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Introduction

This course will explain the calculation of steel following the EN 1993-1-1: General rules and rules for
buildings and EN 1993-1-2: Design of Steel Structures: Structural fire design.

Most of the options in the course can be calculated/checked in SCIA Engineer with the Concept edition
(sen.ed.co.en ).

For some supplementary checks an extra module (or edition) is required, but this will always be indicated in
those paragraphs.

Below you can find an image of the workspace of SCIA Engineer and where to find the different menus.
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Advanced Concept Training — Steel code check

Chapter 1: Materials

For standard steel grades, the yield strength fy and tensile strength fu are defined according to the thickness
of the element.

The standard steel grades as defined in Table 3.1 of the EN 1993-1-1 are:

Table 3.1: Nominal values of yield strength f, and ultimate tensile strength f, for
hot rolled structural steel

Nomunal thickness of the element t [mm]
Standard
and t <40 mm 40 mm < t < 80 mm
steel grade N
£, [N/mm~] £, [N/mm’] fy [N/mm’] £, [N/mm?]

EN 10025-2

S 235 235 360 215 360
S 275 275 43 255 410
S 355 355 510 335 470
S 450 440 550 410 550
EN 10025-3

S 275 N/NL 275 390 255 370
S 355 N/NL 355 490 335 470
S 420 N/NL 420 520 390 520
S 460 N/NL 460 540 430 540
EN 10025-4

S 275 M/ML 275 370 255 360
S 355 M/ML 355 470 335 450
S 420 M/ML 420 520 390 500
S 460 M/ML 460 540 430 530
EN 10025-5

S235W 235 360 215 340
S355W 355 510 335 490
EN 10025-6

S 460 Q/QL/QL1 460 570 440 550

Table 3.1 (continued): Nominal values of yield strength f, and ultimate tensile
strength f, for structural hollow sections

Nominal thickness of the element t [mm]
Standard
and t <40 mm 40 mm < t < 80 mm
steel grade
£, [N/mm’] £, [N/mm?] £, [N/mm’] £, [N/mm’]

EN10210-1

S235H 235 360 215 340
S275H 275 30 255 410
S355H 355 510 335 490
S 275 NH/NLH 275 390 255 370
S 355 NH/NLH 335 490 335 470
S 420 NH/NHL 420 540 390 520
S 460 NH/NLH 460 560 430 550
EN10219-1

S235H 235 360

S275H 275 30

S355H 355 510

S 275 NH/NLH 275 370

S 355 NH/NLH 355 470

S 460 NH/NLH 460 550

S 275 MH/MLH 275 360

S 355 MH/MLH 355 470

S 420 MH/MLH 420 500

S 460 MH/MLH 460 530
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Those materials are included in SCIA Engineer. You can find them via Menu bar > Libraries > Materials
The Histar and Fritenar steel grades have been implemented according to Arcelor.

Also materials from the product codes are implemented in the software (for example materials from Belgian
National Annex NBN NA,...).

With the option ‘Thickness range ' the influence of the thickness on the yield strength fy and tensile strength
fu are defined. When inputting a new user defined material in SCIA Engineer, also the thickness range for
that material should be inputted:

B Materials x
Alen®BE 9 & deE A v Y
5235 Name S235
5275 4 Code independ...
5355

Material type Steel
5450 > 0.01e-003

i .01e
S 275 N/NL Thermal expansion |
5 355 N/NL Unit mass [kg/m"3] 7850.00
5420 N/NL E modulus [MPa] 2.1000e+05
5460 N/NL Poisson coeff. 9.3
5275 M/ML Independent G modu
SERLL G modulus [MPa] 8-0769¢+04
5420 M/ML lmd H o
5 460 M/ML og. decrement (non ©-
S235 W Cotour N
i 0.01e-003
5355 W Thermal expansion | Lower limit[mm] Condition Upper limit[mm] fy [MPa) fu [MPa)
5460 Q/QL/QLL Specific heat [J/gK] 6.0000e-01 1 lIl <tes a0 235.0 360.0
5235 H Thermal conductivity 4.5000e+01 2 40 <t<= 80 215.0 360.0
5275 H Price per unit [€/kg] 1.00 o 0 <te= 0 0.0 0.0
5355 H
< EC3
5275 NH/NLH .
S 355 NH/NLH Ultimate strength [M| 360.0
S 460 NH/NLH Yield strength [MPa] 235.0
5275 MH/MLH I Thickness range
5355 MH/MLH
S 420 MH/MLH
5460 MH/MLH
5235 JR(EN 1002...
MNew Insert Edit Delete Close ettt oK Cancel

Example: NA_Material_Strength_Application.esa
In this example a material of the National Annex of Belgium has been inputted manually: S 275 J2.

This material has a lot of thickness range strength reductions, as we can see in the thickness range table:

Lower limit[mm)] Condition Upper limit[mm] fy [MPa] fu [MPa]
1 <te= 16.00 275.0 430.0
2 16.00 <te= 40.00 265.0 430.0
3 40.00 <te= 63.00 255.0 430.0
a 63.00 <te= 80.00 245.0 430.0
5 80.00 <te= 100.00 235.0 430.0
6 100.00 <te= 150.00 225.0 430.0
7 150.00 <te= 200.00 215.0 430.0
s 200.00 <te= 250.00 205.0 430.0
9 250.00 <te= 400.00 195.0 430.0
. 0.00 <te= 0.00 0.0 0.0
Test data OK Cancel
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Advanced Concept Training — Steel code check

And for each beam the correct yield strength has been taken into account according to the inputted table
above. You can check this by performing a linear calculation and asking for the detailed output for Menu bar
> Design > Steel members > ULS Check (or Process toolbar > Steel > Steel ULS check)

Cs1 | CS2 | CS3 | Cs4

Z

Formcode 1-|section

h [mm] 80.00 h [mm] 600.00 h [mm] 1000.00 h [mm] 1000.00
b[mm] 46.00 b[mm] 220.00 b [mm)] 500.00 b [mm] 500.00
t[mm] 5.20 t[mm] 19.00 t[mm] 220.00 t[mm] 220.00
s[mm] 3.80 s[mm] 12.00 s[mm] 50.00 s[mm] 402.00
r [mm] 5.00 r [mm] 24.00 r[mm] 12.00 r [mm] 12.00
r1 [mm] 0.00 r1 [mm] 0.00 r1 [mm] 0.00 rl [mm] 0.00
a[%)] 0 a[9%] © a[%)] 0 a[%] ©
W [mm] 0.00 W [mm] 116.00 W [mm] 0.00 W [mm] 0.00

wm [mm*2] 0.00

Formcode 1-Isection

wm [mmA*2] 0.00

B 500.00

1 220,00

s 50.00

Formcode 1-lsection

wm [mmA#2] 0.00

s 40, 2:3 0

Formcode 1-lsection

wm [mm?*2] 0.00

Yield strength fy [275.0 Yield stren fy |265.0 Yield strength fy [205.0 Yield strength f, 1195.0 [MPa
Ulimate stren: fu 1430.0 Ultimate stren: fu [430.0 Ulimate strength |fu [430.0 Ultimate stren: f. 1430.0 [MPa
Fabrication Rolled Fabrication Rolled Fabrication Rolled Fabrication Rolled
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2.1. Cross-sections
SCIA Engineer will use the axes y-y and z-z respectively for the major and minor principal axes of the cross-
section.
If the principal axes not coincide with the y-y and z-z axes following the EN 1993-1-1, also those axes are
indicated:

EN 1993-1-1 | SCIA Engineer EN 1993-1-1 | SCIA Engineer

z b z

ZLCS

ZLecs 1 z

In the steel code check, the strong axis will always be considered as the y-y axis. So, when inputting a profile
in which the local y-axis does not corresponds with the strong axis, the axes are switched in the steel code

check and SCIA Engineer will give a message about the axes.

BV —2021/06/21



Advanced Concept Training — Steel code check

Be aware that the switch will also affect the buckling settings for yy and zz.

Flexural Buckling check
According to EN 1993-1-1 article 6.3.1.1 and formula (6.46)

R |rlr||nn naramatarc

Buckllng factor k 0,70 2,00

Buckling length ler 4,200 12,014 |m
Critical Euler load Ner 144890,20 [5959,77 |kN
Slenderness A 19,32 05,27
Relative slenderness Arel 0,21 1,01

Limit slenderness Arelo 0,20 0,20

You can avoid this behaviour by creating the cross-section differently, so the y-axis remains the strong axis.
Afterwards with the properties of the member you can perform a rotation of the local coordinate system (LCS
rotation) if necessary.

Example: Local Axes.esa

The strong axis of this cross-section in the local z-axis:

z

LA

thb 15.00

B 300.00

tha 15.00

A 600.00

This beam is only loaded by a line load in the z-direction, resulting in a moment My and a shear force V; on
the beam.

When looking at the steel code check, the axes are switched and the strong axis is taken as local y-axis:

The critical check is on position 0.000 m

Axis definition :
- principal y- axis in this code check is referring to the principal z axis in SCIA Engineer
- principal z- axis in this code check is referring to the principal y axis in SCIA Engineer

Internal forces Calculated Unit

Normal force Ned 0.00 kN
Shear force Vyed |300.00 kN
Shear force Vzed  |0.00 kN
Torsion Ted 0.00 kNm
Bending moment [Myed |0.00 kNm
Bending moment [Mzed [-300.00 kNm

This is indicated in steel code check and also the internal forces are switched following the new local axis.

10 BV —2021/06/21



2.2.

Section classification

Since SCIA Engineer 17.0, all sections containing an initial shape can be classified. The sections without an
initial shape cannot be classified and will be automatically checked as being class 3.

When you use a cross-section from the profile library, the initial shape will be available. When you want to
use another cross-section, you can use the group ‘Thin-walled geometric ’, for which the initial shape and

torsion properties are available.

Example: Cross-section.esa

e 3 cross-sections:

o HEA300 from profile library
o HEA300 inputted as a general cross-section (imported from .dwg)
o HEA300 inputted as a sheet welded Iw section. By creating this section, it is important that

the correct value for parameter a is defined in mm. This parameter will be recognized as the
fixed part in the calculation of the initial shape:

B Cross-section *
MName €83 ~
Type Iw
Z Detailed 290;9; 300; 14; 262;
Shape type Thin-walled
7 F: | 5 Initial shape Available
4 Parameters
Material 5235 v o
Ba[mm] 230
tha [mm] 2
4 Bb [mm] 300
thb [mm] 14
Hw[mm] 262
| a[mm] 14 |
~N 4 General
* Draw colour Normal colour v
=" 3
Y Colour I
AutoDesign constraints
Fabrication welded b4
W
AL e
: ; = = Export Update Document
4 Shear (.. Shear(.. I Centrelin..| mnitialshape | =
OK Cancel
Initial shape used for effective section calculation
Edit initial shape .
Ye[mm]  Ze[mm] A[mmA2] Ybeg[mm] Zbeg[mm] Yend[mm] Zend[mm] t[mm] lementtyp Reinftype
i 0 7 1770 126 7 0 7 14 SO none 7
2 150 10 832 126 7 174 7 14 F none 4 S e +
3 237 7 1770 174 7 300 7 14 SO none H
a 150 145 2014 150 33 150 257 9 1 none
5 237 283 1770 174 283 300 283 14 SO none
6 150 250 832 126 283 174 283 14 [F ]none
7 63 283 1770 126 283 0 283 14 SO none
4
ul
1
+ +—<—F +

[ Draw part numbers

»  Only the first and the third profile are recognized as a symmetric I-shape containing an initial shape.
For this reason, the classification calculation can be performed.

» The second profile is not recognized as a symmetric I-shape and there is no initial shape available.
e The first and the third profile will be classified as an I-profile and a plastic check will be performed.
e The second profile cannot be classified, so an elastic check will be performed. This will result in

different

BV —2021/06/21
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Advanced Concept Training — Steel code check

1.07 -

Note: the general cross-section cannot be imported in SCIA Engineer with the concept edition. For this
functionality, the Professional or Expert edition is necessary (or module sen.05).

SCIA Engineer will calculate the classification automatically, but the calculated classification in SCIA
Engineer can be overruled by 2 settings in the steel member data (Input panel > Steel > Steel member
data or Process toolbar > Steel member data ):

B Steel member data >

Section classification By program ¥
Elastic verification Mo o
Verify only section checks No -
LTE Buckling Curves 6.3.2 acc. to Steel=Beams=Setup ¥
4 Field
Position Rela ¥

From begin (x] ©

X' From end ('] O
X

B

OK Cancel

» Section classification :you can choose between a classification calculation ‘By program’ , or can
overwrite this and choose for class 1, 2 or 3 . Since classification 4 is not described for all cross-
sections in the Eurocode, this option cannot be chosen.

e Elastic Check Only : you can choose to perform only an elastic check. This corresponds with a class
3 check.

12 BV —2021/06/21



The classification of cross-sections is executed according to EN 1993-1-1, art. 5.5.

Four classes of cross-sections are defined:
e Class 1 (EC3, NEN) or PL-PL (DIN) section
Cross-sections which can form a plastic hinge with the rotation capacity required for plastic analysis
» Class 2 (EC3, NEN) or EL-PL (DIN) section
Cross-sections which can develop their plastic moment resistance, but have limited rotation capacity
e Class 3 (EC3, NEN) or EL-EL (DIN) section
Cross-sections in which the calculated stress in the extreme compression fibre of the steel member
can reach its yield strength, but local buckling is liable to prevent development of the plastic moment
resistance
» Class 4 (EC3, NEN) or slender section
Cross-sections in which it is necessary to make explicit allowance for the effects of local buckling
when determining their moment resistance or compression resistance

Definition of the classification of cross-section
P P
W e
M e Global
analysis
Availabl of
,‘;Eﬁ,,ne structures
Class| Behaviour model | Design resistance capacit,
of plastic Mi
hinge ’
PLASTIC i Class 1
Mp‘, M across full section e VI W el
y 3 pl, Rd )
i ol ]fr important or, ! ' Class2 |
buckling plastic !
I: Me" L I |- _-E%a-ss 3 )
I 1 H
i I !
PLASTIC elastic i 1
M s across full section or, i Class 4 !
plastic 1 i :
2 el fy limited (if required ! ! :
buckling @ ] SOsELO I i !
capacities are I 1 !
I: calculated i ] !
and satisfied) : li i )
ELASTIC
across full section 0 1 >2 >4 OKDP
3 X fy none elastic
ELASTIC
across effective section
4 f fy none elastic

This classification depends on the proportions of each of its compression elements.

For each intermediary section, the classification is determined and the related section check is performed.
The classification can change for each intermediary point.

For each load case/combination, the critical section classification over the member is used to perform the
stability check. So, the stability section classification can change for each load case/combination.

However, for non-prismatic sections, the stability section classification is determined for each intermediary
section.

The classification check in SCIA Engineer will be executed following tables 5.2 of the EN 1993-1-1.
For standard sections, the classification is done according to the parts of the Initial Shape .
» Internal compression elements (I) are classified according to Table 5.2 Sheet 1.
e Outstand compression elements (SO & UQO) are classified according to Table 5.2 Sheet 2.
* CHS (Circular Hollow Sections) are classified according to Table 5.2 Sheet 3.
* Angle sections are classified according to Table 5.2 Sheet 2 and in case of uniform compression
also Sheet 3.

Note: cross-sections without an initial shape are classified as elastic class 3.

BV —2021/06/21 13
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14

Table 5.2 (sheet 1 of 3): Maximum width-to-thickness ratios for compression

parts

Internal compression parts

TC | C

]

- TC - - - - - - Axisof
bending
o) t) = ¢ ‘{t
—— — 1
t
. 1 . L1 I B
B —[ *t t - Axis of
c c C :
- H - - - — bending
| =
. .
Class Part 5ub_1ect to Part s'ub_]ec_'l to Part subject to bending and compression
bending compression
f f f
Stress — — —
distribution + + + | lac
in parts c ¢ c
(compression - i
positive) — — —
¥ f?!' 1)’
whena >05: ¢/t =< 1';9681
1 c/t<Tle c/t<33e 360[_
when e = 0.5: ¢/t < ¢
o
456
when o > 0.5: ¢/t < G 81
2 c/t<83s c/t<38s 41[:_
when @ €0.5: ¢/t € —22
a
f f
Stress g _f Y
distribution
in parts c ¥ c ¢
(compression | |e2
ositive) L
P f, wiy
) 41g
when y>—-1: ¢/t < —
3 c/t<124e ¢/t <42 0.67 +0.33y
when y < —17: ¢/t < 62&(1- w}q\,-"—(—w)
c— 35/F f, 235 275 355 420 460
VT £ 1,00 0.92 0.81 0,75 0,71

#) y < -1 applies where either the compression stress ¢ < f; or the tensile stramn &, > £/E

BV —2021/06/21



Table 5.2 (sheet 2 of 3): Maximum width-to-thickness ratios for compression

parts
Qutstand flanges
c c c
[ 4 | ;
t t t! s
Rolled sections Welded sections
Class Part subject to compression _Part subj ectto bending and compression
Tip 1n compression Tip in tension
Stress ac ac
distribution ___ + +
1n parts AT — — . _
(compression | ! |~—-| B [j “'I [ B
positive) ' e — fp—C —
Og Og
1 c/t=0e e/t — cits—
o ava
10 10e
2 c/t=10s e/t —2 elts——=
o ava
Stress
distribution — IS
in parts 3 |f 3 ‘r = y ‘m
(compression ! |~—-| | c | c
positive) | '
e /1< 218k
3 c/t<1de © EyEg
For kg see EN 1993-1-5
e= [135/F £ 235 275 355 420 460
v ¥ g 1.00 0,92 0,81 0,75 0,71
Table 5.2 (sheet 3 of 3): Maximum width-to-thickness ratios for compression
parts
Angles
—
i
t Does not apply to angles in
Refer also to “Outstand flanges” b continuous contact with other
(see sheet 2 of 3) L components
Class Section i compression
Stress
distribution f
across —_—
section +
(compression U
positive)
3 h/t<15e: ——<115e
Tubular sections
tf—\ ) ld
\Uf
Class Section in bendmg and/or compression
1 d/t <508’
2 d/t=<70¢*
3 d/t<90e”
NOTE For d/t > 90g” see EN 1993-1-6.
f, 235 275 355 420 460
—
e= \,.'235 £, £ 1,00 0,92 0,81 0,75 0,71
& 1.00 0,85 0.66 0,56 0,51
BV —2021/06/21
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Advanced Concept Training — Steel code check

As mentioned before, since SCIA Engineer 17.0, a new classification tool is used based on the initial shape
of the cross-section.

You can choose between 3 methods to determine the plastic stress distribution in the cross-section:
» Elastic stresses;
e Yield surface intersection;
» lterative approach.

In the cross-section properties, you can choose the plastic analysis method. However, this is only informative
and this choice is not decisive. The method that will be used to perform the steel code check can be chosen
in the steel setup window (Menu bar > Design > Steel members > Settings  or Process toolbar > Steel >
Steel settings ):

B | Steel setup x
=)- Standard EN Name Stancard EN o
i Stee 4 Steel

- Member check

- Fire resistance 4 Member check EN 1993-1-1

- Cold Formed 4 (lassification EN 1993-1-1: 5.2.2

-~ Plated structural elements = =

- Limit slenderness Use Semi-Compt

- Buckling defaults Plastic analysis Elastic Stresses A

-~ 5L5 deflection check

i AUtodesign Yield surface intersection
Iterative approach

Lsze Ay_. A, instead of elastic shear
4 Torsion EN 1993-1-1: 6.2.7

Limit for torsion [-] 0.05

4 Default sway types EN 1993-1-1:6.3.1
¥y g yes
z-z no

4 Buckling length ratios ky, kz EN 1993-1-1: 6.3.1

ik . PR G 1.0 1.

Reference: EN 1993-1-1 article 5.2.2

Description: Setting to determine the plastic stress distribution of the cross-section,

Application: The result of the selected approach is used in the calculation of the a value for the Class 1 &
2 limits.

- Elastic stresses: The elastic stresses are used to calculate the plastic stress distribution using fixed
formulas.

- Yield surface intersection: A discrete plastic (yield) surface is derived for the section. The actual internal
forces are then scaled until they intersect with that yield surface. The point from the yield surface that is
closest to the intersection point is then used for further determination of the plastic stress distribution.

- lterative approach: The actual forces are increased iteratively and each time the plane of deformation
is calculated. In case no plane can be determined the boundary is reached. The approach then goes back
oone step and uses the plane of deformation of that step.

Load default non-MNA parameters Load default MA parameters Cancel
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2.21. Elastic stresses

The elastic stresses method is a fast approach using fixed formulas. In this method, the plastic stress
distribution is based on the elastic stresses f1 and f2 at the ends of the parts.

Standard calculation of «a

In case one stress is positive (compression) and the other stress is negative (tension), the following
calculation is used:

| Gcompression |

o=

|0compression| + |Gtension|
In all other cases a is taken as 1,00 for the given part.
Double-symmetric I-section

Specially for a double-symmetric I-section, the a-value of the web element is overruled by the following
formula (Ref. [36]):

compression

web

= — tenshon
. S— My. Ed

h N
Only increase M,: @~ {5+ 2;7 -1, +,-}]

Within this formula, Neq is taken as positive for compression and as negative for tension.

Below you can find the output for cross-section HEA450:

B Classification X
INTERNAL FORCES
7 5
NEd  -5.00 KN [ 5]
Mw.Ed  20.00 KNm \{
MzEd  0.00 KNm
MATERIAL DATA
S 235000.000 KN/mA2 4
E 2.1000e+05 MPa
= 1.00
Plastic analvsis  Elastic stresses v
Classification for fire design 1
Semi-Comp+ limits 1 /2\\ 3
[ I I J
| Update
o =) ME]D m
-
Classification according to EN 1993-1-1 article 5.5.2
Classification  of Intemnal and Outstand parts according to EN 1993-1-1 Table 5.2 Sheet1 & 2
E o2 w ko a
| fai/m?] [ [
& 50 117.25 |21.00 |-6293.591 |-6293.591
3 50 117.25 |21.00 |-6293.591 |-6293.591
4 I 344.00 [11.50 [-5116.789 |5678.407 |-0.9 0.5 [29.8 |71.5 B2.4 112.7 1
5 50 117.25 |21.00 [6855.209 |6855.209 |1.0 |04 (1.0 |5.6 |9.0 10.0 14.0 ¥
i 7 S0 117.25 |21.00 [6855.209 |6855.209 |1.0 |04 |1.0 |5.6 |9.0 10.0 14.0 1
The cross-section is classified as Class 1 "
<

The classification calculation takes 00,002 sec OK

BV —2021/06/21
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Advanced Concept Training — Steel code check

2.2.2. Yield surface intersection

For this method, a full plastic analysis is performed. This plastic analysis is based on the initial shape and
uses a stress-strain diagram with yielding plateau.

r"‘|1|:nl.z

The yield surface is generated for the given section and the intersection of the actual forces is determined
with this surface.

The actual intersection point (grey) does not always collide with a predetermined point of the surface, so
small deviations can occur. From the location of the plastic neutral axis, which results of this analysis, the a-
value for the different parts can be determined.

B Classification X
INTERNAL FORCES
7 5
MEd 500 KN [ 5]
Mv.Ed 20.00 kNm 1
MzEd  0.00 KNm
MATERIAL DATA
S 235000.000 KN/mA2 4
E 2.1000e+05 MPa
= 1.00
Plastic analvsis  Yield surface intersectic v
Classification for fire design 1
Semi-Comp+ limits | 1 |/2\\ 3 ‘
| Update
&R ME]D
-
Classification according to EN 1993-1-1 article 5.5.2
Classification  of Internal and Outstand parts according to EN 1993-1-1 Table 5.2 Sheet1 & 2
3 ol o2 w ko a
[mm] [k/m?] [di/m?1 1 [ [
1 50 117.25 [21.00 |-6293.581 |-6293.591
3 [s0 117.25 [21.00 |-6293.581 |-6293.591
4 I 344.00 [11.50 |-5116.788 |5678.407 |-0.9 0.6 |29.9 |58.1 66.9 112.7 1
5 |50 117.25 [21.00 |6855.209 |6855.209 |1.0 |04 |1.0 [5.6 |9.0 10.0 14.0 1
7 50 117.25 [21.00 |6855.209 [6855.209 |i.0 0.4 |1.0 [5.6 ]9.0 10.0 14.0 1
Note: For theClass 1 & 2 limits an advanced plastic analysis (vield surface intersection) has been used.
The cross-section is classified as Class 1
Calculation info
N My Mz
[kn] [kNm]  [kNm]
188,52 [752.96 [0.00 |
v
<

The classification calculation takes 00,085 sec OK

Note: it can happen that the plastic neutral axis is rotated, but this has a negligible effect on a. This happens
when the closest point on the yield surface has a minor M; moment.
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2.2.3. lterative approach

Also for this method, a full plastic analysis is performed. This plastic analysis is based on the initial shape
and uses a stress-strain diagram with yielding plateau.

The actual plane of deformation for the given internal forces is determined iteratively, which provides an
exact solution.

B Classification X
| INTERNAL FORCES
7 5
MN.Ed -5.00 kN [ || ]
MwEd  20.00 kNm 1
MzEd  0.00 KNm
J MATERWL DATA:
e 235000.000 KN/mA2 4
E 2.1000+05 MPa
e 1.00
Plastic analvsis Herativeapproach v
Classification for fire design U
Semi-Comp limits : 1 Ijz\\ 3 :
| Update
A QG HIEIN m
g ~
Classification according to EN 1993-1-1 article 5.5.2
Classification  of Internal and Outstand parts according to EN 1993-1-1 Table 5.2 Sheet1 & 2 |
[3 ol [:7] w ke a cft Class 1
[mm] [/m?] [d/m?] [ [ 1 [l Lmit
6]
1 S0 117.25 |21.00 |-6293.591 |-6293.501
3 S0 117.25 |21.00 |-6293.591 |-6293.591
4 I 344.00 [11.50 |-5116.789 |5678.407 |-0.9 0.6 |29.9 |58.2 67.0 1127 E
5 |50 117.25 [21.00 |6855.209 |6855.209 |1.0 |04 |1.0 [5.6 |9.0 10.0 14.0 1
7 50 117.25 [21.00 |6855.209 [6855.209 1.0 |04 [1.0 |5.6 |9.0 10.0 14.0 1
MNote: For theClass 1 & 2 limits an advanced plastic analysis (iterative approach) has been used.
The cross-section is classified as Class 1
Calculation info
N My Mz
[l [kiim]  [khm]
[187.02 [748.05 [0.00 | v

The classification calculation takes 00,981 sec OK
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2.24.

Semi-Comp+

Another development that has been available since SCIA Engineer 17.0, is the classification of semi-
compact steel sections. Semi-compact steel sections are sections which are classified as class 3.

The Semi-Comp+ option can be activated in the steel setup :

B Steel setup

= standard EN
(- Steel

Member check
Fire resistance
Cold Formed
Plated structural elements

Limit slenderness I
Buckling defaults

i 515 deflection check
L. Autodesign

4 Steel

4 Member check

4 Classification

MName

Standard EN

EN 1993-1-1
EN 1993-1-1: 5.2.2

Use Semi-Comp+

4 Shear

4 Torsion

4 Default sway types

Plastic analysis

Stability classification method

Use Ay,AZ instead of elastic shear

Limit for torsion [-]

¥y
FE

4 Buckling length ratios ky, kz

Max. k ratio [-]

Max. slenderness [-]

an order buckling ratios

4 Lateral Torsional Buckling

Lateral torsional buckling curves

[ 0 TSPV O Ul B s W 2

Elastic Stresses
Max. class along member
EM 1993-1-1: 6.2.6
no
EN 1993-1-1: 6.2.7
0.05
EM 1993-1-1: 6.3.1
@ yes
no
EN 1993-1-1: 6.3.1
10.00
200.00
Acc. to input
EM 1993-1-1: 6.3.2
General case

ECCS 11aiGal

Reference: Valorisation Project: SEMI-COMP+ n® RF52-CT-2010-00023

Description: Setting to use the plastic member capacity of Semi-Compact steel sections.
Application: When this setting is activated, modified classification limits are used for l-sections and RHS
sections. In addition, when those sections are classified as Class 3 the section moduli are interpolated
between the elastic and plastic values in order to use the plastic capacity of the section,

Load default non-MA parameters

Load default

MNA& parameters

Cancel

The use of this option has a dual application:
classification limits are modified for I-sections and RHS sections;
interpolated section modulus between the elastic and plastic values.

Adaption classification limits

Currently, there is a discrepancy in the used classification limits between EN1993-1-1 and EN1993-1-5. The
Semi-Comp+ publication identified this discrepancy and proposed new classification limits (Ref. [36]):

Ef;i‘;’::;';’: ;:;‘f;:i"" for ESDEP-Background EN 1993-1-1
i;:l :;4;‘;;7@' :B:p,min Xp,n’in c/t-limit ( *€)

Limit between class 3/4:

internal part in compression 0,673 *l 38,23 42
in bending 0,874 121,35 124

outstand flange in compression 0,748 13,93 14

Limit between class 2/3:

internal part in compression 0,6 34,11 38
in bending 0,6 83,38 83

outstand flange in compression 0,6 11,18 10

Limit between class 1/2:

internal part in compression 0,5 28,43 33
in bending 0,5 69,48 72

outstand flange in compression 0,5 9,32 9

* previously 0,74 42,07 42

Note: these adaptions on the classification limits will be implemented in the next iteration of EN1993-1-1.

20
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Interpolated section modulus

The section moduli will be interpolated between the elastic and plastic values. This results in the advantage
that the plastic capacity of the section is considered for class 3 sections.

EN 1993-1-1 SEMI-COMP research
Mag jastic global analysis
et g E‘f:sﬂc globel analysis Mgaq Continuous transition

-

My}

M

el

| Class3 | Ciass 4

et Class1 | 8 {Class3 | Class4
M M7 T M
TP T T4 - w

NiN, =00
(forHEA 200

Class 1 +
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Advanced Concept Training — Steel code check

2.2.5. Effective section

If the classification results in a class 4 profile, the effective cross-section will be calculated according to EN
1993-1-5.

For each load case and combination, the most critical effective area properties are saved:
* Aett is the effective area of the cross-section when subject to uniform compression;
*  Wer is the effective section modulus of the cross-section when subject only to moment about
the relevant axis;
* enis the shift of the relevant centroidal axis when the cross-section is subject to uniform
compression.

With these critical properties, the steel code check will be executed.

Example: Industrial Hall.esa

In this example the classification will be done for an IPE750x134 profile, resulting in a class 4 cross-section.
And afterwards the calculation of the effective shape following EN 1993-1-5 will be given.

We consider column B28:

B Cross-Sections *
FEEGFE R s O @ A vy
E Mid column - IPET5... |4 Geometry -
E Beam - IPE160 Formcode 1-Isection

E Purlin - U240

E Gakble column - HE...
E Diagonal - RD15

f§ Beam2 - IPET50x134

h [mm] 753.00
b[mm] 265.00
t[mm] 17.00
s[mm] 13.20
r [mm] 17.00
rl [mm] @-@¢
a[%] ©
W [mm] 104.00
wm [mm~"2] 0.00

z

T —

*

MNew Insert Edit Setup | Update all | Close

The classification has been executed at the bottom of the column (position = 0,00 m)

On this position a hinged support has been inputted, so on this position the column is not subjected to
bending.
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With table 5.2 of EN 1993-1-1 we can determine the class for each component of the cross-section.

Web according to table 5.2 (sheet 1):

¢ = H — 2 * thickness flange — 2 * radius

c =753 mm-—2*17 mm — 2*17 mm = 685 mm

t=13,20 mm
c/t=51,89
Part subject to Part subject to
Class z :
bending compression
f
Stress
distribution &
in parts c c
(compression !
positive) =]
f, A
i | c/t<72e c/t<33
2 c/t<83¢ c/t<38¢
f,
Stress ¢ f
distribution
in parts c ¢
(compression | |2 +
positive) {
Y
3 c/t<124¢ c/t<42e

With e = /235 /fy = 1
Maximum ratio for class 1: 33
Maximum ratio for class 2: 38

Maximum ratio for class 3: 42

-2 c/t=51,89>42 > Class 4

Flange according to table 5.2 (sheet 2):
Cc

T

¢ = B/2 — (thickness web)/2 — radius

c=265mm/2 —13,20 mm/2 —17 = 108,9 mm

t=17 mm
c/t = 6,40
Class Part subject to compression
Stress
distribution _
in parts 11 s
(comp.rgfswn i | ]-—-|
posttive)
1 c/t<9%e
2 c/t<10e
Stress
distribution _ G
n parts | T
(comg@s.swn | | l'—-l
positive)
3 c/t<14e

With € = /235 /fy = 1
Maximum ratio for class 1: 9
Maximum ratio for class 2: 10

Maximum ratio for class 3: 14

2>c¢c/t=6,40<9 > Class 1

This corresponds with the classification of this cross-section for the stability check in SCIA Engineer:

Classification for member buckling design
Decisive position for stability classification: 0.000 m
Classification according to EN 1993-1-1 article 5.5.2

Classification of Internal and Outstand parts according to EN 1993-1-1 Table 5.2 Sheet 1 & 2

1

ass

1 |SO 108.90 |17.00 [8656.406 [8656.406 |1.0 [0.4 |1.0 [6.4 [9.0 10.0 14.0 1
3 |SO 108.90 |17.00 [8656.406 |8656.406 |1.0 [0.4 [1.0 |64 |9.0 10.0 14.0 1
4 |1 685.00 [13.20 |8656.406 [8656.406 |1.0 1.0 [51.9 [33.0 38.0 42.0 4
5 |SO 108.90 |17.00 [8656.406 |8656.406 |[1.0 [0.4 [1.0 |64 |9.0 10.0 14.0 1
7 __[SO 108.90 [17.00 [8656.406 [8656.406 |1.0 [0.4 [1.0 [6.4 [9.0 10.0 14.0 g

The cross-section is classified ag| Class 4}

BV —2021/06/21
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Advanced Concept Training — Steel code check

This cross-section has a classification class 4 for the stability classification, so effective properties must be

calculated.

Those properties are also given in SCIA Engineer in the preview of the steel code check, just below the
classification calculation.

Effective area Aeff 1.7222e+04 |mm?

Effective second |Iefr,y |1.6608e+09 |mm* |Iefz |5.2895e+07 |mm?
moment of area

Effective section |Wefry |4.4111e+06 |mm? |[Wefz |3.9920e+05 |mm?
modulus

Shift of the en,y 0.00 mm |en: 0.00 mm
centroid

The calculation of the sectional area Aett is given below.

In this section there is a uniform compression force over the web.

The calculation of the effective section will be performed following EN 1993-1-5:2006, Tabel 4.1 and EN
1993-1-5:2006/AC:2009 article 9). In Table 4.1 the uniform compression situation will be used in this

example:
Stress distribution (compression positive) Effective” width Defe
L ber |, 5 Je b | bar=p b
bcl =0,5 et ch = 0,5 b
A [T e
% _
bt , b | ber=p b
b 2
' b?l = bgﬁ' bEZ = beff = bel
5-y
b e w<0:
" MD% b b b1 (1-w)
; ?ez o eff =P D= p W
B ber = 0.4 ber ber = 0,6 besr
v = o)lo 1 1>y>0 0 0>py>-1 -1 1>y >-3
Buckling factor k, | 4.0 | 8.2/(1.05+y) | 7.81 7.81-629% +9,78" | 239 | 598(1-y)’

For y = 1 and internal compression elements:

A, <0,5+/0,085-10,055¢ = 0,673 >p=1
% > 0,5 +/0,085 — 0,0550 = 0,673 —» p = (X, — 0,22)/ X,

For our cross-section:

With:

So:

24

b/t

51,89

E = [fy/o—cr]O'5 =

£ = 1,00 (S235)
ko = 4,0 (table 4.1 of EN 1993-1-5:2006)

p_

091-022

(0,91)2

284-¢- Jk, 284-100 40

0,91

= 0,83
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Doy = bey = 0,5-begr=0,5-p-b=0,5-0,83-685mm = 284,62 mm
Aogr = [265 - 17 + 284,62 - 13,20 + 17 - 13,20] - 2 = 16972,77 mm?

_t
i o
17 - o
“lg
284,62
- |=1320 2;1_52
r
F 265 i

In this calculation the roundings at the corners between the flanges and the web are not taken into account.

Therefore the result in SCIA Engineer will be a bit higher:

Effective properties
Effective area Pef 1.7222e+04 |mm?
Effective second |[Ierry |[1.6608e+09 |mm* |Iesrz [5.2895e+07 |[mm?*

moment of area
Effective section |[Wes,y [4.4111e+06 [mm? [Wes,z [3.9920e+05 |[mm3

modulus
Shift of the eny |0.00 mm ez 0.00 mm

centroid

Also the other properties of this effective cross-section can be calculated.

Note: for cold-formed cross-sections the rules are adapted (according to EN 1993-1-3).

BV —2021/06/21
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Advanced Concept Training — Steel code check

Chapter 3: ULS section check

In this chapter, first the partial safety factors are explained and afterwards a short explanation of all the
section checks is given.

The section check can be found in SCIA Engineer under Menu bar > Design > Steel members > ULS
Check or Process toolbar > Steel > Steel ULS check . In the properties of the check, you can choose to
look at the Brief, Summary or Detailed output:
e with the brief output the results are shown in one ling;
< with the summary output, the results of all unity checks are shown on one page;
» with the detailed output, the results of all the unity checks are shown including a reference to
the used formula in the EN 1993-1-1 for each check. Since SCIA18.0 also all formulas can be
shown in the output.

Further in this chapter, the section checks will be explained and the detailed results are shown.

3.1. Partial safety factors
The partial safety factors are taken from EN 1993-1-1 art. 6.1.

Following safety factors are considered:
* ymo = 1,00: resistance of cross-sections;
* ywm = 1,00: resistance of members to instability accessed by member checks;
e ym2 = 1,25: resistance of cross-sections in tension to fracture.

Those factors can also be found in the National Annex of EN 1993-1-1 in SCIA Engineer (via Status bar >
National annex > Manage annexes ):

B Steel setup X

[=1- Standard EN
£l Steel
Member check
Fire resistance

Mame Stancard EN
4 Steel

4 Member check EN 1993-1-1

Cold Formed
\. Plated structural elements

F Bow Imperfections

I _Member Imperfection

EM 1993-1-1: 5.3.2{3} b}
EN 1993-1-1: 5.3.4(3)

4 Partial Safety Factors EN 1993-1-1:6.1{1)
4 Gamma M0
Value[-] 1.00
4 Gamma M1
Value[-] 1.00
4 Gamma M2
Value[-] 1.25

B ITB Curves - General Case

' LTB Curves - Rolled/Equivalent welded Case

E  Interaction Method

EN 1993-1-1: 6.3.2.2
EN 1993-1-1:6.3.2.3(1)
EN 1993-1-1: 6.3.3(5)

P Fire resistance EM 1993-1-2
P Cold Formed EN 1993-1-3
I Plated structural elements EN 1993-1-5

Load default MA parameters

e
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3.2. Tension

The tension check will be executed following EN 1993-1-1 art. 6.2.3 formula (6.5):

With:

* Nipa =

Afy

the design plastic resistance of the cross-section

Example: Industrial Hall.esa

Consider bracing B234 (for load case 3DWind1). In this load case the bracing is under tension:

Internal forces Calculated Unit

Normal force Ned 30.44 kN
Shear force Vyed [0.00 kN
Shear force Vzed  |0.00 kN
Torsion Ted 0.00 kNm
Bending moment  [Myed |0.00 kNm
Bending moment  [Mzeq  |0.00 kNm

Classification for cross-section design
Warning: Classification is not supported for this type of cross-section.
The section is checked as elastic, class 3.

Tension check

According to EN 1993-1-1 article 6.2.3 and formula (6.5)

Cross-section area A 1.7663e+02 |mm?2
Plastic tension resistance Nolrd |41.51 kN
Ultimate tension resistance [Nurd [45.78 kN
Tension resistance Ntrd  |41.51 kN
Unity check 0.73 -
A x f, 5 - 107 2] x .0[MP.
Npird = —= = 14005+ 1 [ ] » S90.0IMPa) _ 41.51[kN] (EC3-1-1: 6.6)
Mo 1.00
9 xAxf, 9 x 1. -10? 2] x .

Noo = 22 A fy _ 0.9 x 1.7663 - 10%[mm?] x 360.0[MPa] _ 45.78kN] —

™2 1.25
N; ga = min (Npi e, Ny ga) = min (41.51[kN], 45.78[kN]) = 41.51[kN]

; Nea  30.44[kN]

= —=——"—=10.73 < 1.00

Unity check Nora — 4L51[kN) < (EC3-1-1: 6.5)
27
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3.3. Compression
The compression check will be executed following EN 1993-1-1 art. 6.2.4 formula (6.9):

N
B <1
Nc,Rd
With:
Af .
¢ Negg=—2 for class 1, 2 or 3 cross-sections
o
* Nepq = % for class 4 cross-sections
Mo

Example: Industrial Hall.esa
Consider column B28 (for combination CO1-ULS).

The critical check is on position 1.150 m

Normal force Ned -160.06 kN
Shear force Vyed  [-0.05 kN
Shear force Vzed  |-101.92 kN
Torsion Ted 0.00 kNm
Bending moment  |Myed [-117.24 kNm
Bending moment  [Mzed [-0.06 kNm

The classification on this position is Class 1 (column under compression and bending).

Compression check
According to EN 1993-1-1 article 6.2.4 and formula (6.9)

Cross-section area A 1.8800e+04 |mm?
Compression resistance  |Ncgd  |4418.00 kN
Unity check 0.04 -
L 4 2 X 3!
Negg A x f, _ 1.8800 - 10‘{mm?] x 235.0[MPa] _ 4418.00[kN] P
MO 1.00
; Neg 160.06[kN]
== ———— =0.04 < 1.00

Unity check Noro 4418.00[KN] < (EC3-1-1: 6.9)
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3.4. Bending moment

The bending moment check for My and Mz will be executed following EN 1993-1-1 art. 6.2.5 formula (6.12):

With:

Mcrda = Mpira =

Wprfy

for class 1 or 2 cross-sections

w inf .
Mcrd = Meirg = % for class 3 cross-sections

Mc,Rd =

Wesrfy
YMo

Mo

for class 4 cross-sections

Note: an interpolated section modulus can be used in case of class 3 cross-sections when the Semi-Comp+
method is activated (see chapter 2)

Example: Industrial Hall.esa

Consider column B28 (for combination CO1-ULS).

The critical check is on position 1.150 m

Internal forces Calculated Unit

Normal force Ned -160.06 kN
Shear force Vyed  [-0.05 kN
Shear force Vzed  |-101.92 kN
Torsion Ted 0.00 kNm
Bending moment  |Myed [-117.24 kNm
Bending moment  [Mzed [-0.06 kNm

The classification on this position is Class 1 (column under compression and bending).

B " Cross-Sections X
AiasnBiki= o> & @zd A - I
6 Mid column - IPE750x147 iz [mm)]
& Beam - IPE160 Wely [mm*3]
& Purlin - U240 Welz [mmA3]
& G.able column - HEB340 Wply [mm*3]
& Diagonal - RD15 Wolz [mmA3]
& Beam2 - IPE750x134

Mply+ [Nmm)]

Mply- [Nmm]

Mplz+ [Nmm]

Mplz- [Nmm)] 148254531.41

z
New Insert Edit Setup Update all Close
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Bending moment check for My
According to EN 1993-1-1 article 6.2.5 and formula (6.12),(6.13)

Plastic section modulus  [Wpiy 5.1100e+06 | mm?
Plastic bending moment |[Mp,yrd [1200.85 kNm
Unity check 0.10 -
106 3]
Mo g = Woty % fy _ 5110010 [mm?] x 235.0[MPa] _ 1200 85{kNm] PE—
Mo 1.00
: M, £4 117.24[kNm]
heck = 4 = =0.10 < 1.00 1:
Unity chec My s 1200.85(kNm)] < (EC3-1-1: 6.12)

Bending moment check for M;
According to EN 1993-1-1 article 6.2.5 and formula (6.12),(6.13)

Plastic section modulus  |Wpiz 6.3100e+05 |[mm?3

Plastic bending moment [Mpzrd |148.28 kNm
Unity check 0.00 -
e X f, - 10%[mm?] »
My = Woiz i _ 63100 10°%[mm’] x 235.0[MPa] _ | 48.26[KNm] N——
Mo 1.00
) Mzl [-0.06[kNm] ]
Unity check Y —148.28[kNm] 0.00 < 1.00 (EC3-1-1: 6.12)
3.5. Shear
The shear check for Vy and V: will be executed following EN 1993-1-1 art. 6.2.6 formula (6.17):
VEq
<1
Vc,Rd

For plastic design Vcra (in the absence of torsion) is the design plastic shear resistance Vpird, according to
formula (6.18):

_ Ay (fy/\/g)
ViR = —————
Y™mo
With:
A shear area, the formula for Ay depends on the cross-section (see EN 1993-1-1

article 6.2.6(3) and several ECCS publications, see annex A).

For elastic design Vcrad is the design elastic shear resistance. The following criterion for a critical point of
the cross-section may be used (formula (6.19)) unless the buckling verification in section 5 of EN 1993-1-5
applies:

_ TEd

fy - (V3 Ymo)

With (formula (6.20)):
VEd * S
I

Tgq =

Where the shear force is combined with a torsional moment, the plastic resistance V i ra should be reduced
as specified in the next paragraph.
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Example: Industrial Hall.esa

Consider column B28 (for combination CO1-ULS).

The critical check is on position 1.150 m

Normal force Ned -160.06 kN
Shear force Vyed  [-0.05 kN
Shear force Vzed  [-101.92 kN
Torsion Ted 0.00 kNm
Bending moment  [Myed [-117.24 kNm
Bending moment  [Mzed [-0.06 kNm

The classification on this position is class 1 (column under compression and bending).

Shear check for Vy
According to EN 1993-1-1 article 6.2.6 and formula (6.17)

Shear correction factor n 1.20
Shear area Ay 9.4086e+03 |mm?
Plastic shear resistance for Vy |Vpiyrd | 1276.54 kN
Unity check 0.00 5
A, (f_ 9.4086 - 10°[mm?] x M—EAP*’] i B
Vol = e = V3 o 1276.54[kN] PR
Mo 1.00
; ~ |Vyed  |-0.05[kN]| '
Unity check = Verrs ~ T276.540N] 0.00 < 1.00 (EC3-1-1: 6.17)
Shear check for V;
According to EN 1993-1-1 article 6.2.6 and formula (6.17)
Shear correction factor n 1.20
Shear area A 1.1389e+04 |mm?
Plastic shear resistance for Vz [Vpl,zrd |1545.22 kN
Unity check 0.07 -
A, x f_v_ 1.1389 - 10*[mm?] x w e
Vpizra = —Y3 = V3 1545.22[kN] PR
Mo 1.00
: _ [Vagd| [ -101.92[kN]| )
Unity check = Vorre = —1545‘22[“\1] =0.07 <1.00 (EC3-1-1: 6.17)

3.6. Torsion

The torsion check will be executed following EN 1993-1-1 article 6.2.7 formula (6.23):
Tea _ 4
Tra

Where Trd is the design torsional resistance of the cross-section.

The total torsional moment Ted should be considered as the sum of two internal effects (formula (6.24)):
Tgq = Tega + Twkd
With:
*  Tted the internal St. Venant torsion
e TwEed the internal warping torsion
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SCIA Engineer will take into account the St. Venant torsion automatically. If you would like to calculate also
with warping torsion , you should activate this option within the System lengths and buckling settings  of
this member:

B System lengths and buckling settings m] *
LFle * 8xEr A

Settings Results

Name BC1
Buckling span Deflection span
gy Deflectionz = N
Zg= Tz ¥ Deflectiony = =z v
yz= Tz ¥
= Zz ¥
= Buckling lenzth factors Settines per snan for v-v axis
lor factor Calculate ¥ Sway y-y
1 B8
1A Swav v-v Custom v =
Member imperfection in 2nd order analvsis
Bow imperfection e0.v  No bow imperfect «
IPE=W
4 pcvarced settings
Lateral Torsional Buckling Special buckling
7] Point of load apolication In shear center v Tyoe Notused
-
"‘.!. Mcr Calculated X
% 2 Warping check
)
. \ \\‘!‘ End constraint condition for warping
1 L]
£ y Beein Fixed v End Free Y.
%

Save Cancel

When the check box Warping check is activated, you should indicate for the beginning and for end of the
beam if the end is Fixed or Free for warping (you can activate the local axis on the element to see what the
beginning and the end of the element are).

Example: Warping.esa

As quoted in the EN 1993-1-1, art. 6.2.7(7), for closed hollow sections the effects of torsional warping can be
neglected and in the case of a member with an open cross-section, such as | of H, it may be assumed that
the effects of St.Venant torsion can be neglected. This article is a simplification and is valid for SCIA
Engineer version up to and until SCIA Engineer 16.1.

Since SCIA Engineer 17.0, the warping check will also be performed for closed hollow sections, even though
the fact that this will not have the same influence as for open profiles.

In this example 4 beams are inputted:
« |PE180 — no warping has been activated
e SHS180/180/10.0 — no warping has been activated
« |PE180 — warping has been activated in the buckling data
e SHS180/180/10.0 — warping has been activated in the buckling data
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On all beams, a line force of -4 kN is inputted with an eccentricity ey of 0,050 m. The k factor has been

changed into 2,00 within the buckling data for each buckling group (BC1 and BC2) since we are considering
cantilevers.

7 Systern lengths and buckling settings m] X
el 2 [ (@
Settings Results

Name BC1

Buckling span Deflection span
¥y Deflectionz = ¥y ¥
zz= ZZ ¥ Deflectiony = =z v

yz= Tz ¥

I Active buckling constraints

SHS-W

4 Spansetiings

|

klth [-]
1 1.00

k]
2.00

kw []
1.00

IPE—W

b Advanced settings

; LA :f.-uu_u
S
=

F-_ AR
Qe e

ot

Cancel

] 8

For the SHS profiles , there is a small difference between the option ‘warping’ activated or not. This was
expected as warping is not important for closed hollow sections.

For IPE profiles , the warping torsion cannot be neglected. So when this is activated, it has a big influence
on the resistance value for torsion.

Torsion check IPE180 without warping activated:

Torsion check
According to EN 1993-1-1 article 6.2.7 and formula (6.23)

Index of fibre Fibre |2

Total torsional moment | Ted 133.6 |MPa
Elastic shear resistance | Trd 135.7 |MPa
Unity check 0.98 -

Combined Shear and Torsion check for V: and Tted
According to EN 1993-1-1 article 6.2.6 & 6.2.7 and formula (6.25),(6.26)

Plastic shear resistance for Vz and |Vp,Tzrd [70.02 |kN
Ted
Unity check 023 |-
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Torsion check IPE180 with warping activated:

Torsion check
According to EN 1993-1-1 article 6.2.7 and formula (6.23)

Index of fibre Fibre |2

Total torsional moment | Ted 133.6 [MPa
Elastic shear resistance | Trd 135.7 [MPa
Unity check 098 |-

Combined Shear and Torsion check for Vz and Tted
According to EN 1993-1-1 article 6.2.6 & 6.2.7 and formula (6.25),(6.26)

Fibre 1
Shear stress due to uniform (St. Tt,Ed 0.0 MPa
Venant) torsion
Plastic shear resistance for V; and |Vp,Tzrd [152.01 [kN
Ted
Unity check 0.11 -

Combined bending, axial force and shear force check

According to EN 1993-1-1 article 6.2.7

According to I. Vayas, Stahlbau 69 (2000)

"Interaktion der plastischen Grenzschnittgroessen doppelsymmetrischer I-Querschnitte”, Table 1.

Warping conditions at the extremities of the member
Extremity Condition

Begin Fixed

End Free

Decomposition of torsional moment

b4 Muxp,ed Mxs,Ed Mw,ed
[m] [kNm] [kNm] [kNm2]
0.000 [0.00 0.80 -0.43
0.400 [0.29 0.43 -0.19
0.800 |0.41 0.23 -0.06

1.200 |0.44 0.12 0.00
1.600 |0.42 0.06 0.04
2.000 |0.37 0.03 0.06
2.000 [0.37 0.03 0.06
2.400 [0.31 0.01 0.06

2.800 [0.25 -0.01 0.06
3.200 |0.19 -0.03 0.05
3.600 |0.14 -0.06 0.04
4.000 |0.12 -0.12 0.00

Internal forces
St. Venant torsion |Myped |0.00 |kNm
Warping torsion Mxsed  |0.80 |kNm

Bimoment Mwed  |-0.43 |kNm?
Force ratios

Cross-section flange quotient |ar 0.61
Cross-section web quotient aw [0.39
Normal force ratio n 0.00
Moment ratio for My my [-0.82
Moment ratio for M. m: | 0.00
Shear ratio for Vy Vy 0.00
Shear ratio for V: Vz 0.12
Moment ratio for Mw mw |0.61
Moment ratio for Mxp mxp | 0.00
Moment ratio for Mxs mxs | 0.05

Interaction ratio for shear stresses in flanges [By |0.05
Reduction factor for shear stresses in flanges |[pr [0.00
Yield strength reduction for shear stresses in |sf |[1.00
flanges

Interaction ratio for shear stresses in web B. [0.12
Reduction factor for shear stresses in web pw_|0.00
Yield strength reduction for shear stresses in |sw |1.00
web

Additional moment coefficient As_|0.00
Additional moment coefficient S |0.00

Unity check (42) [1.19 |-

As stated before, since SCIA Engineer 17.0 the same warping check will be executed for the closed SHS

profile.
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3.7. Combined check: bending, shear and axial force
This check will be executed following EN 1993-1-1 articles 6.2.8, 6.2.9 & 6.2.10.

For bi-axial bending the following criterion may be used according to formula (6.41):
Myea 1% [ Myga 1°
[ y,Ed ] + [ z,Ed ] <1
Mny.rd Mn.zrd
in which a and B are defined as follows:

e landHsections:a=2;B=5nbutfp=1
e Circular hollow sections: a=2; =2

1,66

¢ Rectangular hollow sections: a = B = i buta=p<6
X N !
with n = —E4
Npj,Rd

In case of one of the following, the influence of the shear force on the bending resistance cannot be accounted
for using the specified article:
* No plastic shear resistance is available because an elastic shear check was done, which
means the reduction factor p cannot be determined.
« Due to extreme shear the reduction factor p > 1 which would lead to a negative reduction.
« In case there is no corresponding bending moment the reduction for shear cannot be applied
(for example V: combined with M; and thus no corresponding My).
In each of those cases an elastic verification using the yield criterion according to art. 6.2.1(5) (formula (6.1))
will be done instead.

The values Mny,rda and Mnzrd depend on the moment resistance, reduced with a factor depending on “n”, the
check of the normal force (formulas (6.39) and (6.40)):

l\/[N,y,Rd = lv[pl,y,Rd(]- - n)/(l - O:Saw)
MN,Z,Rd = Mpl,Z,Rd(l - n)/(l - O:Saf)

And Mpira depends on the yield strength fy.

If Veq = 0,5 Vp, 1 rq: the yield strength will be reduced with a factor p according to formula (6.29):

(1-p)f
Where:
2V, 2
o= ( Bd 1)
Vpird
and:
v _ Ay - (fy/\/?)
pLRd —
YMo

When torsion is present p should be obtained from:

Class 3 cross-sections (EN 1993-1-1 article 6.2.9.2):

In absence of a shear force, for class 3 cross-sections the maximum longitudinal stress should satisfy the
criterion according to formula (6.42):

f

y
Ox,Ed < Y

Mo
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Class 4 cross-sections (EN 1993-1-1 article 6.2.9.3):

In absence of a shear force, for class 4 cross-sections the maximum longitudinal stress should satisfy the
criterion according to formula (6.43):

f
y
Ox,Ed <

Mo

The following criterion according to formula (6.44) should be met:
Ngq 4 My gq + Ngq " eny + M, gq + Ngq " enz

fY fy fY B
Actr m Weff,y,min ' m Weff,z,min ' m
With:
o Aeif effective area of the cross-section when subjected to uniform compression

*  Werrmn effective section modulus of the cross-section when subjected only to moment
about the relevant axis

* en shift of the relevant centroidal axis when the cross-section is subjected to
compression only.

Example: Industrial hall.esa
Consider column B28 (for combination CO1-ULS).

Compression check
According to EN 1993-1-1 article 6.2.4 and formula (6.9)

Cross-section area A 1.8800e+04 [mm?
Compression resistance  [Ncrd [ 4418.00 kN
Unity check 0.04 -

Unity check (or Ned/Nc,rd) = 0.04, so n = 0,04

Shear check for Vy
According to EN 1993-1-1 article 6.2.6 and formula (6.17)

Shear correction factor n 1.20

Shear area A, 9.4086e+03 |mm?
Plastic_shear resistance for Vy |Vplyrd |1276.54 kN
Unity check 0.00 -

Shear check for V:
According to EN 1993-1-1 artice 6.2.6 and formula (6.17)

Shear correction factor n 1.20

Shear area A, 1.1389e+04 |mm?
Plastic_shear resistance for V: |Vplzrd |1545.22 kN
Unity check 0.07 -

The unity check for shear force is smaller than 0,5, thus there is no reduction of the yield strength for the
combined check.

Combined bending, axial force and shear force check
According to EN 1993-1-1 article 6.2.9.1 and formula (6.41)

Plastic bending moment Mpiyrd  [1200.85 |kNm
Exponent of bending ratio y |a 2.00
Plastic bending moment Mpizrd  [148.28  |kNm
Exponent of bending ratio z [B 1.00

Unity check (6.41) = 0.01 + 0.00 = 0.01 -
Wy x f,  5.1100 - 10°[mm’?] x 235.0[MPa]

Mgy ra = - .00 = 1200.85[kNm) (EC3-1-1: 6.13)
a=2.00
- 5 3
My e Wuix < f, 6.3100- 10 [rn{nol) < 235.0[MPa] 148.28[kNm)] o
MO o
3=1.00
. M, eq] \* IM, 4] \* |[—117.24[kNm]| \ > |—0.06[kNm]| \ **°
heck - 0.01 < 1.00 C3-1-1: 6.41]
Unity chec (Mrwd f (Mp.,,m) ( 1200.85[kNm] ) i 148.28[kNm]> 1=1 & 3

Note: Since the shear forces are less than half the plastic shear resistances their effect on the moment
resistances is neglected.

Note: Since the axial force satisfies both criteria (6.33) and (6.34) of EN 1993-1-1 artice 6.2.9.1(4)

its effect on the moment resistance about the y-y axis is neglected.

Note: Since the axial force satisfies criteria (6.35) of EN 1993-1-1 artice 6.2.9.1(4) its effect on the moment
resistance about the z-z axis is neglected.
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The stability check can be found in SCIA Engineer under Menu bar > Design > Steel members > ULS
Check or Process toolbar > Steel > Steel ULS check . In the properties of the check, you can choose to
look at the Brief, Summary or Detailed output, as explained in the previous chapter.

In below the stability check will be explained and the detailed results are shown.

4.1. Classification
The classification can be different for the section check and for the stability check.

Classification in the section check: the classification is done for each section on the member and
afterwards the section check will be executed with the classification and the internal forces on this section.

For the classification in the stability check  there are two approaches possible:
e Maximum class along the member
« Utilisation factor n (eta) (since SCIA Engineer 21.0)

You can define the stability classification method in the steel settings:

B Steel setup x
[=- standard EN Name Standard EN -
=l Steel o
- Member check teel
- Fire resistance 4 Member check EN 1693-1-1
- Cold Formed 4 (Classification EN 1993-1-1:5.2.2

Plated structural elements
- Limit slenderness Hee SemiColnp: gyes
- Buckling defaults Plastic analysis Elastic Stresses v
- 515 deflection check

Stability classification method Max. class along member  ~ I

- Autodesign e
4 Utilisation factor
Max. class along member

G
4 Torsion EN 1993-1-1: 6.2.7

Limit for torsion [-] 005

4 Default sway types EN 1993-1-1:6.3.1
¥y @yes
Bk no

4 Buckling length ratios ky, kz EN 1893-1-1: 6.3.1

Max. k ratic [-] 10.00
Max. slenderness [-] 200.00
an order buckling ratios Acc. to input v
4 Lateral Torsional Buckling EN 1993-1-1:6.3.2

Reference: Valorisation Project: SEMI-COMP+ n® RF52-CT-2010-00023

Description: Utilisation factor n: Setting to use the equivalent member classification as the stability class
by means of the utilization factor as described in the SEMI-COMP+ publication.

Max. class along member: The worst section classification along the member is used as the stability
classification.

Application: The chosen method determines how the stability class is obtained and therefore directly
influences the stability checks.

Load default non-MA parameters Load default NA parameters | Cancel

4.1.1. Maximum class along the member

For each load case/combination, the classification for member buckling design is determined as the maximum
class along the member. This class is used to perform the stability check since stability effects are related to
the whole member and not to a single cross-section.

To determine this critical classification, all sections in the Ly and Lz system lengths of the buckling system
are checked and the worst classification is used  as the critical. Note that only sections on the actual member
are used so in case the system length spans multiple members, only the sections of the actual member are
used to determine the critical classification.

For non-prismatic sections, the stability section classification is determined for each intermediary section.
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4.1.2.  Utilisation factor n

The utilisation factor n is in essence a value that reflects how much the section is utilized. The stability
classification is taken as the section classification at the section with the maximum utilisation factor n. This is
also called as the equivalent section class for member buckling design.

Notes:

e This approach leads to a more economic design of steel structures as the stability classification
is based on the section with the highest utilisation in contrary to the previous approach which
conservatively takes the worst classification along the member.

» This implementation has been verified with benchmarks based on all the worked examples
provided by Ref.[36] on p. 141-193. With one minor remark in which worked example 7 of
Ref.[40] contains wrong values for n due to mixing up steel grades (S355 & S235) between the
classification and individual checks.

Utilisation factor calculation via direct formulas:

The utilisation factor n can be derived via direct formulas in certain use cases.

e Only single section checks are used:
Basically if the only section checks are single section checks such as single bending and/or
compression, meaning no combined section checks are present. In such cases the utilisation
factor n can be determined as follows depending which single section check has the highest
unity check:
0 maximum section check is coming from the compression check
n= UCN_

0 maximum section check is coming from the bending My check
n = UCy,

0 maximum section check is coming from the bending M: check
n = UCy,

« Certain linear combined section checks are used:
0 linear summation (eq. 6.2 of EN1993-1-1):

)e <|NEd| o Mygal | IMZ,Ed|>

Nra  Myyra Myzra

0 maximum longitudinal stress in case of class 3 (eq. 6.42 of EN1993-1-1)

N = Ymo . <_NEd My gq - Z n M, Eq 'Y)
fy (1= Pmax) \ Aefr I, I,
0 maximum longitudinal stress in case of class 4 (eq. 6.43 of EN1993-1-1)
= YMo _<|NEd| + L 4 |Mz,Ed|)
fyr (1= Pmax) \ Aett  Werry  Werr,

o linear effective summation in case of class 4 (eq. 6.44 of EN1993-1-1)
[NEgl |My.Ed| + INgal - e, N |Mzga| + INgal 'eNZl

Aeff We ff,y,min Weff,z,min

_ Y™mo
fy ' (1 - pmax)

n

Utilisation factor calculation via an iterative app roach:

An iterative approach is used for more complicated combined section checks in which a direct formula
cannot be derived.

The iterative approach increases a set of internal forces (N, Myed, Mzed) simultaneously in small steps until
the point is reached where one of the section checks reaches a unity check of 1. The increase of internal
forces happens by means of dividing the set of internal forces (N, Myed, Mzed) with the same utilisation factor

n.
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Example: Industrial hall.esa

Consider column B28 (for combination CO1-ULS). When we have a look at the section class, we can see
that a part of the column is classified as class 1, a part as class 3 and a part as class 4.

P

¥ ¥ ¥ ®

>

7 ®
/

When we use Maximum class along the member as stability classification method , the worst section
class (class 4) is taken as the stability class. This leads to an overall unity check of 0.95

RROURNRARRR

¥y ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥

>

We can calculate more economic by taking the stability classification method  as Utilisation factor nin
the steel settings . The decisive position for the stability classification is now based on the utilisation factor.

The decisive position for stability classification is at 6.9 m (at the top of the column) and the decisive
utilisation factor is 0.59. This leads to a stability class 1 and a more economic unity check of 0.86

<% LESRERAREE
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4.2. Flexural buckling
The flexural buckling check will be executed following EN 1993-1-1 art. 6.3.1 formula (6.46):

Nb,rd is calculated with a reduction factor x, which is depending on the buckling factor k. Since this buckling
factor is playing an important role in this calculation, we will start with explaining this factor and we will focus
on the flexural buckling check itself further in this chapter.

4.2.1. Buckling factors

In SCIA Engineer the calculation of the buckling coefficient ky or kz can be done automatically or you can set
it manually.

Since SCIA Engineer 18.0 a new dialog is introduced for applying buckling settings on a specific buckling
system called System lengths and buckling settings . Prior to SCIA Engineer 18.0 there was a dialog for
the buckling settings called ‘Buckling and relative lengths’ which offered similar settings but without the
graphical window and even without the results.

General method

The buckling coefficients ky and kz are, by default, automatically calculated by SCIA on the base of two
approximate formulas respectively for sway and non-sway structures. These formulas produce buckling
coefficients which are, respectively, larger (sway) and smaller (hon-sway) than 1.

Sway mode Non-sway mode

So it is important for this method that you choose the correct option sway or non-sway for the two local
directions:
e y-y: buckling around the local y-axis (so deformation in the direction of the local z-axis)
« z-z: buckling around the local z-axis (so deformation in the direction of the local y-axis)
Z
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The option sway or non-sway can be chosen for the whole structure in the steel settings :

B Steel setup K
[=- Belgian NBN-EN NA Mame Belgian NBN-EN NA ~
=) Steel
=l 4

- Member check Sleet
- Fire resistance 4 Member check EN 1993-1-1
L i 4 Classification EN 1993-1-1: 5.2.2
i Plated structural elements Toreee: m =
- Limit slenderness e =IET L Om By
-~ Butkling defaults Plastic analysis Elastic Stresses v
i SLS deflection check Stability classification method Max. class along member ¥
L Autodesign

4 Shear EN 1993-1-1: 6.2.6

UseAy,Az instead of elastic shear no
4 Torsion EN 1993-1-1:6.2.7
Limit for torsion [-] 0-05
4 Default sway types EN 1993-1-1: 6.3.1
vy @ yes
2z na
4 Buckling length ratios ky, kz EN 1993-1-1:6.3.1

Max. k ratio[-] 10.00
Max. slenderness [-] 200.00

an order buckling ratios Acc. to input ¥

4 Lateral Torsional Buckling EN 1993-1-1;6.3.2
Lateral torsional buckling curves Generalcase hd
Method for C1 C2 C3 ECCS 119/Galea v
Methed for k, EN 1993-1-1table 6.6 o4

4 General settings
Elastic verification no
Verifv onlv section checks no i

Load default non-MA parameters Load default NA parameters Cancel

This can also be changed for each element separately, by using the system lengths and buckling settings.
This can be found for each element via Property panel > Buckling > System lengths and buck  ling
settings > Settings > Span settings . These properties can be inputted in the graphical window as well.

B System lengths and buckling settings m} X

il FEr e ee

Settings Results

Name BC13

Buckling span Deflection span

.y Deflection z = NN
Zz= 2 ¥ Deflection y = zz v
yz= zz ¥
B= zz ¥

4 Active buckling constraints

“ vy 1z

~
-
| <
B L

4 Spansettings

Buckline lensth factors Settines per span for v-v axis
Il-wfacfor Calculate ¥ I Sway y-y
1 &8
Swavv-v Custom ~
From setup
LAl sway
All non-swa
z i

Save Cancel

For Sway y-y and Sway z-z there are 4 options:
» From setup : the same option will be taken as in the steel setup as shown above;
» All sway : sets all spans of the axis system as sway;
e All non-sway : sets all spans of the axis system as non-sway;
e Custom : allows editing the sway settings per span.
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The following formulas are used for the buckling ratios:
» for a non-sway structure (k < 1):
1 _ (p1p2 +5p1 + 5p; + 24)(p1p, + 4py + 4p; +12)2

L (2pipy + 11ps +5p, + 24)(2p1p, + 5py + 11p, + 24)
» for a sway (flexible) structure (k > 1):

1 2
—=k=x|—+14
L p1X

With:
. — 4p1p2+T°py
m2(p1+p2)+8p1p2

L] . = 1

Pi =4
e k buckling factor
e L system length
 E modulus of Young
e | moment of inertia
e (= % stiffness in node i

1

o M moment in node i
s O rotation in node i

The values for Mi and @ are approximately determined by the internal forces and the deformations, calculated
by load cases which generate deformation forms, having an affinity with the buckling form. So when
performing a linear calculation, in the background 2 additional load cases are calculated, just to calculated
the buckling factors for the elements.

This calculation is automatically done when calculating the construction linearly. So when calculating
nonlinear, you should also perform a linear calcula tion otherwise no buckling factors are calculated
and no steel code check can be performed.

The following load cases are considered in the linear calculation for the calculation of the buckling factors:
* load case 1:
0 local distributed loads qy=1 N/m and gz=-100 N/m on the beams
0 global distributed loads Qx =10000 N/m and Qy =10000 N/m on the columns
* load case 2:
0 local distributed loads qy=-1 N/m and gqz=-100 N/m on the beams
o global distributed loads Qx =-10000 N/m and Qy=-10000 N/m on the columns

The used approach gives good results for frame structures with perpendicular rigid or semi-rigid beam
connections. For other cases, you must evaluate the presented bu  cking ratios .

The concept of sway or non-sway structure is directly linked to the critical coefficient acr issue of the stability
analysis (see for reference the ECCS 119):
* When acr 2 10, the structure is non-sway, therefore the buckling coefficients will be smaller
than 1;
* When acr < 10, the structure is sway, therefore the buckling coefficients will be larger than 1.
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Hence, you should perform a stability analysis prior to setup the sway / non-sway parameter. In that way you
can optimise better the buckling coefficients ky and kz than only with the linear analysis.
* Ifa¢ 2 10, you can simply perform a linear analysis specifying, in the steel settings window,
the non-sway behaviour of the structure for the y-y and z-z directions. Then the non-sway
formula will be used to compute the buckling coefficients for all members.

B Steel setup X |
(= Belgian NEN-EN NA Mame Belgian NEN-EN NA -
- Steel
- 4
- Member check Stecl
- Fire resistance 4 Member check EN 1993-1-1
- Cold Formed 4 Classification EN 1993-1-1:5.2.2

- Plated structural elements

- Limit slenderness Use Semi-Comp+ e
- Buckling defaults Plastic analysis Elastic Stresses v
- 5L5 deflection check Stability classification method Max. class along member ¥
- Autodesign
4 Shear EM 1993-1-1: 6.2.6
Use Ay_. A, instead of elastic shear no
4 Torsion EMN 1993-1-1:6.2.7

Limit for torsion [-] ©-05

4 Default sway types EN 1993-1-1: 6.3.1
¥y no
ZE no

4 Buckling length ratios ky, kz EN 1993-1-1: 6.3.1

Max. k ratio [-] 10.00
Max. slendérness [-] 200.00

an order buckling ratios Acc. to input ¥
4 Lateral Torsional Buckling EN 1993-1-1: 6.3.2
Lateral torsional buckling curves General case "
Method for C1 C2 C3 ECCS 119/Galea v
Method for k_ EN 1993-1-1 table 6.6 ¥l i

Reference! EN 1993-1-1 article 6.3.1.3
Description: Setting for the sway type y-y.
Application: The sway type is used for determining the appropriate buckling cosfficient ky.

Load default non-NA parameters Load default MA parameters Cancel

* Incase ag <10, you can choose to perform a linear analysis using sway buckling factors
(which are always larger than 1). This method results in a much simpler analysis with respect
to a second order analysis accounting for global and local imperfections. However, you should
carefully check that this possibility is allowed in the used design norm (for instance, the Belgian
national annex of Eurocode currently does not allow this method, thus requiring a second order
analysis). Also, note that this method is more conservative with respect to a second order
calculation accounting for global and local imperfections.

Note: sway and non-sway is not the same as unbraced and braced:
e If Wor > 0,2 Wunor: the frame is unbraced;
o IfWur £0,2 Wunor: the frame is braced.

Wy is the lateral flexibility of the structure with bracing system.
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As said before, the formulas used for the computation of ky and kz are valid only in case of rigid and/or semi-
rigid frame structures. This limitation implies that the ky and kz values automatically computed by SCIA
should be critically checked when the application case is different from the one specified above. In such

cases you have several possibilities:

« Limitation of the calculated value for ky and kz, to be set in the steel settings window:
B Steel setup e
(= Belgian NEN-EN NA Mame Belgian NEN-EN NA Ll
- Steel
. 4
- Member check Steel
- Fire resistance 4 Member check EN 1993-1-1
- Cold Formed 4 Classification EN 1993-1-1:5.2.2
- Plated structural elements =
- Limit slenderness Use Semi-Comp+ e
- Buckling defaults Plastic analysis Elastic Stresses v
- 5L5 deflection check Stability classification method Max. class along member ¥
- Autodesign
4 Shear EN 1993-1-1: 6.2.6
Use Ay, A, instead of elastic shear no
4 Torsion EN 1993-1-1:6.2.7
Limit for torsion [-] 005
4 Default sway types EN 1993-1-1: 6.3.1
ry o)
z-z no
4 Buckling length ratios ky, kz EN 1993-1-1: 6.3.1
Max, k ratio [-] 10.00
Max. slenderness [-] 200.00
an order buckling ratios Acc. to input ¥
4 Lateral Torsional Buckling EN 1993-1-1: 6.3.2
Lateral torsional buckling curves General case ¥
Method for C1 €2 €3 ECCS 119/Galea L4 "
Reference; EN 1993-1-1 article 6,3.1.3
Description: Limit for the buckling ratios for flexural buckling.
Application: Value which serves as a limit for the calculated buckling ratios. The buckling ratios are
'capped’ atthisvalue,
Load default non-NA parameters Load default MA parameters Cancel
)

and buckling settings

window:

Manual input of the buckling coefficient or buckling length, to be set in the System lengths

B System lengths and buckling settings o x
Gl TEHIES
Settings  Results
Name BC58
Buckling span Deflection span
¥y Deflection z = i
iz Zx ¥ Deflection y = zz v
yz= zz ¥
oB= zz ¥
éﬁ\ b Active buckling constraints
4 5 i
ILI pansettings
Buckline leneth factors Settines per span for v-v axis
G kv factor Factor ¥ ky [ Sway y-y
* i b 1.00
Swav v-v Custom ¥ a
Ll 2 1.00 a8
% Member imperfection in 2nd order analvsis 3 1.00 L]
Ll Bow imperfection e, EN1993-1-1Tabl v
ul)
‘*‘ b Advancedsettings
! s
E
J =
g PO
2 i
Qg 2w
Save Cancel
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*  Numerical computation of the buckling coefficient via a stability analysis.

In this last case, a stability analysis should be performed, and the instability mode of the
element for which the ky and kz are looked for should be retrieved. Once this has been done,
these stability modes can be affected to the element via Input panel > Steel > Stability

member data or Process toolbar > Steel > Stability member data

#7 Stability

Name SMD1
Normal force for ky, ke Average

b

Stability combination for ky 51/4 -6927.50
Limit ky max 10

Stability combination for kz $1/1 - 500.75
Limit kz max 10

OK

Cancel

Example: Buckling Factor.esa

Consider column B1:
¢ L =4000mm
¢ Set as sway
* Innode N1: My=0kNm > C2=p2=0
e This node N1 defines p2 because p: is always the smallest of the two.
* Innode N2 for load case LC1:
0 My1=79883 kNm

0 @1=¢_y=1523,3 mrad
0 Ci=Myt/e1=79883 kNm /1523,3 mrad = 52,44 kNm/mrad = 5,244 x 10*° Nmm/rad
0 E =210000 N/mm?2
o |ly=162700000 mm*
GL 5,244-101:;\11mm-4000mm
° pl - E - 210000 N 162700000 4 - 6'139
m mm
4p1py+m2PL 46,139-0+126,139
(0] = 2 = = 1,0
m2(p1+p2)+8p1p2  T2(6,139+0)+8:6,139:0
0 k=x/i+4=1,0/ " 4 4=12368
p1X 6,3691,00
o N. = m?El _ m%210000N/mm?*162700000 mm* — 3758575 N = 3759 kN

T gz T (2,368)2(4000)?

Those values can also be found in SCIA Engineer: via Menu bar > Design > Steel members >
Slenderness or Process toolbar > Steel > Steel slenderness  the buckling length ky will be found:

Steel slenderness
Linear calculation

Member CSName Part Swayy Ly ky ly Lamy |lyz | ILTB
_[m] [m]  [] [m] [m] |

kz Iz Lam z
[-1 [m] [-]

63.31| 4.000| 4.000
Yes 4.000| 1.00] 4.000| 105.61
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This value can also be found in the stability check through Menu bar > Design > Steel members > ULS
Check or Process toolbar > Steel > Steel ULS check under the buckling parameters. And here also the
critical normal force Ner can be found:

Buckling parameters Yy 2z

Sway type sway sway

System length L 4.000 4.000 m

Buckling factor k 2.37 1.00

Buckling length ler 9.472 4.000 m

Critical Euler load Ner 3758.82 |1351.09 |kN

Slenderness A 63.31 105.61

Relative slenderness Arel 0.67 1.12

Limit_slenderness Arelo 10.20 0.20

Calculation of buckling factors for crossing diagon als

As the previous default method is only valid for perpendicular connections, this method cannot be used for
the calculation of the buckling factors for diagonals.

In the DIN 1880 Teil 2, Table 15 a method is given for the calculation of the buckling factor for crossing
diagonals. In SCIA Engineer this option is also implemented. In this method the buckling length sk is
calculated in function of the load distribution in the element and sk is not a purely geometrical data.

This method is only applicable for 2 diagonals with a hinged or rigid connection in the middle. To use this
functionality in SCIA Engineer, you must connect the two diagonals with the option Input panel > Structure
> Boundary conditions > Crosslink

— INPUT PANEL & Structure

= Boundary conditions 0 # CROSSLINK

4 TEE AL AP HH|¥+e Lo
0 00

When connecting two beams with this option, in the System lengths and buckling settings ~ window of the
two elements you should set Crossing diagonals as special buckling system type (this option can be found
under Advanced settings ):

Settings Results

Name BC173

Buckling span Deflection span
® y-y Deflection z = yy Vv
z-z= 2z ¥ Deflectiony = zz v

yz= 2z VY

oB= 2z Vv

P Active buckling constraints
4 Spansettings

Buckling length factors Settings per span for v-v axis
kv factor Calculate Y. Sway y-y
1
Swav v-v From setup v

Member imperfection in 2nd order analvsis

Bow imperfection e0.v  From setup v

4 Advarcedsettings

Lateral Torsional Buckling Special buckling
Point of load application In shear center v | Tvoe  Crossing diagonals v
Mcr Calculated v

Warping check
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If this option is used, SCIA Engineer will use the method from EN1993-2 to calculate the buckling factors for

the diagonals:

ANC,
p- |
I' l+1'%

Z/ but = 0.5

o

il
y but £ 0.5

y continuous compression members | hinged compression members
7 - Nt ﬂ1= 0.5
3 'B= Jl +T_'7 \rf-
i \ 12 NE, when
[P LY ]
x4 \12 N(f
B=1-075 =
- \ N¢,
but = 0.5
z/l p=05
13
when ey <1
5 ZL
3Z¢2 (Nt
orwhen EI 2 “l',’ {L- I}
4x° \ YA
N s N
[ X/
-[075-025/% (0,75-0.25M
ell - 7 <, B=|0,75-023 = B.=|0 5-025—+
(%) \
- \\ but ﬁZ 0.5 Ni<N
N b4
With:
B buckling length factor
e L member length
e I length of supporting diagonal
o | moment of inertia (in the buckling plane) of the member
e It moment of inertia (in the buckling plane) of the supporting diagonal
« N compression force in member
* N compression force in supporting diagonal
e Z tension force in supporting diagonal
- E modules of Young (elastic modulus)
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Calculation of the buckling length for a VARH eleme  nt

For a VARH element, SCIA Engineer will use another calculation for the buckling length.

A VARH element is defined as follows: the member has the properties of a symmetric | section where only
the height is linear variable along the member. The system length for buckling around the local y-y axis
(strong axis), is equal to the member length.

For a VARH element we can define

e ky buckling coefficient around the y-y-axis
e Ly system length around the y-y-axis
e lymax maximum moment of inertia around the y-axis
e lymin minimum moment of inertia around the y-axis
*  lyeq equivalent moment of inertia around the y-axis
- E modules of Young (elastic modulus)
Ny critical Euler force around the y-axis
i
I>q I
L
A ’ l”l I
4 Xo
D3

Hirt and Crisinel (Ref. [17]) presents expressions for the elastic critical load of axially loaded non-prismatic
members of double symmetric cross-sections. Flexural buckling around the strong axis of the cross-sections
occurs for:

2. 5.
T E-Ijeq

) (ky ' Ly)z

Nery

Where:
Iy,eq =C- Iy,max

And C is a coefficient that depends on the parameter r, defined as the ratio between the minimum and the
maximum moments of inertia.

r= Iy,min
Iy,max

For a tapered member, C can be calculated as:
c=008+092-r

Example: VARH.esa

350-mm 300-mmfp---===-p===-ce—fecmcecqrccccncdenncna 750-mm 800-mm

3]

Consider column B1: the VARH element going from 800 mm to 300 mm
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The VARH is internally divided into a number of prismatic members. In this case, in 5 parts, but this can be
changed in the Mesh setup window (Menu bar > Tools > Calculation & mesh > Mesh settin  gs) :

B Mesh setup X

Mame MeshSetupl
Average number of 1D mesh elements on straight 10 members 1
Average size of 1D mesh element on curved 1D members [m] 1.000
Average size of 2D mesh element [m] 1.000
Connect members/nodes
4 Advanced mesh settings
4 General mesh settings
Minimal distance between definition point and line [m] ©.001
Definition of mesh element size for panels Automatic v
Average size of panel element [m] 1.000
Elastic mesh
4 1D elements
Minimal length of beam element [m] ©.100
Maximal length of beam element [m] 100.000
Average size of cables, tendons, elements on subsoil, nonlinear soil sprin 1.000
Generation of nodes in connections of beam elements

Generation of eccentric elements on members with variable height

I Divisien on haunches and arbitrary members 5 I

Division for integration strip and 20-1D upgrade 50
Mesh refinement following the beam type None ¥

Method of haunch export Constant parts v
A& OK Cancel
— . 8 4
Iy min = 1,7041 - 10°mm
— . 9 4
Iymax = 1,6989 - 10mm

1,7041 - 108 mm*
1,6989 - 10°mm*

=0,316711

C=0,08+092+r=03713
Iyeq = C * Iy may = 0,3713 * 1,6989¢° = 6,3093 - 108mm*

T * Exlyeq
Ncr,y = W = 4503,61 kN
Flexural Buckling check
According to EN 1993-1-1 article 6.3.1.1 and formula (6.46)

Buckling parameters Yy zz

Sway type sway sway

System length L 4.000 4.000 m
Bucking factor k 4.27 1.00

Bucking length ler 17.075  [4.000 m
Critical Euler load Ner 4485.32 |7000.23 |kN
Slenderness A 134.11 55.79

Relative slenderness Arel 1.43 0.59

Limit slenderness Ao [0.20 0.20

Buckling curve b (5

Imperfection a 0.34 0.49

Reduction factor X 0.37 0.79

Buckling resistance Nbrd |914.27 1948.85 |[kN
Tapered member data

Minimum second moment of area Iymn [1.7041e+08 |mm*
Maximum second moment of area  |Iymsx  |1.6989e+09 [mm?*
Taper coefficient € 0.37

Equivalent second moment of area |l e |6.3093e+08 [mm?*

Flexural Buckling verification

Cross-section _area  |A 1.0512e+04 |[mm?
Bucking resistance |[Nbgrd [914.27 kN
Unity check 0.77 -
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4.2.2. Buckling length

In the previous paragraph the general calculation of the buckling factors has been explained for all type of
elements. With this buckling factor the buckling length of the beam will be calculated as follows:

=k -L
With:
o | buckling length
e k buckling factor
e L system length

The system length of an element is defined by the property ‘System lengths and buckling settings’ of the
element. It is the distance between the buckling supports.

The buckling length can be calculated with the buckling factor (which can be calculated automatically or
manually inputted) or it can be given manually.

Example: Buckling Length.esa

Consider column B3. This column has 3 nodes: N5, N10 and N6. The local x direction goes from the bottom
to the top of the column, so internal for SCIA Engineer N5 is the first node of this column and N6 the last

one.

In the property panel for this column, you can choose for System lengths and buckling settings . With this
option, the system length of the beam can be inputted. By default the following option will appear:

|

B Systern lengths and buckling settings
iFRIEEEs fe
Settings  Results
:} Name BCs
Buckling span Deflection span
. gy Deflection z= SEl
wr= Ian ¥ Deflection y = =z v
yz= zz ¥
oOB= 22 ¥
b Active buckling constraints
Spansettings
N 'ml}
™ =~ Buckline leneth factors Settinzs per soan for v-v axis
lew factor Calculate v, Sway y-y
-l 1 B3
Swav v-v Custom v

\ Member imperfection in 2nd order analvsis

Bow imperfection e0.v  No bow imperfect ¥

o |

P Advancedsettings

« e

T A d

Save Cancel
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Explanation of the system lengths:
« The first node (according to the local x-axis) is node N5, the last one is node N6.
e y-ydirection:

0 This means around the local y-axis. So the column will deform in the z-direction.

0 Around the y-axis, node N5 is supported. In node N10 no beam can be found in the
local z-direction in this point, thus column B3 is not supported around the y-axis in
node N10. In node N6 a horizontal beam in the local z-direction can be found and the
column will be supported around the local y-axis (y-y) in node N6. This is indicated
with the triangles in this window:

= Supported in node N5
= Not supported in node N10
= Supported in node N6

e z-z direction:

0 This means around the local z-axis. So the column will deform in the y-direction.

0 Around the z-axis, node N5 is supported. In node N10 a horizontal beam in the local y-
direction can be found and the column will be supported around the local z-axis (z-z) in
node N10. Also in node N6 a horizontal beam in the local y-direction can be found and
the column will also be supported around the local z-axis (z-z) in node N6. This is
indicated with the triangles in this window:

= Supported in node N5
= Supported in node N10
= Supported in node N6
e The system length will be taken as follows:

0 Around the y-axis: the length between node N5 and N6: so 3 m

0 Around the z-axis: the length between node N5 and N10 for the first part of the column
(1,8 m) and the length between N10 and N6 for the second part of the column (1,2 m)

0 This can also be found via Menu bar > Design > Steel members > Slenderness  or
Process toolbar > Steel > Steel slenderness
Steel slenderness
Linear calculation

Member CSName Part Swayy Ly ky ly Lamy lyz |ILTB
z m z

Sway z Lz
[m] [] [m] [-]
B3 CS3 1|Yes 3.000f 1.09| 3.270( 18.51 | 1.800| 1.800
No 1.800) 0.51| 0.919| 26.78
B3 CS3 2 |Yes 3.000f 1.09| 3.270| 18.51 | 1.200| 1.200
No 1.200) 0.57 | 0.680| 19.83

In this window you can easily check the system length (Ly and Lz), the buckling factors
(ky and kz) and the buckling length (Ily = ky x Ly and Iz = kz x Lz).

As mentioned before, since SCIA Engineer 18.0 a new dialog is introduced for applying buckling settings on
a specific buckling system called System lengths and buckling settings

System lengths and buckling settings can be accessed either:
e via Menu bar > Libraries > Structure and analysis > Buc  kling groups and click on <New>
for creating a new buckling group or click on <Edit> to modify an existing buckling group.

« viathe properties of a 1D-member: Property panel > System lengths and buckling
settings .
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7 System lengths and buckling settings

FEEIEESE ESg

Settings  Results

BCs

Name

Buckling span

Sy

22= 22z ¥

Deflection span
Deflection z =
Deflection y =

o M

zz v

yz= zZ ¥

TB= 22 v

b Active buckling constraints
4 Spansettings
Settines oer soan for v axis
v Sway y-y
1

Buckline lensth factors
kv factor

Calculate

Swav vy Custom ¥
Member imperfection in 2nd order analvsis

Bow imperfection ey Mo bow imperfect ¥

N,

b Advancedsettings

= [}E‘% 9

The left part of the dialog gives you a graphical representation of the 1D-members in the buckling system
with their buckling constraints and information about the sway settings per span. It is not only a
representation of the above mentioned settings, but it also allows editing directly in that graphical window
by clicking on the buckling constraints to set them to fixed/free or by clicking on the sway symbols per span
to set them to From setup , All sway , All non-sway or Custom . By clicking on the triangles indicating the
system lengths of each part of a beam, you can change the buckling constraints.

Save Cancel

For the buckling constraints there are two symbol types depending on the chosen span:
* Triangle symbol (buckling span y-y, z-z and for the deflection spans deflection y, deflection z)

* Rectangular symbol (buckling span y-z, LTB (Lateral Torsional Buckling))

Besides this, with this new improved buckling settings, it is easier to access the results. You can see them by
clicking on the Results tab of the system lengths and buckling settings window.

B Systern lengths and buckling settings

e IEEBE o6

& & G 1 T Default ~xHHIT | ®

~
Steel slenderness

Linear cakulation
Member | CSMame  Part Swayy | Ly

ky Iy Lamy  lyz  ILTB
m} [-1_[m].

Swrayz

E e

B3 Cs3 1|Yes L09 | 3.270| 1851 L
Mo 1800 | 0.51 | 0.519 | 26.78

B3 cs3 2|Yes 3,000 | 1.09 | 3.270| 1851 1.200 | 1.200
No 1.300 | 0.57 | 0.6B0 | 19.

|
{ ||||\\:§'

~ e, v
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Compare column B3 and column ‘B2+B30’ with each other: they should have exactly the same system
length. The only difference between those columns is that element B3 was inputted as a beam of 3 m and
column ‘B2+B30’ is divided in two parts. SCIA Engineer will consider those two beams also as one buckling
system:
* When the local axes are exactly in the same direction (so in this case the local x-axis is in the
same direction and the angle between the beams is exactly 180°).
« If no hinge has been inputted between the two beams.

Now look at beam B13. The system lengths are the following (as expected, because there are horizontal
beams in the two directions on each node):

yy  zz

" p 1 4
p 4
P4

When looking at the rendered view, it will be clear that beam B16 is too weak to have an influence on the
system length of beam B13. In SCIA Engineer there is possibility to exclude a beam from a buckling system.

Select beam B16 and go to ‘Buckling’ in its properties window. It is possible to indicate that beam B16 is a
secondary beam and should not be considered in the system lengths:

%
MEMBER (1) A
Name B16
Layer Layerl v =

Type beam (80) »
Analysis model  Standard
FEM type standard

Cross-section €S54 - RD8 v~ =
Alpha [deg] o0.00
Member system-line at  Centre
ey [mm] 0.00
ez [mm] 0.00
LCS standard
LCS Rotation [deg] 0.00
¥ BUCKLING

System lengthsand ... Default ~ :_.—:

Material and no.of p...

I Secondary member (V) I
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When looking now at member B13 and changing the System lengths and buckling settings  back to

Default , the member B16 will not be included in the system lengths:

Name
Layer
Type
Analysis model
FEM type
Cross-section
Alpha [deg]
Member system-line at
ey [mm]
ez [mm]
LCS
LCS Rotation [deg]
v BUCKLING

B13

Layerl ~~

column (100)
Standard -
standard ~~

C53 - 1450

vy  zz

28
4

0.00
Centre ~
0.00

0.00
standard

0.00 2

System lengths and ...  Default =

Material and no. of p...

28

£

Secondary member

4.2.3. Flexural buckling check
The flexural buckling check will be executed following EN 1993-1-1 art. 6.3.1 formula (6.46):

N
B<1
Np rd
Where:
A, .
* Npra= Xy y for class 1, 2 or 3 cross-sections
M1
Aetrf .
© Nprq =2 Y‘*ff Y for class 4 cross-sections
M1

The reduction factor x will be calculated as follows:

1

= — butx<1,0
X D+ D?—)2 X=
With:
« ®=05[1+a(X-0.2)+2?]
. A= ’N for class 1, 2 or 3 cross-sections
cr
A= Aetrly for class 4 cross-sections
NCI‘
__ m’El .
e Ng= L2 critical normal force (Euler force)
e a imperfection factor depending on the buckling curve:
Buckling curve ao a b c d

Imperfection factor o 0,13 0,21 0,49 0,76

The selection of the buckling curve for a cross-section is done with EN 1993-1-1, Table 6.2
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Table 6.2; Selection of buckling curve for a cross-section

Buckling curve
Buckling | 5 235
Cross section Limits about 5275
axis 8335 e
5420
b 5 V—¥ a ag
e te = 40 mm z—z b an
2 't' v—¥ a
= <= | 40 mm <1< 100 Fer e
& z—-z2 c a
#
_i'l R T
= o | =100 mm e . :
- v
N =]
= y—¥ d C
ty = 100 mm e d ;
" tr < 40 mm Y i »
g £ z—z c c
- e
i
= 8 ! ¥-¥ c c
= 40 mm e d d
— hot finiched any a a
=g
2.0
£ 3
- cold formed any c c
£ tr i
T I - | enerally (except as
i - |
g2 nl oy = -—
s ¥ E—H thick welds: 2> 0,5t;
= 1 ! I bits < 30 any c c
! Zh | 'ty <30
o B == %
=5 —
o 8 Il _\\—- ; any c c
52 T\
7 b
|
—
E
b= |
; y - 7 b b
2 = .
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Example: Buckling Curves.esa

In Table 6.2 general buckling curves are given for the most common profiles. For some cross-section types,
SCIA Engineer will automatically use these curves. The cross-section groups that are supported are:

Profile library;
Haunch;

Sheet welded;

Build-in beams;
Thin-walled geometric;
Fabricated.

For the other cross-section groups, the buckling curves for both directions are by default set to ‘d’. This can
be changed manually by changing the properties of the cross-section.

In this example 2 beams are inputted with 2 different cross-sections:

B1: CS1 - IPE180
o0 buckling curve a for y-y according to code
o0 stability check uses curve a, according to code
B2: CS2 — | form (Geometric shapes group)
0 non-standard cross-section: no buckling curve according to code. Buckling curve d is
used.
o stability check uses curve d

B Cross-section X

4 General

Draw colour Normal colour ¥

Colowr [ ]
7 AutoDesign constraints

Fabrication general v

4 Buckling curves

Edit buckling curves

Flexural buckling y-y d

7
Lh

Flexural buckling z-z <

Lateral torsional buckling Default

H 180
|

4 |Initial shape
Initial shape

Classification

[
42

N Effective section

{r o B Advanced procedure

E=F 4 Fibres and Parts

Fibre text zoom 1.0 v

B 91 Edit named items

4 AT TTREE L=

ta 8

E t Updat: D t
l 8 Ficture HFibres ¢ dbi/dy ddj. w oTxy P sl i il

0K Cancel
Cross-section lavout and dimensions s
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Once all the buckling factors and system lengths have been inputted correctly, the flexural buckling check
can be executed in SCIA Engineer.

Example: Industrial hall.esa

Consider column B28. The classification of beam B28 is class 4, so an effective cross-section has been
calculated:

Effective area At 1.7222e+04  |mm?
Effective second |Ly 1.6608e+09 |[mm* I 5.2895e+07 |mm*
moment of area
Effective section |Wesy |4.4111e+06 |mm? |Wes: [3.9920e+05 |mm?
modulus
Shift of the eny |0.00 mm  |en: 0.00 mm
centroid

SCIA Engineer will first show the buckling parameters of this beam:

Flexural Buckling check
According to EN 1993-1-1 article 6.3.1.1 and formula (6.46)

Buckling parameters Yy zz

Sway type sway non-sway
System length L 6.900 6.900 m
Bucklng factor k 3.58 0.87

Bucking length ler 24.716  |5.978 m
Critical Euler load Ner 5635.44 |3067.01 kN
Slenderness A 83.15 112:71
Relative slenderness Arel 0.85 1.15
Limit_slenderness Ao [0.20 0.20

Buckling curve a b

Imperfection a 0.21 0.34
Reduction factor X 0.77 0.51

Buckling resistance Nbgrd [3106.15 |2050.75 kN

In below the results of the yy direction are explained.

This direction has been set on sway in the steel setup and with this option the buckling factor k is
calculated.

The length of the column is 6,900 m, so the buckling length = 3,58 x 6,900 m = 24,716 m

With this buckling length the critical Euler load N¢r can be calculated. Afterwards the slenderness and the
relative slenderness can be calculated with the critical Euler load.

An IPE750 profile has a buckling curve a, resulting in an imperfection factor a = 0,21.

With those properties the reduction factor x will be calculated, which will be used in the following formula:
Xy X A x f, 077 x 1.7222 - 10*[mm?] x 235.0[MPa)
M1 1.00

Ny R = 3106.15[kN]

This result in a buckling resistance Np,rd = 3106,15 kN for flexural buckling around the local y-axis.
The same principle can be repeated for flexural buckling around the local z-axis.
This will result in a lower buckling resistance: No,rd = 2050,75 kN.

The lowest buckling resistance will be used in the flexural buckling check:

Flexural Buckling verifica

Cross-section effective area |A 1.7222e+04 | mm?
Bucking resistance Nbrd | 2050.75 kN
Unity check 0.08 -
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4.3. Torsional buckling

The check on torsional buckling can be important for profiles in which the position of the shear centre is not
the same as the centre of gravity of this section.

The torsional (-flexural) buckling check is executed according to EN 1993-1-1, art 6.3.1.4. In case of an RHS
section or CHS section the check will not be executed and a note will be shown instead. In case of an |-
section, when the check is not limiting it will not be printed and a note is shown instead. Not limiting is
defined here as a unity check lower than the unity check for Flexural Buckling. In case however Flexural
buckling can be ignored (due to low compression force or low slenderness) the comparison is done with the
unity check of the compression check. The buckling curve for torsional (-flexural) buckling is taken as the z-z
buckling curve. The value of the elastic critical load Ncr is taken as the smallest of Ner 7t (Torsional buckling)
and Ncr7r (Torsional-Flexural buckling). For doubly symmetric sections the elastic critical load N is taken
equal to NerT.

The elastic critical load Ner,t for torsional buckling is calculated as Ref.[37]:

1 m2El,,
Ncr,T =3 Gl + —
i I

0
i§ =15 +if +y§ + 25

i(z) (N - Ncr,y) (N - Ncr,z) (N - Ncr,T) - NZY(Z) (N - Ncr,z) - NZZ(Z) (N - Ncr,y) =0

With
« G shear modulus
- E modulus of elasticity
ey radius of gyration about the strong axis
* iz radius of gyration about weak axis
e |k torsion constant
o lw warping constant
e Iy buckling length for the torsional buckling mode
* yoandzo coordinates of the shear centre with respect to the centroid
*  Nery critical axial load for flexural buckling around the y-y axis
*  Nerz critical axial load for flexural buckling around the y-y axis
e Nert critical axial load for torsional buckling
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Example: Flexural Torsional buckling.esa

Look at the steel code check for member B1:

Torsional(-Flexural) Buckling check
According to EN 1993-1-1 article 6.3.1.1 and formula (6.46)

Torsional buckling length |l 3.600 m
Elastic critical load Ne v [2156.75 kN
Elastic critical load Nerre [1302.24 kN
Relative slenderness At 10.98
Limit_slenderness Arelo  10.20
Buckling curve C
Imperfection a 0.49
Reduction factor X 0.55
Cross-section _area A 5.3300e+03  |mm?
Buckiing resistance Nprd [690.40 kN
Unity check 0.14 -
x2ng x2 X ¢ L1010 6
Ner = .l] X (G S |(E ! ') - 125[r1nm]~’ X (80769,2[Mpa] x 3.1000 - 10°[mm*] + = 210000'0[%28(10[:]’3659 £t I)
= 2156.75(kN]

Ne tr = 1302.24[kN]

[AxT,  [5.3300-10°[mm?] x 235.0[MPa]

M= N 1302.24]kN] =098
1 1 1 1
= min e .1 | = min| ———————=.——.,1) = min(0.55,1.04,1) = 0.55
' @+ \““‘;2 - M7 Nt (1.17 +V1.172 - 0.982" 0.98° ) ( )
%A XE .56 X 5. - 103(mm2] % 235.
- x X Axf, _ 0.55 x5.3300- 10 [mm?] x 235.0[MPa] — 690.40[kN] EES A
™1 1.00
Unity check = JNed| = [=100.00[kN]| =0.14 < 1.00 (EC3-1-1: 6.46)
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4.4, Lateral torsional buckling
44.1. Calculation of Mcr

General formula

The elastic critical moment for lateral torsional buckling Mer is calculated by the following formula:

m2El, J( k )2 Iy N (kpr * L)2GI,

+ (szg - C3zj)2 - [szg - C3Z]-]

e P N AT A T
Where

- E Young modulus of elasticity (E = 210000 N/mm?2 for steel)

e G shear modulus (G = 80770 N/mma2 for steel)

e kur*L lateral torsional buckling length of the beam between points which have lateral
restraint (= ILte)

o lw warping constant

e |k torsional constant

L P moment of inertia about the minor axis

*  Zg distance between the point of load application and the shear center

o kw a factor which refers to end warping. Unless special provision for warming fixity is
made, kw should be taken as 1,0

o Z 7z =125—05 [, (y2+22)%dA
for doubly symmetric cross-sections: z; = 0

s Zs coordinate of the shear center

C1, Cz and Cs are factors depending on the loading and on the end restraint conditions.

In SCIA Engineer there are different methods implemented for the calculation of those C-factors. Those
methods are explained further in this chapter.

Haunched sections (I+lvar, Iw+Plvar, Iw+Ilwvar, lw+lvar, I+lwvar) and composed rail sections (lw+rail,
Iwn+rail, I+rail, [+2PL+ralil, I+PL+rail, [+2L+rail, I+Ud+rail) are considered as equivalent asymmetric |
sections.

The formula for Mcr uses the following parameters:
e (i, Cy, Ca: calculated according to ENV, ECCS or Lopez
e LTB length: kit*L
* kand kw: factors related to the end fixity
e Zg: load position
e z;; asymmetry of the section

More details about each parameter are given in separate chapters.

It is also possible to calculate Mcr with @ more precise calculation, a second order Lateral Torsional Buckling
calculation (LTBII) . This will be explained further in this chapter.
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Calculation of C 1, C2 and C3 factors

Three C-parameters are used in the general formula for Mcr:
* Citakes into account the shape of the moment diagram
* Catakes into account the position of the loading
» Castakes into account the asymmetry of the cross-section

The coefficients C4, C, and Cs can be calculated in SCIA Engineer according to three different methods:

« ENV 1993-1-1 Annex F

 ECCS 119/Galea

* Lopez, Yong, Serna

By default, the method according to ECCS 119/Galea is applied. The following paragraphs give more

information on these methods.

You can choose between those 3 methods in the steel settings:

B Steel setup

[=- Standard EN
- Steel

4 Torsion EN 1993-1-1: 6.2.7 ~

Limit for torsion [-] 0.05

4 Default sway types EN 1993-1-1: 6.3.1
vy B B yes
zz no

4 Buckling length ratios ky, kz EN 1993-1-1:6.3.1

Max. k ratio [-] 10.00
Max. slenderness [-] 200.00

2nd order buckling ratios Acc. to input v

4 Lateral Torsional Buckling EN 1993-1-1: 6.3.2
Lateral torsional buckling curves General case ¥
Method for C1 €z €3 ECCS 119/Galea A

ENV 1993-1-1 Annex F

“ Lopez, ‘l’og, Serna |
o

Elastic veritication

ENV 1993-1-1 Annex F

When this setting is chosen, the moment factors are determined according to ENV 1993-1-1 Annex F Ref.[5].

Verify only section checks no
Flexural buckling accounted for by an order calculation no
Mements en columns in simple construction no
o
Reference: EN 1993-1-1 article 6.3.2.2 (2)
Description: Setting for selecting the calculation method of the C1 C2 C3 coefficients.
Application: Used in the determination of Mcr, the elastic critical moment for lateral torsional buckling.
- ENV 1993-1-1 Annex F: A tabulated method where the actual moment diagram is compared to
standard diagrams.
- ECC5 119/Galea: A graphical method which accounts for interaction between transverse loading and
end moments.
- Lopez, Yong, Serna: A closed-form formula for C1 which accounts for the actual moment diagram.
Load default non-MA parameters Load default NA parameters Cancel

For determining the moment factors (EN 1993-1-1: C1, Cz and Cs) for lateral torsional buckling (LTB), we use

the standard tables.

The current moment distribution is compared with some standard moment distributions. This standard moment

distributions are moment lines generated by a distributed q load, a nodal F load, or where the moment line

reaches a maximum at the start or at the end of the beam.

The standard moment distributions which is closest to the current moment distribution, is taken for the
calculation of the factors C1, C2 and Ca.
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ECCS 119/Galea

When this setting is chosen, the moment factors are determined according to ECCS 119 Annex B Ref.[34].
The figures given in this reference for C1 and C: in case of combined loading originate from Ref.[28], which
in fact also gives the tabulated values of those figures as well as an extended range.

The actual moment distribution is compared with several standard moment distributions. These standard
moment distributions are moment lines generated by a distributed g load, a nodal F load, or where the
moment line is maximum at the start or at the end of the beam.

The standard moment distribution which is closest to the actual moment distribution, is taken for the
calculation of the factors C1 and Co.

Galea gives results only for C1 and C: factors. Cs is taken from ECCS 119 Annex B tables 63 and 64. Cs is
determined based on the case of which the C: value most closely matches the table value.

Lopez, Yong, Serna

When this method is chosen, the moment factors are determined according to Lopez, Yong, Serna
(Ref.[35]).

When using this method, the coefficients C;and Cs are set to zero.

The coefficient C1 is calculated as follows:

[ [ ] 050,

C, =
1 A1
Where:
A k = klkz
. A = M ax+ o M2 +aME+azM3+oyM3+asME
1= (1+a1+a2+a3+a4+a5)M12nax
R A, = M;+2M3+3M3+4My+5M;s |
2 9Mmax
L]
L]
L]
L]
L]
With:
e ki taken equal to kw
e ke taken equal to kw

« M1 —> Ms the moments My determined on the buckling system in the given sections as shown
on the above figure. These moments are determined by dividing the beam into 10
parts (11 sections) and interpolating between these sections.

*  Mmax maximal moment My along the LTB system

This method is only supported in case both k and kw equal 0,50 or 1,00.
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Comparison of the 3 calculation methods

In below an example in SCIA Engineer in which the three methods are calculated:

Example: Cfactors.esa

In the steel settings the chosen calculation method for the C-factors has been changed. In below an
overview of the results for those factors for the three methods:

ENV 1993-1-1 Annex F ECCS 119/Galea Lopez, Yong, Serna
LTB length lir {12,000 m LTB length I |12.000 m LTB length I |12.000 m
Influence of load position stabilising Influence of load position stabilising Influence of load position stabilising
Correction factor k 1.00 Correction factor k 1.00 Correction factor k 1.00
Correction_factor kv |1.00 Correction factor kv [1.00 Correction factor kv [1.00
LTB moment factor C |1.89 LTB moment factor C |1.26 LTB moment factor G |1.20
LTB moment factor C, |0.33 LTB moment factor C, |045 LTB moment factor C; |0.00
LTB moment factor C; 264 LTB moment factor C; |041 LTB moment factor C; |0.00
Shear centre distance d, [0.00 mm Shear centre distance d; [0.00 mm Shear centre distance d; [0.00 mm
Distance of load application [zq |-245.00 mm Distance of load application |zq [-245.00 mm Distance of load application |zq [-245.00 mm
Mono-symmetry constant By [0.00 mm Mono-symmetry constant By [0.00 mm Mono-symmetry constant By [0.00 mm
Mono-symmetry constant zj |0.00 mm Mono-symmetry constant z; |0.00 mm Mono-symmetry constant z; |0.00 mm
Mcr = 1576,03 kNm o =1118,50 kNm Mcr = 842,64 kNm

As you can see, there can be a big difference between the three calculation models.
In the method following ‘Lopez, Yong, Serna’ the values for Cz and Cs are always taken equal to zero.

When comparing the Ci factors, the method following ‘ECCS 119/Galea’ and ‘Lopez, Yong, Serna’ are
approximately the same (1,26 and 1,20 respectively), but the Ci factor following the ‘ENV 1993-1-1 Annex F’
results in a total different value: 1,89.

When we would calculate Mcr more detailed with the LTBII method (see chapter ‘Lateral Torsional Buckling
using LTBII"), we have 1169,66 kNm as result for Mcr on element B2. So the default choice for using ECCS
119/Galea to calculate the C-factors makes sense.

LTB parameters

Method for LTB curve General case

Plastic section modulus Woly 3.9490e+06 |mm3
Elastic critical moment Mcr 1169.66 kNm
Relative slenderness ArelL.T  [0.89

Limit slenderness ArelLT,0 [0.20

LTB curve a

Imperfection arT 0.21

Reduction factor XLT 0.74

Design buckling resistance  [Mb,rd 686.74 kNm
Unity check 0.70 -

Note: The elastic critical moment Mcris calculated using the FriLo BTII Solver.
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k and kw factors

It is generally assumed that k = kw = 1, which means that the ends of the element are not fixed. If the ends
are fixed, values lower than one can be used (usually 0,5 for full fixity or 0,7 for one end fixed and one end
free) and this would lead to bigger values of Mcr. You can adapt the values of k and kw within the system
lengths and buckling settings.

Select the member, then open the System lengths and buckling settings ~ window from the property panel.
Select LTB and in Span settings you can modify the values for k and kw:

Settings Results

Name BG1

Buckling span Deflection span
¥y Deflection z = yy V¥

zz= 2z ¥ Deflectiony = zz v
2= 22 ¥

b Active buckling constraints
4 Spansettings

kitb [-] k[ kw [-]
L 1.00 1.00 1.00

When using cantilever elements, these values are automatically changed by SCIA Engineer.

Load position
The load position has an influence on the calculation of Mcr through the value of zg. You can choose among
five load positions.

If you open system lengths and buckling settings, you can see an option called Point of load application
under the Advanced settings . The five possibilities are:

« Ontop: the load is applied on the top flange
e Inshear center : the load is applied in the shear center
e On bottom : the load is applied at the bottom flange
« Always destabilising :  the load is applied on the destabilising flange
e Always stabilising : the load is applied on the stabilising flange
[& System lengths and buckling settings =} *
[ FF REEEE S
. Settngs  Resulis
ﬁ Name BCs
Buckling span Deflection span
. gy Deflectionz = ¥y v
zz= Tz ¥ Deflection y = =z ¥
y2= zZ- ¥
OB= zz v
b Active buckling constraints
4 Spansettings
““N LD'
= Buckling leneth factors Setfines cer span for v-v axis
kv factor Calculats N Sway y-y
~> Swav v-v. Custorn v 1 B
IJ\ Member imperfection in 2nd order analvsis
-7 Bow imperfection eD.v  No bow imperfect v
@
= = 7 Ackmmer e s
Lateral Torsional Buckling Special buckling
AT . B Point of load acolication In shear center A |Tvoe  Notused
i »::%
L - Onbottom
. ~ e e

Save Cancel

This value is set to In shear center by default and can be adapted to influence the value of Mer.
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LTB length

LTB length is calculated as I.ts = ki * Lite

ki is by default taken equal to 1. A smaller value can be used to reduce the LTB length. You can adapt ki

within the system lengths and buckling settings:

Settings Results

Name BG1

Buckling span Deflection span
¥y Deflection z = ¥y v
zz= 2z ¥ Deflectiony = zz v

yz= 22 ¥

b Active buckling constraints

4 Spansettings

k[ kw []
1 1.00 1.00

L.ts is the reference length. It is by default equal to the reference length around the weak axis (Lz) for both
bottom and top flange. This can be seen in both previous window but as well in the steel settings window:

B Steel setup

Name Standard EN

a
Member check Steel
Fire resistance P Member check EM 1993-1-1
Cold Formed I Fire resistance EN 1993-1-2
Plated structural elements
893-13
Limit slendernass P Cold Formed EN 1993-1-3
Butkling defauits P Plated structural elements EN 1993-1-5
; 5L5 deflection check P Limit slenderness EN50341-1
~- Autodesign

4 Buckling defaults
4 Buckling systems relation

zz IZ

yz IZ

*

| it zz

4 Deflection systems relation
In plane deflection (defz) ¥¥
Out of plane deflection (defy) zz
ky factor Calculate
kz factor Calculate
Point of load application Inshearcenter
4 Bow imperfections
Bow imperfection 0,y No bow imperfection
Bow imperfection 0,z Ne bow imperfection
P SLS deflection check
P Autodesign

Load default non-NA parameters Load default NA parameters Cancel

The reference length can be overruled by another value using LTB restraints. These restraints make it

possible to define separate conditions for bottom and top flange.
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Dutch National Annex

The Dutch National Annex of EN 1993-1-1 describes another formula (NB.NB.2) to calculate M.

C
Mcr=kred'L_'\/E'Iz'G'It

g

SCIA Engineer follows this method when the Dutch National Annex is used.

Example: Cfactors.esa

Open the project and select the Dutch National Annex in the Manager for National annexes and recalculate
the project.

The steel check for beam B1 shows now the lateral torsional buckling check with Mcr calculated according to
the Dutch National Annex.

Lateral Torsional Buckling check
According to EN 1993-1-1 article 6.3.2.1 & 6.3.2.2 and formula (6.54)

LTB parameters

Method for LTB curve General case

Plastic section modulus Woly 3.9490e+06 |mm3
Elastic critical moment Mcr 1143.93 kNm
Relative slenderness Arel,LT _ [0.90

Limit slenderness ArelL1,0 [0.20

LTB curve a

Imperfection aLT 0.21

Reduction factor XLT 0.73

Design buckling resistance  [Mprd 680.68 kNm
Unity check 0.71 -
LTB length It 12.000 m

Fork length Lg 12.000 m

Influence of load position stabilising

Factor a 575.00

Reduction factor kred [1.00

Coefficient C 5.89

Factor S 2177.97 mm

LTB moment factor C1 1.27

LTB moment factor C2 ]0.51

Note: M has been calculated according to the Dutch NEN-EN NA.

The Dutch National Annex also mentions conditions, which need to be fulfilled to follow this method:

Bijlage NB.NB (normatief) Het kritisch elastische kipmoment

NB.NB.1 Toepassingsgebied
(1) Dein deze bijlage gegeven rekenregels voor het kritieke elastische kipmoment zijn van toepassing voor:

— dubbel-symmetrische I-vormige doorsneden waarbij de belasting niet hoger dan 0,1 maal de hoogte van
het profiel boven de bovenfiens aangrijpt;

— buisprofielen waarvoor geldt: h / b > 3, waarbij de belasting niet hoger dan 0,1 maal de hoogte van het
profiel boven de bovenflens aangrijpt.

OPMERKING  Voor buisprofielen waarvoor geldt h / b = 3 mag zijn aangenomen dat ze niet gevoelig Zijn voor
kipinstabiliteit.

(2) Hettoepassingsgebied van de in deze bijlage gegeven rekenregels is beperkt tot staven die zijn begrensd
door gaffels of zijn opgelegd met onderflensinklemmingen die voldoen aan het gestelde in 6.3.2.5 en waarbij
de verhouding van de lengte van de staaf tussen de gaffels L; en de hoogte h van het profiel groter is dan of
gelijk isaan Sofwel: L;/h 2 5.

(3) AlsgeldtL,/h <5, dan moet dezelfde toetsingsprocedure zijn gevolgd als wanneer o > 5 000. Hiervoor geldt
NB.NB.4.2(3).

When one of the conditions is not fulfilled, SCIA will give a warning message (warning W30) and the default
Eurocode method will be executed.
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4.4.2. Lateral torsional buckling check

General case

The flexural buckling check will be executed following EN 1993-1-1 art. 6.3.2.
Mgq

<1
My, ra

Where:
M W, 2
L] = —_—
bRd = XLT Y Yo
W, =W,, for class 1 or 2 cross-sections
* W, =W,, for class 3 cross-sections
* W, = Wy for class 4 cross-sections

The reduction factor XLt will be calculated as follows:
1

Xir = ——F— butx <1,0
D7+ (DET—XET
With: ~ ~

. CDLT = 0,5[1 + O(LTO\LT - 0,2) + )\ET]

- Wy f
BN T
e Mer critical bending moment
e a imperfection factor depending on the buckling curves:

Buckling curve a b c d

Imperfection factor oyt 0,21 0.34 0.49 0,76
< with the following recommended buckling curves for lateral torsional buckling:

Cross-section Limits Buckling curve
Rolled I-sections hb <2 A
hb=>2 b
. hb=2 C
Welded I-sections Wb 2 d
Other cross-sections - d

When slenderness A1 < 0,2 or for % < 0,22 lateral torsional buckling effects may be ignored.

cr
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Lateral torsional buckling for rolled sections or e guivalent welded sections

In the EN 1993-1-1 a distinction is made between lateral torsional buckling for general cases and for rolled
sections or equivalent welded sections. The theory in ECCS - N° 119 clearly specifies that it is valid only for
I-sections or sections with comparable shape.

This distinction can also be chosen in SCIA Engineer through the steel settings and is set for all the
members in the project:

B Steel setup x
[=}- Standard EN Name Standard EN -
[=- Steel
i 4 Steel
i Member check s
;- Fire resistance 4 Member check EN 1993-1-1
~Cold Formed 4 Classification EN 1993-1-1: 5.2.2
-Plated structural elements = =
- Limit slenderness Use Semi-Comp+
-Buckling defaults Plastic analysis Elastic Stresses ¥
rlsdEleth o the Stability classification method Max. class along member ¥
- Autodesign
# 4 Shear EN 1993-1-1: 6.2.6
Uze Ay, A, instead of elastic shear no
4 Torsion EN 19293-1-1: 6.2.7

Limit for torsion [-] 0:05

4 Default sway types EN 1993-1-1:6.3.1
yy Bves
-z no

4 Buckling length ratios ky, kz EN 1993-1-1:6.3.1

Max. k ratio [-] 10.00
Max. slenderness [-] 200.00

an order buckling ratios Bec. te input v
4 Lateral Torsional Buckling EN 1993-1-1:6.3.2
Lateral torsional buckling curves General case ~

General case
Rolled section or equivalent welde

Reference: EN 1993-1-1 article 6.3.2.2,6.3.2.3
Description: Setting for selecting the lateral torsional buckling curves,
| Application: Used in the determination of the reduction factor for lateral torsional buckling.

Load default non-NA parameters Load default NA parameters Cancel

With this option, the reduction factor for lateral torsional buckling is calculated a bit differently:

1

XLt = =
P+ (DLT—B)LLT

but Xt < 1,0 and Xt < %
ALt

With

* Ppr= 0,5[1 + apr (A — Apmo) + BALr]
*  Aro= 0,4 (maximum value)
e B=0,75 (minimum value)

Cross-section Limits Buckling curve
- hb=2 b
Rolled I-sect
olled I-sections Wb > 2 c
L hb<2 c
] Welded I-sections Wb =2 d

When slenderness XLT < XLT’O or for % < XLT’OZ lateral torsional buckling effects may be ignored.
cr
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Following EN 1993-1-1 article 6.3.2.3: XLT’O: 0,4 but this value can be adapted in the national annex of a
country in SCIA Engineer (also the value for 3 can be changed here):

B Steel setup X
=J- Standard EN 4| ITB Curves - General Case EN 1993-1-1: 6.3.2.2 A
=) Steel = f
4 i EN 1993-1-1:6.3.2.2(2)
b dhek Imperfection Alpha,LT 3 3
Fire resistance 4 a
Cold Formed Value [] 0.21
Plated structural elements
4 b
Value [-] 0.34
4 c
Value [-] 0.49
4y d
Value[-] 0.76

4 LTB Curves

Formula Use Table 6.4
¥ LTB Curves - Rolled/Equivalent welded Case EN 1993-1-1: 6.3.2.3(1)
4 Lambda,lT,0

Value [-] 0.40

4 Beta

Value [-] 0.75

4 LTB Curves
Formula Use Table 6.5

4 Modification factor f EN 1993-1-1: 6.3.2.3(2)
Formula Default EN Method
4 Interaction Method EN 1993-1-1: 6.3.3(5)

Values Annex A (alternative method 1) v
P Fire resistance EN 1993-1-2

P Cold Formed EN 1993-1-3 v

Load default NA parameters Cancel

The reduction factor X may be modified as follows:

_ XLT
XLT,mod = T

Parameter ‘' may be defined in the National Annex. The following minimum values are recommended:
f=1-05(1—kJ[1—20Ar—08)] butf<1,0

With ke by default taken from the next table:
Table 6.6: Correction factors k.

Moment distribution ke

([T 1,0

y=1
mﬂmmm:m ;
1,33-0,33
-l<sy<l v

But alternatively, ke can also be calculated from the factor Ca:

ke =1/,/Cy
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Advanced Concept Training — Steel code check

In SCIA Engineer you can choose between the standard method or the calculation of ke in function of Ci (by
default ke will be taken from Table 6.6) via the steel settings:

B Steel setup

[=)- Standard EN
£ steel

i Member check
- Fire resistance
Cold Formed
Plated structural elements
Limit slenderness
Buckling defaults
- 5L5 deflection check i
. Autodesign

4

4

a4

4

4

x
Classification EN 1993-1-1:5.2.2 ~
Use Semi-Comp+ no
Plastic analysis Elastic Stresses v
Stability classification method Max. class along member v
Shear EN 1993-1-1:6.2.6
Use A, A, instead of elastic shear e
Torsion EN 1993-1-1: 6.2.7
Limit for torsion [-] 0.05
Default sway types EN 1993-1-1:6.3.1
vy bl ves
i no
Buckling length ratios ky, kz EN 1993-1-1:6.3.1
Max. kratio[] 10.00
Max, slenderness [-] 200.00
2™ order bu ckling ratios Ace. toinput v
Lateral Torsional Buckling EN 1993-1-1:6.3.2
Lateral torsional buckling curves General case v
Method for C1 €2 €3 ECCS 119/Galea v
Method for k EN 1993-1-1 table 6.6 -

EN 1993-1-1 table 6.6
Determined from C1

Reference: EN 1993-1-1 article £.3.2.3 (2)

Description: Setting for selecting the calculation method of the ke correction factor.
| Application: Used in the determination of the modified reduction factor for lateral torsional buckling. The
| ke factor can either be determined from Table 6.6 or derived from C1 which gives a more exact value.

Load default non-NA parameters Load default NA parameters

| caneel

We will demonstrate this LTB check in SCIA Engineer with following example.

Example: Industrial hall.esa

Consider beam B114.

The default method for the calculation of the C-factors has been used. This is also indicated in the preview of

the check results:

First the Lateral Torsional Buckling Check will be shown:

Lateral Torsional Buckling check
According to EN 1993-1-1 article 6.3.2.1 & 6.3.2.2 and formula (6.54)

LTB parameters

Method for LTB curve General case

Plastic section modulus Woly 3.6380e+05  [mm3
Elastic_critical moment Mcr 56.14 kNm
Relative slenderness ArelLT 1.23

Relative slenderness Arel,T 0.07

Relative slenderness ArelexTrA | 1.31

Limit slenderness AreliT,0  [0.20

LTB curve a

Imperfection aLt 0.21

Reduction factor XLT 0.47

Design buckling resistance  [Mb,rd 39.92 kNm
Unity check 0.45 -

Note: ArelexTra is determined according to "Design rule for lateral torsional buckling

of channel sections, 2007".

And afterwards the parameters for the calculation of M¢r will be shown.

LTB length v [6.000 m
Influence of load position no influence
Correction factor k |1.00

Correction factor k. |1.00

LTB moment factor C; [1.13

LTB moment factor C; |0.45

LTB moment factor C; [0.53

Shear centre distance d: [0.00 mm
Distance of load application |zg [0.00 mm
Mono-symmetry constant By |0.00 mm
Mono-symmetry constant z |0.00 mm
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= xExl|, | : . P xGxl, y
Mo =€« i E '1[\9(1) e MOk G - (Gxz - Caxz)| =113

Iy

? x 210000.0[MPa] x 2.4800 - 10°[mm®]

X

6.000[m)?
100\’ 2.5514-10"(mm’]  6.000[m]’ x 80769.2[MPa) x 1.9700 - 10°[mm?] _ . ) o
) {\ (m) 2.4800 - 10°[mm’] 77 % 210000.0[MPa] x 2.4800 - 10°[mm*] (0.45  0.00[mm] ~ 0.53 x 0.00[mm])" — (0.45  0.00(mm] - 0.53 x 0.00[mm})
56.14[kNm|
Woy <, [3.6380 - 10°[mm’] x 235.0[MPa]
Arel LT = 4/ =/ =1.23
Viwme Y 56.14[kNm]
AT = 0.43 — 0.29 x At = 0.43 — 0.29 x 1.23 = 0.07
Al EXTRA = Arel LT + At T = 1.23 4+ 0.07 = 1.31
. 1 . 1 .
XLT = min - ,1 | = min | ———————, l) = min (0.47,1) = 0.47 (EC3-1-1: 6.56)
T+ 1/t — A2 1.47 + Vv1.472 - 1.312
PLT T\ PLT — AleexTRA
fy 235.0[MP.
Mp.rd = \LT X Wpiy X — = 0.47 x 3.6380 - 10"[mm‘] X #a] = 39.92[kNm) (EC3-1-1: 6.55)
M1 d
My.e4| .03k
Unity check = —*E41 _ [1B.03pMm]] _ g o5 < 1.00 (EC3-1-1: 6.54)

Mbre  39.92[kNm]
Note: C parameters are determined according to ECCS 119 2006 / Galea 2002.

Note that at the end of the output for this check, the calculation method for the C-parameters will be
indicated.

Channel sections

When a channel section is loaded, additional torsion appears due to the eccentricity of the shear centre

relative to the centroid of the cross-section. For that reason, the value of Mcr has to be adapted.

To account for this additional torsion effect, the following procedure can be used where Aextra is calculated.

Maodified design rule for LTB of Channel sections

In case thiz sefting is activated within the Steel Setup, the reduction factor for Lateral-Torsional
Buckling of Channel sections is determined according to Ref[22].

More specifically the calculation is done as follows:

1
(I:r_,_? T \'Iq'tr = "Ii:xfm

Reduchion factor: ¥, =

Where: "i-"'” = D5h + .:x”{,%m” - U'E}+ "E-JTH }— curva A foe chanine! saciions, therelore oyy= G 2

Ay = Ar + 4

Ay =
M.,
]%::.n A f D5s2, <080

A =043-0294,; ¢ 08024, <15
A =0 if Ay >15

This Modified design rule is applied only in case the following conditions are met:

- The section concems a Channel section (Form Code 5)
- The General Caseiz uged for LTB (Mot the Rolled and Equivalent Walded Case)
- 15 <= Litb'h <= 40 (with Llth the LTE length and h the cross-section height)

BV —2021/06/21
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Advanced Concept Training — Steel code check

443, LTB restraints

= T
4
¢ 4
r __—-{_‘ ———————

Single angle

r Purlin

4

i+
\
=

Rafter ——

In SCIA Engineer lateral torsional buckling restraints can be inputted. Those restraints will change the lateral
torsional buckling length, used for the calculation of Mer:
¢ m2El, (L)ZI_W (kpr * L)2GI,
T M P |/ I, m2EL

+ (szg - C3Zj)2 - [szg - C3Z]-]

Where:
e kur*L: lateral torsional buckling length of the beam between points which have lateral
restraint (= ILte)

This length will be taken as the distance between two LTB restraints.

Fixed LTB restraints are defined on the top flange or on the bottom flange. The LTB lengths for the
compressed flange are taken as distances between these restraints. The LTB moments factors are
calculated between these restraints.

The restraints can be inputted via Input panel > Steel > Steel LTB restraints  or via Process toolbar >
Steel > Steel LTB restraints

Note: only the restraints on the compressed side are taken into account.
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Example: LTB_Restraints.esa

In this example the same beam has been inputted three times. Since in this example an IPE450 is used, the
lateral torsional buckling curves for Rolled section or equivalent welded  are used in the steel settings:

B Steel setup e
= Standard EN Mame Standard EN ~
- Steel
aér 4
- Member check Sk
- Fire resistance 4 Member check EN 1993-1-1
Cold Formed 4 Classification EM 1993-1-1:5.2.2
- Plated structural elements = =
- Limit slenderness Use Semi-Comp+
- Buckling defaults Plastic analysis Elastic Stresses v
- SLS deflection check Stability classification method Max. class along member ¥
- Autodesign
4 Shear EN 1993-1-1: 6.2.6
Use Ay, A, instead of elastic shear no
4 Torsion EN 1993-1-1:6.2.7
Limit for torsion [-] 0.05
4 Default sway types EN 1993-1-1:6.3.1
yy @ yes
T na
4 Buckling length ratios ky, kz EN 1993-1-1:6.3.1
Max. k ratio [-] 10.00
Max. slenderness [-] 200.00
an order buckling ratios Ace. toinput v
4 Lateral Torsional Buckling EN 1993-1-1:6.3.2
I Lateral torsional buckling curves Rolled section or equivalent we v I
Method for €1 C2 €3 ECCS 119/Galea v
Method for k_, EN 1993-1-1 table 6.6 Pl
| Reference: EN 1993-1-1 article 6.3.2.2, 6.3.2.3
| Description: Setting for selecting the lateral torsional buckling curves,
‘ Application: Used in the determination of the reduction factor for lateral torsional buckling.
Load default non-NA parameters Load default MA parameters Cancel

Note: the default setting for LTB curves is General case .

The results for LC1 are:

1.14 —

¢ N g

§L‘ﬁf

e

N =9
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Advanced Concept Training — Steel code check

Bl B2
Lateral Torsional Buckling check Lateral Torsional Buckling check
According to EN 1993-1-1 article 6.3.2.1 & 6.3.2.3 and formula (6.54) According to EN 1993-1-1 article 6.3.2.1 & 6.3.2.3 and formula (6.54)
Method for LTB curve Alternative case Method for LTB curve Alternative case
Plastic section modulus Woly 1.7020e-03 m3 Plastic section modulus Woly 1.7020e-03 m3
Elastic critical moment Mcr 280.68 kNm Elastic critical moment Mcr 972.64 kNm
Relative slenderness Arelit 1.19 Relative slenderness Arel,LT 0.64
Limit slenderness Arelit,o | 0.40 Limit_slenderness AreliT,0 |0.40
LTB curve = LTB curve €
Imperfection ar 0.49 Imperfection ar 0.49
LTB factor B 0.75 LTB factor B 0.75
Reduction factor XLt 0.53 Reduction factor XLT 0.86
Correction factor ke 0.94 Correction factor ke 0.91
Correction factor f 0.98 Correction factor f 0.96
Modified reduction factor Xit,mod | 0.54 Modified reduction factor XiT,moed | 0.90
Design buckling resistance | Mp,rd 215.74 kNm Design buckling resistance | Mp,rd 359.89 kNm
Unity check 1.14 - Unity check 0.68 -
LTB length lir [7.000 m LTB length Iir |3.500 m
Influence of load position no influence Influence of load position no influence
Correction factor k 1.00 Correction factor k 1.00
Correction factor kw [1.00 Correction factor kw [1.00
LTB moment factor Ci |1.43 LTB moment factor C: |1.33
LTB moment factor C, |0.45 LTB moment factor C, |0.12
LTB moment factor C; [0.53 LTB moment factor Cs; [1.00
Shear centre distance d; [0 mm Shear centre distance d; |0 mm
Distance of load application |zq |0 mm Distance of load application [z, |0 mm
Mono-symmetry constant By |O mm Mono-symmetry constant By |0 mm
Mono-symmetry constant zi |0 mm Mono-symmetry constant zi |0 mm

And for beam B3, 6 LTB restraints are inputted, so no LTB calculation will be executed:

If At < Apro OF for % < Ap10? lateral torsional buckling effects may be ignored. With: XLT,O: 0,4
cr

So for beam B3, the following LTB check is displayed:

Lateral Torsional Buckling check
According to EN 1993-1-1 article 6.3.2.1 & 6.3.2.3 and formula (6.54)

LTB parameters

Method for LTB curve Alternative case

Plastic section modulus |Wpiy 1.7020e-03 m3
Elastic critical moment Mcr 4017.35 kNm
Relative slenderness ArelLT 0.32

Limit slenderness AreliT,0 [0.40

Note: The slenderness or bending moment is such that Lateral Torsional Buckling effects
may be ignored according to EN 1993-1-1 article 6.3.2.2(4).

LTB length I [1.400 m
Influence of load position no influence
Correction factor k 1.00

Correction factor kw |1.00

LTB moment factor C; [1.01

LTB moment factor C, |0.02

LTB moment factor C; |[1.00

Shear centre distance d; [0 mm
Distance of load application |z, |0 mm
Mono-symmetry constant By |0 mm
Mono-symmetry constant zi |0 mm
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When looking at load case LC2, the top side of the beam will be under tension, so SCIA Engineer will not
take into account the effects of the LTB Restraints:

1L
T B

b LTB?
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Advanced Concept Training — Steel code check

44.4. Sheeting

When diaphragms (steel sheeting) are used, the torsional constant I: is adapted for symmetric or asymmetric
| sections, channel sections, Z sections, cold formed U, C and Z sections.

A sheeting can be inputted via Input panel > Steel > Steel sheeting

sheeting :

or Process toolbar > Steel > Steel

B | Sheeting

O YmVanV,

X
Mame D1
Sheeting LIE Sheetl v .
Positionz +Z -
I 1amnd 2 spans W
Sheeting position Positive v
Bolt position Top flange v
Eolt pitch br ¥
Lf - frame distance [m] 3.000
Ld - sheeting length [m] 1-200
4 Geometry
Coord. definition Rela v
Position x1 ©-000
Position x2 1.000
Origin From start »

i Cancel |gu

The settings for the diaphragm are:

e Sheeting LIB

* Position z

. Kk

*  Sheeting position

< Bolt position

e Bolt pitch

« Frame distance
* Sheeting length

76

with this option you can choose between sheeting types of the library of
SCIA Engineer or input his own sheeting.

position of the sheeting according to the LCS of the beam

value of coefficient k depends on the number of spans of the sheeting:

k =2 for 1 or 2 spans

k = 4 for 3 or more spans

the position of the sheeting may be either positive or negative

Positive means that the sheeting is assembled in a way so that the width is
greater at the top side.

Negative means that the sheeting is assembled in a way so that the width is
greater at the bottom side.

bolts may be located either at the top or bottom side of the sheeting

bolts may be either:

in every rib (i.e. ‘br’)

in each second rib (i.e. ‘2 br’)

distance of frames

length of the sheeting (shear field)
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The sheeting will only have an influence on the torsional constant It and will be taken into account in the

calculation for Mer for the lateral torsional buckling check.

The torsional constant I: is adapted with the stiffness of the sheeting.

The value for It equals the previous value for I: (thus I: of the beam) plus a supplementary stiffness calculated
with the values of the sheeting:

2

liig = It + vorh Cy G

rotational stiffness of the connection between the sheeting and the beam

Where:
1 1 1 1
* vorh Cy = Comk  CpAk + Cop k
* Comi = k#
b 2
* Coax=Cio[2]|  ifby <125
© Coax = 1,25 Cyop [%] if 125 < b, < 200
o Capy ~ 2Els
oPk ~ T
S3
o I = 5
With:
o | LTB length
e G shear modulus
« vorhCe actual rotational stiffness of the sheeting
e Camk rotational stiffness of the sheeting
e Ceak
ek numerical coefficient
= 2 for single or two spans of the sheeting
= 4 for 3 or more spans of the sheeting
e Eles bending stiffness of per unit width of the sheeting
e S spacing of the beam
e ba width of the beam flange (in mm)
e Cioo rotation coefficient — see table below
e h beam height
ot thickness beam flange
e S thickness beam web

BV —2021/06/21

'°°s'.',';';','".§ o 5"";“’)'“";"" Pitch of faseners | Washer |y
Positive ] Negative | Trough l Crest e~by € =2y (mm) | (kNmv/m] | [mm)
For gravity loading:

x x x 2 52 4«0

x x x 2 3l 40

x x x K, 10,0 &0

x x x K, 5.2 0

x x x 2 3.1 120

x x X 2 20 120
For uplift loading

x x x 16 26 40

x x x 16 1.7 40
Key

by is  the corrugation width [185 mm maximum),
by is the width of the sheeting flange through which it is fastened 1o the purlin.
K, indicates a steel saddle ‘vasher as shown below with t = 0,75 mm Sheet fastened

through the trough

D'—‘<

The values in this table are valid for: through the crest
sheet fastener screws f diameter ¢ =« 63mm, < T
steel washers of thick sess f, = 10mm;
S W W W

h i ek

ng of | core r =2 066mm
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Example: Diaphragm.esa

Consider member B1:
e LTBlength=7m
e (C1=1,13,C>=0,45,C3=0,53
L Mer = 281 KNm

Consider member B2
¢ lia = 1840207 mm4
e LTBlength=7m
e (C1=1,13,C>=0,45,C3=0,53
. Mecr = 405 KNm

The results for the calculation of the sheeting are shown in the preview of the steel check just before the
section check:

Sheeting
According to EN 1993-1-1 article BB.2.1 and formula (BB.2)

Sheeting name D1
Moment of inertia per length |1 0.00 m4/m
Position z +2
Sheeting position negative
Bolt position top flange
Bolt pitch br
Frame distance Lf |3.000 m
Sheeting length Ls [3.000 m
Sheeting factor Ki- [0.167 m/kN
Sheeting factor K2- ]15.700 m2/kN
Numerical _coefficient k 4.00
Stiffness
Actual stiffness S 5555.21 kN
Required stiffness Serf 42650.44 kN
S < Sed inadequately braced
Sheeting on side compression side
Rotational stiffness (Sheeting) Camk 2637.60 kNm/m
Rotational stiffness (Beam Cap,k 100.15 kNm/m
distortion)
Rotational stiffness (Connection) | Csak 23.75 kNm/m
Rotational coefficient Cio0 10.00 kNm/m
Rotational stiffness vorhCs |19.06 kNm/m
LTB length It 7.000 m
Cross-section _torsional constant |1t 6.6900e-07 m#
Additional torsional constant Tt add 1.1715e-06 m*
Adapted torsional constant Ttid 1.8405e-06 m*
g Lix 10000 3.000[m] x 10000 - 5555.21(kN]

Ki + Ko 0.167[m/kN] + 15.700[m*/kN]

Lq ’ ! ' 3.000(m)

(M..Gx.‘ﬁ_mxo_g.jxhe) 70

[+ I
8= LT = LT
210000.0[MPa] x 7.9100 - 10-7[m®] x 2 2« 210000.0[MPa] x 1.6760 - 10~5[m*] x 2 2)
( 000 + 80760.2[MPa] x 6.6900 - 10-7[m*] + 000’ % 0.25 x 450[mm]? ) x 70
a 450[mm]?
— 42650.44[kN]
kx E x| 4.00 x 210000.0[MPa] x 0.00[m*/m] ,
Comy = - = 2637.60[kNm/
o L 3.000(m) [kNm/m]
3 ¢ 3
3 :;w «E X 91[;""‘] x 210000.0[MPa]
T = = 100.15[kNm/
Copx h—t¢ 450[mm| — 15[mm) 00.15[kNm /m]
b 1
Cons = Cioo x 5 x 1.25 = 10.00(kNm /m] % X 1.25 = 23.75(kNm /m]
Cio0 = 10.00[kNm/m]
hCs = ! = ! = 19.06[kNm/
vorhCp = — 1 = 1 1 I = 19.06[kNm /m]

Corx | Conx  Comx  100.15(kNm/m] =~ 23.75(kNm/m] ' 2637.60[kNm/m]
vorhCo x 177 19.06(kNm/m] x 7.000[m]?
ladd = < = o
s G 80769.2[MPa]

=1.1715-10"%[m?)

liia = b+ leaga = 6.6900 - 1077 [m?] + 1.1715 - 10°[m?] = 1.8405 - 10~°[m")
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The results for the lateral torsional buckling check are:

Lateral Torsional Buckiing check
According to EN 1993-1-1 article 6.3.2.1 & 6.3.2.2 and formula (6.54)

LTB parameters

Method for LTB curve General case
Plastic_section modulus Woly 1.7020e-03  [m?
Elastic critical moment M., 404.94 kNm
Relative slenderness Areltt 0.99

Limit slenderness Arelito | 0.20

LTB curve b

Imperfection awr 0.34

Reduction factor Xt 0.60

Design buckling resistance  |Mbrd 240.36 kNm
Unity check 1.02 -
LTB length I.r |7.000 m
Influence of load position no influence
Correction factor Kk 1.00

Correction factor kv |1.00

LTB moment factor C |1.13

LTB moment factor C; |0.45

LTB moment factor C: [0.53

Shear centre distance d: |0 mm
Distance of load application |z, [0 mm
Mono-symmetry constant B, (O mm
Mono-symmetry constant z |0 mm

2 xEx| (kN2 W BrxGx il s
M(,C,xlf—TK’x[\:‘(k—) xl—ﬁL‘_T?X—E:,I-‘-(cMzZ CGxz) - (Caxzg—Caxz)| =113

. 72 % 210000.0[MPa] x 1.6760 - 10-%[m°*]

7.000[m]?
| [f100\? 7.9100-10-7[m] _ 7.000[m]? x 80769.2[MPa] x 1.8405 - 10~*[m‘] )
[\: (m) X 16760 105[m7] T 2 x 210000.0[MPa] x 1.6760 - 10 57| T (0:4% X Olmm] — 0.53 x O[mm})” — (0.45 x O[mm]  0.53 x Ofmm])
= 404.94[kNm]
[Woiy % f,  [1.7020 - 10~*[m?] x 235.0[MPa]
Arel T = [ =22 =/ =0.99
TEN T M \ 404.94[kNm]
X min 1 1 min ( L 1) min (0.60,1) = 0.60 (EC3-1-1: 6.56)
LT = 1 =. = 1 ?. = o . - 8 ~1-12 O..
our + oo — Mgz 1.13 + V1.137 - 0.99
f 4 O[MP.
Mb,rd = XLT X Wpiy X —— = 0.60 x 1.7020 - 10*[m’] x W = 240.36(kNm| (EC3-1-1: 6.55)
M1 o

. _ [Myedl  [245.00[kNm]|
Unity check = Mora ~ 240.36(kNm] ~ 1.02 > 1.00 (EC3-1-1: 6.549)

Note: C parameters are determined according to ECCS 119 2006 / Galea 2002.
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4.4.5. Lateral torsional buckling using LTBII

This option has been inputted in SCIA Engineer as a separate module and it is only included in the ultimate
edition. The necessary module for this option is sensd.07 .

For a detailed lateral torsional buckling analysis, a link was made to the Friedrich + Lochner LTBII calculation
program.

LTBIl is the abbreviation of ‘Lateral Torsional Buckling with 2" order calculation’.

The Frilo LTBII solver can be used in 2 separate ways:
1. calculation of Mcr through eigenvalue solution;
2. 2" QOrder calculation including torsional and warping effects.

For both methods, the member under consideration is sent to the Frilo LTBII solver and the respective
results are sent back to SCIA Engineer.

The single element is taken out of the structure and considered as a single beam, with:
e appropriate end conditions for torsion and warping;
« end and begin forces;
e loadings;
» intermediate restraints (diaphragms, LTB restraints).

To use this option in SCIA Engineer the functionality 7DoF 2nd order analysis for LTB should be activated
in the project settings (Menu bar > File > Project settings ). In previous versions (before SCIA Engineer
18.0) this option’s old setting name is ‘LTB 2" order’.

Afterward with the option Input panel > Steel > LTBII steel member data  or Process toolbar > Steel >
LTBII steel member data you can input LTB-data on a beam.

Example: LTBIl.esa

In this example the same beam will be calculated with LTBII data on it and without in three configurations:
o

I Kip2

LTEI member data BS
£ 1

b

LTEI member gata BS

AN

When looking at the check for LC1 there is not a big difference between the beams with or without the LTBII
data:

# A LTBI member doto B4

A A VAN JAN
: Y i
A 7AY A JAY
|
N
‘] r
=N \/
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In Frilo the rigidity of the sheeting against rotation and translation is taken into account, which results in a

higher stiffness of the sheeting and thus a better unity check.

When looking at the results for load case LC2, the direction of the inputted line load is changed. The upper

side of the beams is under tension for this load case. SCIA Engineer does not take into account LTB
restraints or a sheeting on the tension side. But Frilo can take this also into account. There will be an

augmentation of the rigidity:

v

A JAY
|
&
v v
A A
|
N
ﬁ-&—" A4
AK—V N A

Also, in the detailed output this calculation is indicated:

Lateral Torsional Buckiing check
According to EN 1993-1-1 article 6.3.2.1 & 6.3.2.2 and formula (6.54)

LTB parameters

Method for LTB curve General case
Plastic_section_modulus Woly 1.6600e-04 m3
Elastic _critical moment Mcr 74.26 kNm
Relative slenderness Arel LT 0.78

Limit slenderness Arelito [0.20

LTB curve a

Imperfection awr 0.21

Reduction factor XLt 0.80

Design buckling resistance  [Mbrd 36.73 kNm
Unity check 0.39 S

|Note: The elastic critical moment M- is calculated using the FriLo BTI Solver. |

Mcr parameters
LTB length [lir [7.200 [m

£ 7 LT8i member doto B4 ]

JAN
I~
=2
E
¥ ¥V ALT81 member doto B8
JAY
|
JAY
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Advanced Concept Training — Steel code check

4.5.

Compression and bending check

The compression and bending check for a member will be executed following EN 1993-1-1 art. 6.3.3.

Unless second order analysis is carried out, members which are subjected to combined bending and axial
compression should satisfy formulas (6.61) and (6.62):

NEgq My kg + AMy kg Mz Eq + AM kg
XyNr % X My rk ye M, rk

YM1 LT ymq Ym1

Ngq My Ed + AMygq M, gq + AM, kg <
X Nex % My ri “ M, ri -

Ym1 LT ymy Ym1

Ned, Myed and Mzeq are the design values of the compression force and the MAXIMUM
moments about the y-y and z-z axis along the member respectively
Note: the word ‘MAXIMUM’ was forgotten in the translation of the Belgian National Annex.
Xy and x: are the reduction factors due to flexural buckling
x.7 is the reduction factor due to lateral torsional buckling

Class 1 2 3 4
A, A A A A
Wv W‘D].‘l-’ Wpl.v we]_v weﬁ‘_r
W, Wl Woe Wl Wesr,
AM., ra 0 0 0 env NEa
AM, g4 0 0 0 exz NEg

The interaction factors kyy, kyz, kzy and k;; have been derived from EN 1993-1-1 Annex A (alternative
method 1) or from Annex B (alternative method 2).

The choice between Interaction Method 1 or 2 can be made in the National Annex parameters:

82

B Steel setup

I=)- Standard EN

- Fire resistance
i Cold Formed

Plated structural elements

4 Steel

4 Member check
Bow Imperfections
Member Imperfection
Partial Safety Factors

LTB Curves - General Case

vl v v v ow

LTB Curves - Rolled/Equivalent welded Case

Name

Standard EN

EN 1993-1-1

EN 1993-1-1: 5.3.2(3) b}
EN 1993-1-1: 5.3.4(3)
EN 1993-1-1: 6.1{1)

EN 1993-1-1: 6.3.2.2

EN 1993-1-1: 6.3.2.3{1}

X

Interaction Method

Values

EN 1993-1-1: 6.3.3{5)

Annex A {alternative method 1)

A

Annex A (altermative method 1)

Annex B lalternative method 2)

P Plated structural elements

Load default MA parameters

EN 1993-1-5

Cancel
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Example: Industrial Hall.esa

Consider column B28 (for combination CO1-ULS).

In SCIA Engineer first all calculated formulas, in this example following EN 1993 Annex 1, are given and

afterwards the check is given as two times a sum of three values as in formulas (6.61) and (6.62) of the EN

1993-1-1.

Bending and axial compression check

According to EN 1993-1-1 article 6.3.3 and formula (6.61),(6.62)

Bending and axial compression check parameters

Interaction method alternative_method 1
Cross-section _area A 1.8800e+04 mm?
Plastic section modulus Wely |[5.1100e+06 mm3
Plastic section modulus Wpiz [ 6.3100e+05 mm?
Design compression force Ned 160.06 kN
Design bending moment Myes |-702.46 kNm
(maximum)

Design bending moment Mzed  [-0.37 kNm
(maximum)

Characteristic compression Nrk 4418.00 kN
resistance

Characteristic moment resistance | Myre | 1200.85 kNm
Characteristic_ moment resistance |M:qx | 148.28 kNm
Reduction factor Xy 0.74

Reduction factor X 0.48

Reduction factor X 0.71

Interaction factor Kyy 0.99

Interaction factor Kyz 1.30

Interaction factor kzy 0.53

Interaction factor Kez 0.81

Maximum moment My.ed is derived from beam B28 position 6.900 m.
Maximum moment M:es is derived from beam B28 position 6.900 m.

Interaction method 1 parameters

Critical Euler load Nery 5635.44 kN
Critical Euler load Nerz 3067.01 kN
Elastic_critical load Ner,r 4845.28 kN
Plastic_section modulus Woply 5.1100e+06 mm?
Elastic_section modulus Wely 4.4110e+06 mm?
Plastic_section modulus Woplz 6.3100e+05 mm?
Elastic_section modulus Welz 3.9900e+05 mm?
Second moment of area Iy 1.6610e+09 mm*
Second moment of area I 5.2890e+07 mm*
Torsional constant It 1.6200e+06 mm*
Method for equivalent moment Table A.2 Line 1 (Linear)

factor Cmy.0

Ratio of end moments Yy 0.00

Equivalent_moment factor [ 0.79

Method for equivalent moment Table A.2 Line 1 (Linear)

factor Crmz0

Ratio of end moments W: 0.00

Equivalent moment factor Cmz0 0.78

Factor Py 0.99

Factor Yz 0.97

Factor & 18.71

Factor ar 1.00

Critical moment for uniform Mero 1008.48 kNm
bending

Relative slenderness Arelo 1.09

Limit_relative slenderness Areloim  10.26

Equivalent moment factor Cry 0.96

Equivalent moment factor Conz 0.78

Equivalent moment factor ConlT 1.00

Factor bir 0.00

Factor ar 1.44

Factor dur 0.00

Factor ewr 0.73

Factor Wy 1.16

Factor Wz 1.50

Factor Npl 0.04

Maximum relative slenderness  [Arelmax  |1.20

Factor Cyy 0.99

Factor Gy 0.43

Factor Cy 0.96

Factor Cz 0.99

Unity check (6.61) = 0.05 + 0.81 + 0.00 = 0.86 -
Unity check (6.62) = 0.08 + 0.43 + 0.00 = 0.51 -

When turning on the formulas in the detailed output, the calculation of each parameter will be shown.
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4.6. Shear buckling check — EN 1993-1-5

46.1. General
The shear buckling check will check if the web of the cross-section can be subject to local buckling.

This check is not included in EN 1993-1-1, but in EN 1993-1-5: Design of steel structures — Part 1-5: Plated
structural elements.

First, there will be checked if the value for the slenderness is smaller than a certain value, because for webs
with a small slenderness, this check should not be executed.

Plates with hy/t greater than 72 €/n for an unstiffened web should be checked for resistance to shear.

With:
€= 235
o]
e n will be defined in the National Annex. The value n = 1,20 is recommended for steel grades
up to and including S460. For higher steel grades n = 1,00 is recommended.

b
|
-
hw
1
.

If the slenderness is higher than the minimum one, the shear buckling check is executed following EN 1993-
1-5, formula (5.10) (this is a check on the shear force) and formula (7.1) (which is the check on the
interaction between shear force, bending moment and axial force). Both formulas are checked in SCIA

Engineer.

84 BV —2021/06/21



Example: Shear buckling.esa

Consider Beam B1. This is an IPE160 profile: hw = 160 — 2 x 7,40 = 145,2 mm. And t =5 mm
* hw/t=29,04

This should be checked with the value: 72¢/n =72 x 1,00/ 1,2 = 60
* hw/t<72¢/n > the shear buckling check does not have to be executed.

This is also indicated in SCIA Engineer:

Shear Buckling check
According to EN 1993-1-5 article 5 & 7.1 and formula (5.10) & (7.1)

Shear Buckling paramete

Buckling field length a 6.000 m
Web unstiffened

Web height hw |145 mm
Web thickness t 5 mm
Material coefficient € 1.00

Shear correction factor |n 1.20

Shear Buckling verification

Web slenderness hw/t |29.04
Web slenderness limit 60.00

Note: The web slenderness is such that Shear Buckling effects may be ignored
according to EN 1993-1-5 article 5.1(2).

Consider Beam B2. This is an | profile: hw = 600 — 2 x 9 = 582 mm. And t = 6 mm
b hw /t=97

This should be checked with the value: 72¢/n =72 x 1,00/ 1,2 =60
o hw/t>72¢/n
e The shear buckling check has to be executed.

Shear Buckling check
According to EN 1993-1-5 article 5 & 7.1 and formula (5.10) & (7.1)

ear B g parameters
Buckling field length a 6.000 m
Web unstiffened
End post non-rigid
Web height hw [582 mm
Web thickness t 6 mm
Yield strength fyw [235.0 MPa
Flange width bf [276 mm
Flange thickness tr |9 mm
Yield strength fyf  [235.0 MPa
Material coefficient € 1.00
Shear correction factor |n 1.20

Shear Buckling verification

Web slenderness hw/t 97.00

Web slenderness limit 60.00

Plate slenderness Aw 1.12
Reduction factor Xw 0.74
Contribution of the web Vbw,Rd 350.27 |kN
Capacity of the flange Mf,rd 344.99 |kNm
Flange factor C 1.606 m
Contribution of the flange | VbfRrd 3.27 kN
Maximum resistance Vb rd,imt_|568.54 | kN
Resistance Vb,Rd 353.53 |kN
Plastic resistance Mpl,Rd 502.92 |kNm
Shear ratio n3,bar 0.04

Unity check (5.10) = 0.04 -
Note: The interaction between Bending and Shear Buckling does not need to be verified
because the shear ratio does not exceed 0.5.
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46.2. Stiffeners

In EN 1993-1-5, figure 5.1 the definitions of stiffeners on a member are given:
e

f i T a _1—1

a) No end post b) Rigid end post ¢) Non-rigid end post

Those stiffeners will influence the total length for shear buckling. In SCIA Engineer those stiffeners can be
inputted on a beam and will ONLY have an influence on the shear buckling check in the steel service.

Those stiffeners can be inputted via Input panel > Steel > Steel stiffeners  or Process toolbar > Steel >
Steel stiffeners .

B Stiffener *

Name Sti

—sD Material 5235 v ..
G Thickness[mm] 20 v

ll =D Decrease [mm] 1

Rigid end posts
D g P!
4 Geometry

Coord. definition Rela v

@ Position x 0-100

MNumber of stiffeners (n) 4

LJ LJ Regularty 2

§ Delta x 0.267
@ (n -1) x AX First stiffener L] yes
X Last stiffener [ yes

OK Cancel

The stiffeners define the field dimensions which are only relevant for the shear buckling check. When no
stiffeners are defined, the value for buckling field length ‘a’ is taken equal to the member length.

If you want to take stiffeners into account in the analytical model, you need to model them outside the steel
service. You could create a new cross-section, in which the stiffener is considered, and apply that cross-
section to the 1D member, each time over a length equal to the thickness of the stiffener. When calculating
the model, the stiffener will be considered in the results of the deformations, stresses, ...
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Example: Stiffeners.esa

In this example 2 identical beams are inputted. B1 without stiffeners and B2 with stiffeners:

Let us now compare the shear buckling check with and without stiffeners:

Shear Buckling check

Shear Buckling parameters

B1 - without stiffeners

According to EN 1993-1-5 article 5 & 7.1 and formula (5.10) & (7.1)

Buckling field length a 6.000 m
Web unstiffened

End post non-rigid

Web height hy, |782.00 mm
Web thickness t 5.00 mm
Yield strength fyw | 235.0 MPa
Flange width bs |275.00 mm
Flange thickness tr  [9.00 mm
Yield strength fyy  |235.0 MPa
Material coefficient € 1.00

Shear correction factor |n 1.20

Shear Buckling verification

Web slenderness hw/t 156.40

Web slenderness limit 60.00

Plate slenderness Aw 1.81
Reduction factor Xw 0.46
Contribution of the web Vbw,Rd 243.24 | kN
Capacity of the flange Mt rd 460.07 | kNm
Flange factor C 1.570 m
Contribution of the flange | Vbfrd 1.92 kN
Maximum resistance Vb,rdlimt _|636.60 | kN
Resistance Vb,rd 245.16 | kN
Plastic resistance Mpl,rd 693.01 | kNm
Shear ratio N3,bar 1.23

Moment resistance MR eff 580.90 |kNm
Moment ratio N1,bar 0.43

Moment ratio limit N1,bar limit | 0.66

Unity check (5.10) = 1.22 -

B2 - with stiffeners

Shear Buckling check

According to EN 1993-1-5 article 5 & 7.1 and formula (5.10) & (7.1)

Shear Buckling parameters

Buckling field length a 1.600 m
Web stiffened

End post non-rigid

Web height hy [782.00 mm
Web thickness t 5.00 mm
Yield strength fuw [235.0 MPa
Flange width bs [275.00 mm
Flange thickness te 9.00 mm
Yield strength fir  [235.0 MPa
Material coefficient € 1.00

Shear correction factor [n 1.20

Shear Buckling verification

Shear buckling coefficient | k+ 6.30

Web slenderness hw/t 156.40

Web slenderness limit 64.82

Plate slenderness Aw 1.67
Reduction factor Xw 0.50
Contribution of the web Vbw,Rd 264.19 | kN
Capacity of the flange Mt rd 460.07 | kNm
Flange factor (3 0.419 m
Contribution of the flange | Vbfrd 1138 |kN
Maximum resistance VbrdJimit _|636.60 | kN
Resistance Vb,rd 275.57 |kN
Plastic resistance Mpi,rd 693.01 |[kNm
Shear ratio N3,bar 0.91

Moment resistance MR eff 580.90 |kNm
Moment ratio N1 bar 0.20

Moment ratio limit N1barlimt | 0.66

Unity check (5.10) = 0.87 -
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Q% This check will be executed following EC-EN 1993-1-1 art.6.4.1 and 6.4.3.
The following cross-section pairs are supported as battened compression
pim member:
. Q) 21
2) 2Uo
3) 2Uc
i ECN @

You can add the links (battens) via Input panel > Steel > Links or Process toolbar > Steel > Links

B | Non compact beam *

Mame MNoncompact beam

/ 4 Mon compact beam
t Q‘-‘\V Division 3

Distance from begin x [m] 0.100

Distance from end x ' [m] @.100

Width of link w [m] 0-010
Thickness t [mm] 10
x' On begin

On end a

OK || Cancel

The following additional checks are performed when performing the ULS check:
» buckling resistance check around weak axis of single chord with Nt sd;
» section check of single chord, using internal forces;
» section check of single batten, using the internal forces.

‘ ‘ ho

i
-t
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Example: EC_EN_Battened_Compression_Members_l.esa
Consider member B1.
On this beam, only a compression force of 500 kN is applied.

Properties of the batten:

Division 4
Distance from beginx [m] 0,200
Distance from end x” [m] 0,200
Width of link w [m] 0,220
Thickness t [mm] 7,00
On begin v
On end W

Properties of the IPE330 cross-section:

A [mm*2]
Ay [mm*2]
=z Az [mm*2]
AL [m*2/m]
AD [m*2/m]
c¥UCS [mm]
cZUCS [mm]
o [deg]
Iy [mm*4]
Iz [mm*4]
iy [mm]
iz [mm]
Wely [mm*~3]
Welz [mm*3]
Wply [mm*3]
Wplz [mm*~3]
Mply+ [Nmm]
Mply- [Mmm]
Mplz+ [Nmm]
Mplz- [Nmm]
dy [mm]
dz [mm]
It [mm*4]
lw [mm 8]
By [mm]
Bz [mm]
Values in SCIA Engineer:
Check for battened compression member
Length L. 4600.00 mm
Length a 1150.00 mm
Distance between centroids of ho 210.00 mm
chords
Second moment of area of chord |Ic 7.8800e+06 |mm*
Slenderness A 41.50
Efficiency factor d 1.00
Area of chord Ac |6.2600e+03 |[mm?
Effective second moment of area |I.¢ [1.5379e+08 |mm*
Shear stiffness Sy 24381.93 kN
Bow imperfection eo 9.20 mm
Moment ML |0.00 kNm
Moment Megq  |4.86 kNm
Shear force Veg  |3.32 kN
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Manual calculation of those values:

o | length = member length — (distance from begin) — (distance from end)
= 5000 mm — 200 mm — 200 mm = 4600 mm
e a distance between battens = I/ (humber of divisions) = 4600 mm / 4 = 1150 mm
* ho distance between centroids of chords = 210 mm
* len I of the IPE330 profile
e A area if one I-profile, so A of IPE330
* A =L /io=4600 mm/110,833 mm = 41,5

11 = O,S'h(z)'Ach‘l‘Z'Ich
=0,5- (210 mm)? - (6260 mm?) + 2 - (7881000 mm*) = 1,538 x 108 mm*

. 1 1,538 x 108mm*
ip = 1= >— = 110,833 mm
2:Ach 2:6260mm

e M =0ifA> 150
=2-2if75 <A <150
=10ifA<75
for this example A=41,5<75 > pu= 1,00
d |eff =0'5h(2)ACh+2|J'ICh
=0,5-(210 mm)?- (6260 mm?) + 2 - (1,00) - (7881000 mm*) = 1,538 x 108 mm*
24-E-Ich 2'm?-E-Ich
* Sy = 2(+2—1cchh_0) but Sv < T[a—zc
nilb a

n = number of planes of battens: n = 2
I = (thickness batten) x (width of batten)3/ 12 = (7 mm) x (220 mm)3/ 12
= 6,211 x 108 mm*

210000N
24-E-Ich 24(22277)-(7881000mm*)

2Ich ho

2.( 2Ich )_ 2.(1. 2(7881000mm%) 210mm
as 1+ (14
nib a (1150mm) (1 2:(6,211x 106 mm%) 1150mm

= 2,438x 10* kN

210000N
2-m*Elch _ Z'HZ'(T)-(7881000mm4)

= = =2,470x 10* kN

a2 (1150)2

> Sv=2,438x10*kN
* €0 =1/500 = 4600 mm /500 = 9,2 mm
e Med, M: in the cross-section under consideration = 0 kNm

; Ngd _ NEq Ngd-eo+Mgd,1
® Med If(l_N__S_ >0 eMEd=W
o " Ner Sy

otherwise: - Med =1 x 108 kNm

2.(210000NY 8. 4
B e _ T (307) (1,538 x 10°mm*)

L2 (4600mm)?

Ng = = 15064 kN

500kN 500kN
15064kN 24700 kN

9(1— )=0,9466>0

Nggq-eo+M 500kN-9,2mm+0kNm
B0 ol = 4860 kNmm = 4,860 kNm
1-NEd_Ned 0,9466
Ncr Sy
TMgg _ ™4860kNmm

1 4600mm

') thd:=

* Ve =

=3,32kN

The check of the chord will be executed with a section check following the EN 1993-1-1 for the chord profile
with the following internal forces on one batten:

Check of chord as beam in field between battens
According to EN 1993-1-1 article 6.4.3.1 & 6.2.9.1 and formula (6.42)

Axial force Ng [270.78 |kN
Shear force |Vg |1.66 kN

Moment Mg |0.95 kNm
Unity check 0.19 -
. N = Nerord = 0'5 . NEd + M _ 0'5 . 500kN + (4860kNmm)-(210mm)-(6260mm?) = 270,78 KN
2-1eff 2:1,538 x 108mm*

* Ve=Ved/2=3,32kN /2 =1,66 kN

Vggq-a 3,32kN:1150mm
e Mg= E:‘ = = 0,95 kNm

This section check will result in a unity check of 0,19
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Buckling check of chord
According to EN 1993-1-1 article 6.4.3.1 & 6.3.1.1 and formula (6.46)

= Nchord = 170,78 kN (see check ‘Check of chord as beam in field between battens’)

Chord force Nched |270.78 kN
Buckling length ler 1150.00 |mm
Slenderness A 32.41
Relative slenderness | Arel 0.37
Buckling curve b
Imperfection a 0.34
Reduction factor X 1.00
Unity check 0.16 -
¢ NchEd
o e buckling length
ler 1150mm
e A slenderness = jI—Tg \/m = 32,411
ACg 6260mm?
2.275N
o el relative slenderness = fACh v _ (2200 2
Nerz 12351000 N

*  Buckling curve = b, this is the buckling curve for the IPE330 around the z-axis
imperfection factor for buckling curve b = 0,34
reduction factor, can be calculated as explained in the buckling check

s a
* X
« UC

Check of batten

According to EN 1993-1-1 article 6.4.3.1, 6.2.9.2 & 6.2.6 and formula (6.42), (6.19)

(21°°°°N )-(7881000mm*)

T Elp

with N, , = B = 12351 kN

(ler)? (1150mm)?

NchEed _ 270,78kN
Npra 16182 kN

unity check = =0,16

6260mm?-275N/mm?

. _ Ach fy
with Nb,Rd =X" Yo =0,94- 1,00

Thickness t 7.00 mm
Width of link |b 220.00 |mm
Moment i ] 9.09 kN
Moment Mgz |[0.95 kNm
Stress o} 16.9 MPa
Unity check 0.06 -
Stress T 5.9 MPa
Unity check 0.04 =
e thickness of batten
e b width of batten
. T _ VEq-a _ 3,32kN-1150mm = 9,09kN
hg-2 210mm-2
e Mg = 0,954 kNm (see previous check)
. o MG b/2 954-000Nmm6220r;1m/2 — 16 9 MPa
6.211-10°mm
calculatlon of lp: see calculation of Sy above
o 16,9MPa
d UCo = I = 27sN/mm? 0,06
YMo 1,00
-7 =L =% _—59MPa
b-tT 220mr151-gl\r}[115r211
¢ ucr = fy/V3 275N/mm?/y/3 0 04
YMo 1,00

= 1618,21 kN
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Chapter 6: Optimisation

In SCIA Engineer there are two ways of performing an optimisation:
e cross-section optimisation: optimisation of a chosen cross-section;
< overall optimisation: optimisation of one or more (or all) cross-sections at the same time.

Both options are explained in the next two paragraphs.

6.1. Cross-section optimisation

With this option you can optimise a cross-section for the steel code check. This will be explained in the
example below.

Example: Optimisation.esa

The optimisation can be found via the steel check command. First the steel code check has to be executed,
so first click on Refresh in the property panel. Then you can choose for the action Autodesign :

ACTIONS %

(® Refresh

@ New combination from Combination key

|@ Autodesign I
(® Preview

It's possible that SCIA Engineer will give following message:
SCIA Engineer 20.0.0043 X

| Filter will be switched on Cross-section

In the property panel the option for Filter has been changed into Cross-section . Now choose here for the
cross-section IPE140 and click again on Refresh and afterwards on Autodesign .

Now the Autodesign of the cross-section  window will open:

Autodesign of the cross-section X
Autodesign
1
Maximal check
Maximum unity check: 011
Edit constraints Info
Edit Change
Mext down Mext up
Search for optimal
Direction Up & down ~ N
Parameter %
1 - catalogue: IPE140 ~
Param. Value Autodesign List Sort by
1 Isection IPE140 Yes No v H v
Set value Select/Deselect All Test relations Cancel

First you can fill in the maximal check . Normally this is a unity check of 1,00.

The Maximum unity check displayed below is the maximum unity check for the IPE140, found in this
project.
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When clicking on <Search for optimal> , SCIA Engineer will suggest the smallest IPE cross-section which
will resist the calculated internal forces. In this example an IPES80AA will be found. When clicking on <OK>
now, SCIA Engineer will replace this IPE140 profile by an IPESOAA profile automatically.

Now the steel code check of this IPES80AA profile is executed with the internal forces calculated with the
properties of the IPE140 profile. For example, the self weight will not be taken into account correctly. So, the
project should be recalculated, before accepting those new unity check results.

It is also possible to use a list of sections . With this list it is possible to indicate which sections can be used
or not. For example, the section IPE140A can be filtered out the possibilities for the autodesign.

Recalculate the project and let us make a list for the columns. This can be done through Menu bar >
Libraries > Structure and analysis > Cross section list and choose for Library cross-section of one
type . Now select the profiles that should be added to this list (you can use the Ctrl button for this):

Form code

-
Rectangular hollow section
Circular hollow section

L section

Channel section

Tsection

Full rectangular section
Full circular section
Asymmetric | section

Rolled Z section

Cold formed angle section

Code name

Selected to list

Cold formed channel sectio HL[SZ5)
Cold formed Z section HMICH)
Cold formed C section HM[CH]} HEAZ204

Cold formed Omega sectior HP HEAZ240

Cold formed C section eave: HP[ARC) HEAZ2404

Cold formed C-Flus section HP[ARCUS)

Cold formed ZED section HRGERD) HEA2604

Cold formed ZED section as, HP{Imp)

Cold formed ZED section in HT(CH) HEA280A

Cold formed Sigma section HWI(CH)

Cold formed Sigma section | v HEA3DOA v
oK Cancel

When performing an Autodesign in the steel menu now for the columns HEA220, this list can be chosen:

Autodesign

Maximal check

Maximum unity check:

Edit constraints

Edit

Next down

1.00

0.02

Info

Change

Mext up

Search for optimal

Direction

Up & down ~

N
Parameter
1 - catalogue: HEA220 -
Param. Value Butodesign List Sort by
1 Isection HEA220 Yes LIST1 v H v

Set value Select/Deselect All Test relations oK Cancel

For the moment this profile has a maximum unity check of 0,015, so SCIA Engineer will search for the
smallest profile from this ‘LIST1’ which will pass the unity check.

Close this example without saving! It will be used in the next paragraph again!
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In the next example the different options of the cross-section optimisation are explained.

Example: Optimisation2.esa

Go to the steel check command and execute Autodesign for this beam.

This profile has a lot of parameters, so you can choose which parameter(s) should be updated:

Autodesign of the cross-section

Autodesign

Mazximal check

Maximum unity check: 3.53
Edit constraints Info
Edit Change
Mext down Mext up

Search for optimal

Direction Up & down ~

Parameter

1 - dimension: Ba ~

Z-d?mens?on:tha Pdesig lelated tc
3 - dimension: Bb

4 - dimension: thb fes No
5 - dimension: A
Advanced Autodesign
Coupled Set Autodesign
Set value Select/Deselect All

X

Ba 400

Bh 300

Ratio List Step Min Max Info
Ne v 10 100 500
Test relations Cancel

Also the option Advanced Autodesign  will appear. With this option several parameters can be optimised at
the same time and restriction for each parameter can be given. So input the following options:

Autodesign

Maximal check

Maximum unity check: 3:53
Edit canstraints Info
Edit Change
Boxt dowe Heviip

Search for optimal

Direction Up & down |
Parameter
Advanced Autodesign ~
Param. Value utodesig lelatedtx
1 Ba 400 2 Yes No
2 tha 12 Ne Ne v
3 Bb 300 [ Yes No
4 thb 12 Ne Ne v
5 A 120 B Yes No
Setvalue Select/Deselect All

\

Ba 400

300

Lo

thb 12
Ratio List Step Min. Max Info
Neo v 10 100 500
Ne v 10 1 16
Ne v 10 100 700
Ne v 10 1 16
No ¥ 10 60 500
Test relations OK Cancel

With these settings, thicknesses thb and tha are not autodesigned. If you want to autodesign these as well,
the step should be chosen wisely (for example a step of 1 instead of 10). All other options can be adapted by

SCIA Engineer.
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When clicking on <Search for optimal>, the following profile is suggested by SCIA Engineer:

Autodesign
i 1.00 a——

Maximal check | . Ba 440 .
hiamum I cheds ok '—ﬁz'-

t anstraints Info :

Edit Change = o
Mext down MNext up m
N
Search for optimal 4‘ [
Direction Up & down ~ 5 —7 Y
thb 12 Al2
| Parameter
Advanced Autodesign ~

Param. Value utodesig lelatedtc Ratio List Step Min. Max. Info
1 Ba 440 Fl Yes No No v 10 100 500
2 tha 12 No No ¥ No ¥ 10 1 16
3 Bb 300 o Yes No No v 10 100 T00
4 thb 12 Ne Ne v Ne v 10 1 16
5 A 120 [Yes No Ne v 10 60 500

Set value Select/Deselect All Test relations OK Cancel

With the option Set value a value for a certain parameter can be set. So, select the parameter ‘Ba’ and click
on ‘Set value’. Now a value of 500 mm can be inputted. And the Maximum unity check for this profile will
be adapted automatically.

6.2. Overall optimisation

It is also possible to perform an overall optimisation in SCIA Engineer. With this option, one or more profiles
can be optimised at the same time. Afterwards the calculation will be restarted and the internal forces are
recalculated with the new cross-sections, followed again with a new optimisation.

This iterative process can:
» stop because all profiles do not have to be autodesigned and the same profile was found as in
the previous step;
» or stop because the maximum number of iteration steps has been reached if this is inputted by
you.

It is advised to input a number of iteration steps, otherwise this optimisation process can become a loop and
will stop after 99 iteration steps. This will cost a lot of calculation time.

The principle of the overall optimisation process is explained by the following example.

Example: Optimisation.esa
If this example is still open from the previous chapter, please close it and reopen it without saving.
Calculate the project and go to Menu bar > Tools > Calculation & Mesh > Autodesign

Click here on Add item and choose for Steel > Cross-section AutoDesign  and add all cross-sections in
this autodesign process.
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Advanced Concept Training — Steel code check

The combination, for which the optimisation calculation has to be calculated, can be chosen.

Also for each profile, you can indicate if this profile has to be autodesigned only in the Up direction (so only
become bigger) or in the Up and down direction (and also can become a smaller profile as result). With this
last option, there is a chance that the iterative process will become a loop.

- %

Propertv Parameters PICTURE
Name 01 Cross-section ©S1-HEA2 »
Type of loads Combinati v Parameter HEAZZO v
Combinations C01-ULS ¥ | Use cross-sectio
Autodesign type Steel - Cross Rolled HEAZZO
ftems count 4 Sortby Height -
Starting CS5 Actual *

Search pattern Find firsto »
Direction Upanddoy v

ltems Maximal check [ 1.00

Autodesign chec 0.9
2, €S2 (IPE140)

3. €53 [HFLeg45x45x5)

4, C54 (IPE100)

Remove liem Add item

Autodesign | Caleulation Close

Now <Close> this window. And click in the next window on <Optim. Routine> :

B Ohverall Auto n w

BEEREFE «2 O B A vy

S} Hame 01 ~
Type of loads Combinations v
Combinations C01-ULS v

Autodesign type Steel - Cross-section AutoDesign
ltems count 4
Autodesign item ltem 1 v
4+ Autodesign item
Cross-section C51-HEA220 v
Parameter HEAZZ0

llea Frace_cartinn lick

New Insert Edit Delete I Optim.Routine IAulodesign all | Calculate | Close

Now you can choose for a maximum number of iteration steps:

» Determine automatically: the iteration process will stop if all the profiles are autodesigned and
no different result will be found in a certain iteration step. So no maximum of number of
iteration steps will be inputted.

e Limit number of iteration: maximum of number of iteration steps.

Input 6 iteration steps as limit number and click on <Start>.

Now the iteration process will start. The iteration process will stop after no difference will be found or after 6
iteration steps. In this example SCIA Engineer will stop after 5 iterations steps, because all cross-sections
remain the same after the fifth step.
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After this process, an information window about this iteration will be displayed. The first two columns (Cross-
section and Parameter) don't provide a lot of information: they both mention the final cross-section.

ITERATION STEP 1:

1. Routine step 1

1.1, 1
Cross-section Parameter Sort by | Original cross-section | Auicdesign of cross-seclion | Aulbdesign check
fl
C51 - HEA1604A HEA160.4 Height C51 - HEAZZ0 C51 - HEAZOO 0382
C52 - IPE20O0C IPE2Z00O0C Height CS52 - IPE140 CS2 - IPE200O 0,89
CS53 - HFLeg90x50x% [HFLeg®0xS0x5 |Height CS53 - HFLegéSx45x5 | C53 - HFLeglOxS0x3 0,54
C54 - IPE140A IPE140A Height CS4 - IPE100 C54 - IPE140AA 0,91

Changed profiles:

+ CS1: HEA220 > HEA200
* CS2:IPE140 - IPE2000
* (CS3: HFLeq45x45x5 - HFLeq80x80x8
+ CS4:IPE100 - IPE140AA

ITERATION STEP 2:

2. Routine step 2

Cross-section Parameter Sort by | Original cross-section | Auibdesign of cross-secfion | Auibdesign check

fl
C31 - HEA1G0A HEA160A Height C31 - HEAZOO C31 - HEA1G0 082
CS2 - IPE20O0OC IPE2000O Height CS2 - IPE2000O C52 - IPE200 0,99
CS53 - HFLeg90x50x% [HFLeg®0=x30x% |Height CS53 - HFLeg80xg80x3 |CS3 - HFLegS0xS0=9 0382
C54 - IPE140A IPE140A Height C54 - IPE140AA C54 - IPE140A 0,97

Changed profiles:

*+ CS1: HEA200 > HEA160
+ CS2:IPE2000 - IPE200
» CS3: HFLeq80x80x8 > HFLeq90x90x9
* CS4: IPE140AA > IPE140A

ITERATION STEP 3:

3. Routine step 3

Cross-section Parameter Sort by | Original cross-section | Auibdesign of cross-seclion | Auibdesign check

fl
C51 - HEA160A HEA160.4A Height C51 - HEA1S0 C51 - HEA160 0,76
CS2 - IPE20O0OC IPE200OO Height Cs2 - IPE200 CS2 - IPE2000O 0,87
C53 - HFLeg90x50x% [HFLeg90=x30x5% |Height CS53 - HFLegB0xS0xS | CS3 - HFLeg90xS0=9 0,99
C54 - IPE140A IPE140A Height CS4 - IPE140A C54 - IPE140A 0,98

Changed profiles:

+ CS2:IPE200 - IPE2000

ITERATION STEP 4:

4. Routine step: 4

Cross-section Paramefer Sort by | Original cross-section | Autodesign of cross-section | Autodesign check

]
CS1 - HEA180A HEA 180A Height CS1 - HEA160 CS1 - HEA180A 0.98
CS2 - IPE200O IPE2000 Height Cs2 - IPE200O CS2 - IPE2000 0.89
CS3 - HFLeq90x80x9 |HFLeg90x90x9 |Height CS3 - HFLeq90x90x® |CS2 - HFLeg90x90x9 0.97
CS4 - IPE140A IPE140A Height CS4 - IPE140A CS4 - IPE140A 0.98

Changed profiles:

+ CS1: HEA160 > HEA160A

BV —2021/06/21

97



Advanced Concept Training — Steel code check

ITERATION STEP 5:

5. Routine step: 5

Cross-section Paramefer Sort by | Original cross-section | Autodesign of cross-secfion | Autodesign check

I
CS1 - HEA180A HEA180A Height CS1 - HEA160A CS1 - HEA160A 0.90
Cs2 - IPE200O IPE2000 Height Cs2 - IPE200O Cs2 - IPE200O 0.8
CS3 - HFLeq90x90x9 |HFLeqg90x90x9 |Height CS3 - HFLeq90x90x® |CS3 - HFLeg90x90x9 0.98
CS4 - IPE190A IPE140A Height CS4 - IPE140A CS4 - IPE140A 0.98

As a limit number we put 6 iteration steps, but since the cross-sections are the same as in the previous
iteration step, the iteration process is completed after 5 iterations.

6.3. Arbitrary members

Since SCIA Engineer 17.0, there is a new setting available for performing the autodesign of arbitrary
members. This setting can be found in the steel settings.

B Steel setup s
(= Standard EN Name Standard EN
- Steel
4
= Member check Steel
- Fire resistance P Member check EN 1993-1-1
- Cold Formed P Fire resistance EN 1893-1-2
- Plated structural elements
993-1-
- Limit slenderness b ‘Cold Farmed EN 1995-13
-~ Butkling defaults > Plated structural elements EN 1993-1-5
~SLS deflection check b Limit slenderness EN50341-1
Autodesign

P Buckling defaults

P 5LS deflection check

4

Autodesign

Consider arbitrary members as prismatic for Autodesign [L4] ves

Load default non-NA parameters Load default MA parameters oK Cancel

When this setting is activated (default setting), the member is considered as being prismatic (e.g.one cross-
section) during the autodesign calculation. This speeds up the calculation.
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71. Overview

Global analysis aims at determining the distribution of the internal forces and moments and the
corresponding displacements in a structure subjected to a specified loading.

The first important distinction that can be made between the methods of analysis is the one that separates
elastic and plastic methods. Plastic analysis is subjected to some restrictions.

Another important distinction is between the methods which make allowance for, and those which neglect
the effects of the actual, displaced configuration of the structure. They are referred to respectively as
second-order theory and first-order theory based methods.

The second-order theory can be applied in all cases, while first-order theory may be used only when the
displacement effects on the structural behaviour are negligible.

The second-order effects are made up of a local or member second-order effects, referred to as the P-&
effect, and a global second-order effect, referred to as the P-A effect.

P
g o s
xi
L
: L
|
I
e 1 77
M(x} = Hx Mix)=Hx +P§+Pa x/L
M(L) = HL M(h) =HL + P o
First Order Theory secand Order Theary

On the next page an overview of the global analysis following the EN 1993-1-1, chapter 5, is given:

» All the rules in this overview are given in the EN 1993-1-1 art. 5. For each step the rule will be
indicated. The first rule (acr > 10) will be explained in EN 1993-1-1 art. 5.2.1(3).

» In this overview 3 paths are defined:

o Path 1: in this path a first order calculation will be executed

o Path 2: in this path a second order calculation will be executed with global (and if
necessary local/bow) imperfections.

o Path 3: in this path a second order calculation will be executed with the buckling shape
of the construction as imperfection.

e The calculation will become more precise when choosing for a higher path.

« The lower paths will result in a faster calculation, because a first order calculation can be
executed without iterations, but this first-order theory may be used only when the displacement
effects on the structural behaviour are negligible.

* Inthe next paragraphs the rules in this overview will be explained.

To take into account all non-linearities in the model, non-linear load combinations are made.
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Advanced Concept Training — Steel code check

Structura Frame Stability

5.2.1(3)
o =10
A
ves No 52.2(3)b 5.22(3)a 5.3.2(11)
Global Imperfection ¢
5.3.2(6)
N Y
[ >3 5226 ° Neg > 25% N = Ner
Q (member)
& if ginall
required members

(1) () 2a 2b é{) 3

1% Order Analysis 2" Order Analysis

O )
Increase sway
effects with: No Members v
_ 1 ) with e,
1
1-—
acr
5.2.2(3)c 5.2.2(7)b
I» based on a global Ip taken equal to L
buckling mode
Stability Check in plane
5.2.2(7)a
Stability Check out of plane + LTB Check
Section Check
With:

*  MNer elastic critical buckling mode

« L member system length

e buckling length
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7.2. Alpha critical
The calculation of alpha critical is done by a stability calculation in SCIA Engineer.

According to EN 1993-1-1, 1st order analysis may be used for a structure, if the increase of the relevant
internal forces or moments or any other change of structural behaviour caused by deformations can be
neglected. This condition may be assumed to be fulfilled if the following criterion is satisfied:

F . .
A = — = 10 for elastic analysis

Fgd
With:
*  Oer factor by which the design loading must be increased to cause elastic instability in
a global mode
*  Fea design loading on the structure
e Fer elastic critical buckling load for global instability, based on initial elastic stiffnesses

If acr has a value lower then 10, a 2™ order calculation needs to be executed. Depending on the type of
analysis, both global and local imperfections need to be considered.

EN1993-1-1 prescribes that 2" order effects and imperfections may be accounted for both by the global
analysis or partially by the global analysis and partially through individual stability checks of members.

7.3. Global frame imperfection ¢

L

- L

The global frame imperfection will be inputted for the whole structure by an imperfection value @. This value
can be calculated with the following formula (EN 1993-1-1 art. 5.3.2(3)a):
1

!
|
|
|

P =500 % %m
With:
+ oy ==but Z<a, <10
© oy = /0,5(1+$)
e h height of the structure in meters
* m number of columns in a row including only those columns which carry a vertical load

NEed not less than 50% of the average value of the vertical load per column in the
plane considered.

The global imperfection can be inputted in SCIA Engineer in the nonlinear combinations as explained by the
example below.
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Example: Industrial Hall.esa

In this example, two global imperfections functions will be used: one according to global X-direction and one
according to the global Y direction. It is not necessary to combine both imperfections in the same combination.

In SCIA Engineer you can choose between five options for the global imperfection in the nonlinear
combinations (Menu bar > Libraries > Load cases, combinations >N  onlinear combinations ):

* None: no global imperfection will be taken into account

e Simple inclination : the imperfection is defined as a simple inclination. The inclination is
defined in mm per m height of the structure. More specifically a horizontal displacement is
given in the global X and/or Y direction which has a linear relation to the height (global Z
direction).

* Inclination functions : the imperfection is defined by a deformation-to-height curve, similar to
the simple inclination. The curve can then be assigned to an appropriate non-linear
combination. These inclination functions are entered through Initial deformations (this option is
explained below)

» Deformation from loadcase : with this option you can choose for a calculated loadcase and
the deformation of that loadcase will be used as initial global imperfection. . This option can be
used to take into account for example the imperfections due to the self-weight. Especially for
slender beams this can be important.

< Buckling shape : the imperfection is derived from the buckling data

B Monlinear combinations x
HiEFE «= O A Y
NC1 Name NC1
NC2 Description
Nes Solver index (1)
Nea T Ultimat
imate v
NCs ype
NCE 4 Contents of co...
NCT LC1 - Self Weight [-] 1.35
NC8 LC2 - Self Weight Clar 1.35
NCg LC3 - Maintenance [-] 1.50
:Em LC4 - Snow [] 0.75
11
30Wnd10 - 180, + CF 0.90
NC12
NC1Z Bow imperfection None A
NC14 Global imperfection Buckling shape ~
NC15 None
NC16 Simple inclination
NC1T Inclimation functions
Deform. from loadcase
NC1g Buckling shape
NC19
NC20
New from combinati..| New Insert Edit Delete Close
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In this example the option Inclination functions  has been chosen.

These inclination functions are entered through Menu bar > Libraries > Structure and analysis > Ini  tial
deformations .

The Type is chosen as EN 1993-1-1 art. 5.3.2(3), with a basic imperfection of 1/200. In this way the
inclination function is calculated according to the code EN 1993-1-1.

The height of the construction is 8,4 m for both inclination functions.

There are 6 columns in the X-direction, but in the middle spans only 2 columns are inputted. Because a long
part of structure only has 2 columns in the X-direction, in this example the number of columns in this direction
has been inputted as ‘2'.

There are 11 columns in the Y-direction. But the columns at the end are smaller than the middle ones. So, in
this example it is decided to input ‘9’ columns in the Y-direction.

The inclination function for the X-direction (Def_X) in SCIA Engineer is displayed below:

B Initial defermations x
= Bk as O W@ A vY
Def X
Def Y

Mame Def_X

Type EN 1993-1-1art.5.3.2(3) v
Basic imperfection value: 1/ [-] 200.00
Height of structure : [m] 8.400

Number of columns per plane: 2

©: 0.00295300

oy, [ 0.69
o[ 0.87
Mew Insert Edit Close
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In this example 5 nonlinear combinations are inputted:
» 1,35 x Self Weight + 1,35 x Self Weight Cladding + 1,5 x Maintenance + 0,75 x Snow

+ 0,9 x 3DWind10

* 1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind13
« 1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind14
* 1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind15
1,35 x Self Weight + 1,35 x Self Weight Cladding + 0,75 x Snow + 1,5 x 3DWind16

All combinations are entered four times:

* NC1-NCS5: inclination in the positive X- direction

* NCB6-NC10: inclination in the negative X- direction
¢ NC11-NC15: inclination in the positive Y- direction
¢ NC16-NC20: inclination in the negative Y- direction

Mew from combinati...

B " Monlinear combinations

HEENFE «2 O A Y
NC1 Mame MC1
NC2 Description
:Ej Solver index “].
NCs Type Ultimate
NCE 4« Contents of combination
NCT LC1 - Self Weight [-] 1.35
NCa LC2 - Self Weight Cladding [-] 1.35
NCo LC3 - Maintenance [-] 1.50
NeLo LC4 - Snow -] 0.5
MNC11
— 3DWnd10 - 180, + CPE,- CPI[-] 0.90
NC13 Bow imperfection According to buckling data
NC14 Global imperfection Inclination functions
NC15 4 dx inclination functions
NC16 7 Def X
(oGl Factor None
:212 Sense +
NC20 ¥ None
4 dy inclination functions
7 None
% None
4 dz inclination functions
¥ None
¥ None

Mew

Insert Edit Delete

Close

Tip: The nonlinear combinations can be copied from the linear combinations using the button <New from
linear combinations> . If code or envelope combinations were used to perform the linear calculation, the linear

calculation first needs to be executed before the nonlinear combinations can be created.
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7.4. Bow imperfection

7.4.1. Ned > 25% Ner
The relative initial local bow imperfection of members for flexural buckling is given as the value: eo/L.
This bow imperfection does not have to be applied on each member as given in EN 1993-1-1 art. 5.3.2(6):

When performing the global analysis for determining end forces and end moments to be used in member
checks according to 6.3 local bow imperfections may be neglected. However, for frames sensitive to second
order effects local bow imperfections of members additionally to global sway imperfections should be
introduced in the structural analysis of the frame of each compressed member where the following conditions
are met:

» atleast one moment resistant joint at one member end

Ner NEd
> A5 05 A or L5 0,25 L or Ngg > 0,25 N
Ner Ngq Ner Ngq

So, the bow imperfection must be applied when the normal force Neq in @ member is higher than 25% of the
member’s critical load Ner.

7.4.2. Bow imperfectione o

The initial bow imperfection is given by:

™ Buckling curve | elastic analysis | plastic analysis
acc. to Table 6.1 e/ L e/ L
a 1/350 1/300
a 1/300 1/250
b 1/250 1/200
c 1/200 1/150
d 1/150 1/100

Where L is the member length.

As explained in the previous chapter, the bow imperfection must be applied when
the normal force Ned in @ member is higher than 25% of the member’s critical
buckling load Ner. If Ned < 25% Ner, you can choose to apply this bow imperfection
or not.

The buckling curve used for calculation of the imperfection is the curve inputted in the cross-section library.
For standard sections, the curve according to the code is automatically used, for non-standard cross-sections
(as general cross-sections) you need to input the buckling curve manually.
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Example: Industrial hall.esa

In SCIA Engineer you can choose between three options for the bow imperfection

combinations:

106

None: no bow imperfection will be taken into account
Simple curvature : you will input a deformation ‘' or ‘1/f for all the members, where ‘1/f’
corresponds with the value ‘eo/L’ as explained earlier.
: with this option you can choose for a local imperfection as defined
in the buckling data, so for each member following his own buckling curve (this option is

According to buckling data

explained below).

B ' Monlinear combinations x
H-iEIFE «as B a v ¥
NC1 Name NC1
NCz Description
Nea Solver index (1)
hCA T Ultimat
i imate v
NCS ype
NCE 4+ Contents of combination
NCT LC1 - Self Weight [-] 1-35
NC8 LC2 - Self Weight Cladding [-] 1.35
NC9 LC3 - Maintenance [-] 1.5Q
e 14 Show ] 078
NC11
Neis 3DWnd10 - 180,+ CPE, - CPI [-] 0.90
NC13 Bow imperfection According to buckling data  «
NC14 None
NCis Simple curvature
According to buckling data
NC16 L LREl_A v
NC17 Factor MNone v
NC18
Sense * v
NC19 N
v
NC20 Lt
4 dy inclination functions
7 None v
¥ MNone v
4 dz inclination functions
¥ Mone v
Y MNone v
MNew from combinati...| MNew Insert Edit Delets Close

in the nonlinear
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In this example the option According to buckling data  has been chosen.

Since SCIA Engineer 21.0 the buckling data can be defined via the steel settings :

| B Steel setup did
[ Standard EN Name Stancard EN ~
(=} Steel
) -
- Member check Steel
Fire resistance b Member check EN 1993-1-1
- Cold Formed I Fire resistance EN 1993-1-2
- Plated structural elements
993-1-3
o Lt sten derness > Cold Formed EN 1993-1-3
- Buckling defaults > Plated structural elements EN 19983-1-5
- 5LS deflection check b Limit stenderness EN 50341-1
-~ Autodesign
4

Buckling defaults

4 Buckling systems relation

7z IZ v
yz IL v
It zz v

4 Deflection systems relation
In plane deflection (def z) ¥¥ ¥
Out of plane deflection (def y] ZZ v
ky factor Calculate v
kz factor Calculate v
Point of load application Inshear center ¥

4 Bow imperfections

Bow imperfection el,y No bow imperfection A

Bow imperfection 0,z Mo bow imperfection

EN 1993-1-1 Table 5.1 - elastic

EN 1993-1-1 Table 5.1 - plastic

EN 1993-1-1 Table 5.1 - elastic - if requir
EN 1993-1-1 Table 5.1 - plastic - if requir
Manual input of bow imperfection

e )

Load default non-NA parameters Load default NA parameters Cancel

It is also possible to define the bow imperfections on buckling groups level (via Buckling groups or System
lengths and buckling groups).

You can choose between 6 options:

EN 1993-1-1 Table 5.1 — elastic : the elastic value following the buckling curve of the cross-
section will be used

EN 1993-1-1 Table 5.1 — plastic : the plastic value following the buckling curve of the cross-
section will be used

EN 1993-1-1 Table 5.1 — elastic — if required : the elastic value following the buckling curve of
the cross-section will be used if Nea > 25% Ner

EN 1993-1-1 Table 5.1 — plastic — if required : the plastic value following the buckling curve
of the cross-section will be used if Neq > 25% Ner

Manual input of bow imperfection : you can input manually a value for this bow imperfection
No bow imperfection : no bow imperfection is taken into account for the member

In this example on all beams the bow imperfection EN 1993-1-1 Table 5.1 — elastic has been inputted. Only
for the diagonals no bow imperfection has been inputted in this example.
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7.5.

Buckling shape as imperfection -

Ner

As an alternative, the global and bow imperfection can be replaced by the buckling shape as imperfection
(path 3 from the global diagram).

To input geometrical imperfections, the functionalities Nonlinearity > Initial imperfections

must be activated:

Project data

Basic data

Functionality Actions Unit Set  Protection
GENERAL

Property modifiers
Model modifiers
Parametric input

Climatic loads @
Mokbile loads
Dynamics

Stability E
MNonlinearity %
Structural model Q

IFC properties

Prestressing
Bridge design
Excel checks
Substitution beam

DETAILED
4 Monlinearity lal
Beam local nonlinearity @E
Support nonlinearity/basic soil <
I Initial imperfections lil

Geometrical nonlinearity Q

General plasticity
Cables
Friction support/Soil spring

4 Subsoil
Pad foundation check

4 Steel
Plastic hinge analysis
Fire resistance checks
Steel connections
Scaffolding
7DoF 2nd order analysis for [TB Y]

10],% Cancel

s

and Stability

So first, the stability calculation (linear or nonlinear) is calculated. Afterwards in the nonlinear combinations,
you can choose the buckling shape you want to be considered. First you can choose for the stability
combination and just below for the calculated mode:

B " Menlinear combinations *
HEiEFE «» O A v Y

NC1 Name NC1

nez Description

e Solver index (1)

NCa -

NC5 Type Ultimate v
NCE 4+ Contents of combination

NCT LC1 - Self Weight [[] 1.35

NC8 LC2 - Self Weight Cladding [[] 1.35

e LC3 - Maintenance [[] 1.50

hco LC4 - Snow [-] 0.75

ne 3DWnd10 - 180, + CPE, - CPI[] 0.9¢

NC12

NC13 Bow imperfection None v
NC14 Global imperfection Buckling shape ¥
MC15 Stability 51 v
s Eigen shape 1

L8k Max deformation [mm] 10.0

NC18

NC19

NCz0

MNew from combinati..| MNew Insert Edit Delete Close

The last option that must be inputted is a value for the maximum deformation. This is the deformation of the
node which has the biggest deformation of the construction. SCIA Engineer will recalculate all the
displacement of the other nodes using this maximal deformation.
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Since the buckling shape is dimensionless, EN 1993-1-1 gives the formula to calculate the amplitude ninit of
the imperfection. In the example below this calculation is given for a simple example.

Example: Buckling Shape.esa
In this example, the procedure to calculate a buckling shape is illustrated for a column.

The column has a cross-section of type IPE300, is fabricated from S235 and has the following relevant
properties:

Wli_» E = 210000 N/mm?

fy = 235 N/mm?2
ym1 = 1,00
L =5000 mm
A = 5380 mm?2
ly = 83560000 mm*
I = 6040000 mm#*
Wiy = 628400 mms3

X Wi,z = 125000 mm3

Calculation of the buckling shape

First a stability calculation is done using a load of 1 kN. This way, the elastic critical buckling load Ncr is
obtained.

To obtain precise results, the Number of 1D elements is set to 10. This can be done via Menu bar > Tools
> Calculation & Mesh > Mesh settings . In addition, the Shear Force Deformation is neglected so the
result can be checked by a manual calculation.

The stability calculation gives the following result for the critical load coefficients (Menu bar > Results >
Critical load coefficients ):

Critical load coefficients

Stability combination : S1
1 500.75
2 2003.39
3 4511.38
4 6927.50

This can be verified with Euler’'s formula using the member length as the buckling length:

n?El - 210000N/mm? - 8,3560 - 10’mm*
[ (5000mm)?

N = = 6927,51 kN

For the weak axis we can calculate N¢r with I; to become 500,77 kN.
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The following picture shows the mesh nodes of the column and the corresponding buckling shape:

3D displacement

Stability calculation. Buckling shapes are normalized, so that the maximum nodal displacement resp. rotation component of each mode is equal to
im resp. 1rad.

Stability combinations: S1/1 - 500.75
Selection: All
Location: In nodes avg.. System: Global
Results on 1D member (central fine):
Extreme 1D: Section
Name dx Case Ux uy uz Px Py Pz Urotal
[m] [mm] [mm] [mm] [mrad] [mrad] [mrad] [mm]
B1 0.000 S1/1 - 0.0 0.0 0.0 -628.3 0.0 0.0 0.0
500.75
B1 0.500- S1/1 - 0.0 309.0 0.0 -597.6 0.0 0.0 309.0
500.75
B1 0.500+ |S1/1 - 0.0 309.0 0.0 -597.6 0.0 0.0 309.0
500.75
B1 1.000- S1/1 - 0.0 587.8 0.0 -508.3 0.0 0.0 587.8
500.75
Bl 1.000+ S1/1 - 0.0 587.8 0.0 -508.3 0.0 0.0 587.8
500.75
Bl 1.500- S1/1 - 0.0 809.0 0.0 -369.3 0.0 0.0 809.0
500.75
B1 1.500+ (S1/1 - 0.0 809.0 0.0 -369.3 0.0 0.0 809.0
500.75
B1 2.000- S1/1 - 0.0 951.1 0.0 -194.2 0.0 0.0 951.1
500.75
B1 2.000+ S1/1 - 0.0 951.1 0.0 -194.2 0.0 0.0 951.1
500.75
B1 2.500- S1/1 - 0.0( 1000.0 0.0 0.0 0.0 0.0| 1000.0
500.75
B1 2.500+ |S1/1 - 0.0| 1000.0 0.0 0.0 0.0 0.0 1000.0
500.75
B1 3.000- S1/1 - 0.0 951.1 0.0 194.2 0.0 0.0 951.1
500.75
B1 3.000+ S1/1 - 0.0 951.1 0.0 194.2 0.0 0.0 951.1
/ 500.75
B1 3.500- S1/1 - 0.0 809.0 0.0 369.3 0.0 0.0 809.0
500.75
B1 3.500+ |S1/1 - 0.0 809.0 0.0 369.3 0.0 0.0 809.0
500.75
B1 4.000- S1/1 - 0.0 587.8 0.0 508.3 0.0 0.0 587.8
500.75
B1 4.000+ S1/1 - 0.0 587.8 0.0 508.3 0.0 0.0 587.8
500.75
Wi B1 4.500- S1/1 - 0.0 309.0 0.0 597.6 0.0 0.0 309.0
/ 500.75
B1 4.500+ |S1/1 - 0.0 309.0 0.0 597.6 0.0 0.0 309.0
500.75
B1 5.000 S1/1 - 0.0 0.0 0.0 628.3 0.0 0.0 0.0
500.75

You can ask for this result via Menu bar > Results > 3D deformations  (or via Main > Results > Deformed
structure for post-processing environment ‘v16 and older’).

Using for example an Excel worksheet, the buckling shape can be approximated by a 4t grade polynomial.

1200

1000

800

600

400

/{: 5.72E-12x% - 5.72E-08x3 + 1.89E-05x2 + 6.21E-01x \0\
200
0 / . : . . \

0 1000 2000 3000 4000 5000

A polynomial has the advantage that the second derivative can easily be calculated.
* Mg =572-10"1%-x*-572-10"% x> +1,89-107°-x? + 6,21-1071-x
Mermax = 6,86 - 10711 -x2 —3,43-1077 - x + 3,78 - 107°
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Calculation of e o

@ y
M (X-0.2) %

= A—0,2
e =a-(A ) NRk 1—y (A) Npx

With:

2

i NRk:fy'A_

e A= ,/Npi/N. =+/1264300N/6885280N = 0,43

e a = 0,21 for buckling curve a

© x= — = 0,945
05[1+a(x-02)+(X)’] +J(o,5[1+a(1-o,z)+(1)2]) -()°

These intermediate results can be verified through SCIA Engineer when performing a steel code check on
the column:

Flexural Buckling check
According to EN 1993-1-1 article 6.3.1.1 and formula (6.46)

Buckling parameters Yy zz
Sway type sway non-sway
System length L 5.000 5.000 m
Buckling factor k 1.00 1.00
Buckling length ler 5.000 5.000 m
Critical Euler load Ner 6927.51 |500.77 kN
Slenderness A 40.12 149.22
Relative slenderness Arel 0.43 1.59
Limit slenderness Arel,o  |0.20 0.20
147674000 Nmm
eo = 0,21(0,43 - 0,2) - =5,573 mm

1264300 N

Calculation of _ninit

The required parameters have now been calculated so in the final step the amplitude of the imperfection can
be determined.

The mid section of the column is decisive - x = 2500
* Mt mid section = 1000,31

*  TMermax @t Mid section =-3,912 - 107* - 1/mm?
NC]‘

Co i
E-ly Nermax

6885280 N
*  Minit = 5,642 MM 555w . 1 1000
783560000 mm*:3,912 10~ ——

*  Minit = cr

*  Mipit = 5,629 mm

This value can now be inputted as amplitude of the buckling shape for the imperfection:

B " Menlinear combinations *
BEiEBIFE a2 O a v Y
MNC1 Mame NC1

Description

Solver index (0]
Type Ultimate w
4+ Contents of combination
LC1[] 1.00
Bow imperfection Nene
Global imperfection Buckling shape
Stability S1
Eigen shape 1
I Max deformation [mm] 5.6 I

New Insert Edit Delete Close
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Chapter 8: Physical non-linearity

When the stresses are dependent on the strains in a nonlinear way, the nonlinearity is called a physical
nonlinearity.

8.1. Plastic hinges

When a normal linear calculation is performed and limit stress is achieved in any part of the structure, the
dimension of critical elements must be increased. If however, plastic hinges are taken into account, the
achievement of limit stress causes the formation of plastic hinges at appropriate joints and the calculation
can continue with another iteration step. The stress is redistributed to other parts of the structure and better
utilization of overall load bearing capacity of the structure is obtained.

The material behaves linear elastic until the plastic limit is reached after which it behaves fully plastic. The o-
¢ diagram thus has the same shape as the Moment-Curvature diagram:

A

M

Mp

=~

The full plastic moment is given as Mp, the curvature as k.

In SCIA Engineer, a plastic moment can only occur in a mesh-node . This implies that the mesh needs to be
refined if a plastic hinge is expected to occur at another location than the member ends.

The reduction of the plastic moment has been implemented according to the following codes: EC3, DIN
18800 and NEN 6770.

There is off course a risk when taking plastic hinges into account. If a hinge is added to the structure, the
statically indeterminateness is reduced. If other hinges are added, it may happen that the structure becomes
a mechanism. This would lead to a collapse of the structure and the (nonlinear) calculation is stopped.

On the other hand, plastic hinges can be used to calculate the plastic reliability margin of the structure. The
applied load can be increased little by little (e.g. by increasing the load case coefficients in a combination)
until the structure collapses. This approach can be used to determine the maximum load multiple that the
structure can sustain.
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To take into account plastic hinges for steel structures, the functionality Steel > Plastic Hinge analysis

be activated in the functionality tab of the project settings.

Project data

| GENERAL

Basic data Functionality Actions

Unit Set  Protection

Property modifiers
Medel modifiers
Parametric input
Climatic loads
Mokbile loads
Dynamics

Stability

Nonlinearity I

Structural model
IFC properties
Prestressing
Bridge design
Excel checks

Substitution beam

must
*
DETAILED
B Monlinearity
| Subsoil
4  Steel
Plastic hinge analysis a
Fire resistance checks
Steel connections
Scaffolding
TDoF 2nd order analysis for ITB
Girders with sinuscidal webs
OK Cancel

The choice of code which needs to be applied can be specified through Menu bar > Tools > Calculation &

Mesh > Solver settings.

The no code option simply follows the EC-EN logic.

17 Solver setup

Specify load cases for linear c
Specify combinations for nonl
4 Advanced solver setti...
4 General
Run ene nenlinear combinz
Neglect shear force deform
Type of solver
Humber of sections on aver 10
Warning when maximal tra
Warning when maximal rot

Coefficient for reinforcemer 1

4  Nonlinearity
Method of calculation
Number of increments 1
Maximum iterations 50
Solver precision ratio 1

Solver robustness ratio 1

Direct

1000.0
100.0

Print time in Calculation Pri

Picard

Name SeolverSetupl

Plastic hinge code EC
a No code
DIN
4 NEN

It is not possible to choose on what members or in which nodes plastic hinges can be formed. If the
functionality is activated, a plastic hinge will form wherever the moment resistance is exceeded regardless of

the element’s plastic capacity.
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Example: Plastic_Hinges.esa

In this project, a continuous beam is considered. The beam has a cross-section type IPE 300 and is
fabricated in S235.

According to Eurocode 3, the plastic moment around the y-axis is given by:

Wiy 1, . 1-n
- Mypra = =25 My ra = Mypira * 155 Myv.ra = Mygira * (1= p2) |Myny,re = Mynga x (1= p2)

W e® 2
-‘Mz,pLRd = :Tofy Mz,N,Rd = Mz,pl,Rd * [1 — (n a) ] Mz,V,Rd = Mz.pI,Rd * (1 - py) MZ‘N,V,REI = Mz,N‘Rd * (1 - Py)

1-a

For the beam (no normal or high shear force present) considered this gives the following:
e fy =235 N/mm?2
e Wpy= 6,28 105 mm?3
e yw=1,0

— Mplyd = W;’"y'fy = 147,59 kNm

Mo

A linear analysis shows the following moment-diagram:

-178.52 kNm

\

\'\u

101.39 kNm

A nonlinear analysis taking into account plastic hinges gives the following result:

-147.59 kNm

N\[\LM

Do
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When the load is increased further, another plastic hinge will form in the middle of a span thus creating a
mechanism. The nonlinear calculation will stop and a singularity message will be given:

The stiffness matrix is singular!
The structure is unstable. Instability found
in FE-node No. N2, direction phi_Y, increment 1.

OK

The animation window shows the expected scene, where an additional plastic hinge in the middle of the
span leads to a mechanism:

BV —2021/06/21
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8.2. General plastic analysis

A general plastic analysis can be carried out for any 2D members (plates, walls and shells). The von Mises
yield condition is currently available, which is suitable for ductile materials in general, such as metals (steel,
aluminium, ...). It is a symmetric behaviour acting in the same way in tension and compression, with or
without hardening in the plastic branch.

The plastic behaviour of materials may be combined with other types of nonlinearities in SCIA Engineer.

Note: plasticity is not supported yet for 1D members. The 1D members that are present in the model will be
considered as elastic.

8.2.1.  Von Mises yield criterion

In SCIA Engineer, the von Mises yield criterion is implemented.

This criterion suggests that the yielding of materials begins when the second deviatoric stress invariant J2
reaches a critical value. For this reason, it is sometimes called the J2-plasticity or J2 flow theory. It is part of
a plasticity theory that applies best to ductile materials, such as metals. Prior to yield, material response is
assumed to be elastic.

In materials science and engineering the von Mises yield criterion can be also formulated in terms of the von
Mises stress or equivalent tensile stress, ok, a scalar stress value that can be computed from the Cauchy
stress tensor. In this case, a material is said to start yielding when its von Mises stress reaches a critical
value known as the yield strength, oy. The von Mises stress is used to predict yielding of materials under any
loading condition from results of simple uniaxial tensile tests. The von Mises stress satisfies the property that
two stress states with equal distortion energy have equal von Mises stress.

The Von Mises stress is expressed as:

1
O = \/E [(011 = 022)% + (022 — 033)% + (033 — 011)% + 6 (01, + 035 + 03,)]

Because the von Mises yield criterion is independent of the first stress invariant, 11, it is applicable for the
analysis of plastic deformation for ductile materials such as metals, as the onset of yield for these materials
does not depend on the hydrostatic component of the stress tensor, just like the Tresca criterion.

01

Von Mises &>
Yield Surface z -

6% i
7. Hydrostatic
AV i

Tresca
Yield Surface

-plane
(Deviatoric Plane)
o1 +02+03=0

g2
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8.2.2. Finite element model

Drilling rotations at each node is used for in-plane loading. This means that element has six degrees of
freedom at each node and is therefore compatible with other types of elements (beam/solid elements).

Within the element area the Gauss 2x2 quadrature points are used. Each of these Gauss quadrature points
is realized by nine Gauss-Lobatto quadrature points throughout the thickness, so the four-node element has
2x2x9=36 quadrature points in total.

(a) (b) (c)
'; /
A |
@ @ 2
3
.
2 1 Al
2 =~
2 1 C . /0/ 2 St
(— Pz 6
I}.yﬁ"jy 7
P 8

Uy

Due to these Gauss-Lobatto points the element can handle bending loading with high accuracy. In all of
these points the nonlinear model is computed independently using the plane stress formulation. Linear
transversal shear stiffness is assumed.

8.2.3.  Material properties

Figure C.2 from EN 1993-1-5 is used for the material behaviour:

Madel
Tk TA
fy 4
with
yielding
platean a)
tan'(E)
€
I tan ' (E/10000)
{or similarly small value)
fa [ 1
£t tan"(E/100) 1
with
strain- c)
hardening 4
tan™(E) _
€
1 true stress-strain curve
2 siress-strain curve from tesis

The different models are:
a) elastic-plastic without strain hardening
b) elastic-plastic with a nominal plateau slope
c) elastic-plastic with linear strain hardening

d) true stress-strain curve modified from the test results as follows:
o, =oc(l+¢€)

frue
g . =ln (l +€)
In SCIA Engineer, a), b) and c¢) are implemented.

frue
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check

8.2.4. General plasticity in SCIA Engineer

General plasticity is a specific type of nonlinearity in SCIA Engineer. This means that General plasticity

subfunctionality of the nonlinear analysis.

Project data

Basicdata Functicnality Actions UnitSet Protection

GENERAL DETAILED
Property modifiers 4 MNonlinearity
Model modifiers Beam local nenlinearity
Pararnetric input Support nonlinearity/basic soil spr
Climatic loads Initial imperfections
Maobile loads Geometrical nonlinearity
Dynamics I General plasticity %_"’E'] I
Stability Cables
I Monlinearity iCIE Friction support/Seil spring
Structural model P Subsoil
IFC properties P Steel
Prestressing
Eridge design
Excel checks

Substitution beam

OK Cancel

The nonlinearity of materials is defined directly in the material library. See the property group Material

behaviour for nonlinear analysis

B Materials

= ET |
5235

5275

5355

S 450

5275 N/NL
5355 N/NL
5420 N/NL

S 460 N/NL
5275 M/ML

5 355 M/ML
5420 M/ML

S 460 M/ML
5235 W

5355 W

5460 Q/QL/QLL
5235 H

S275H

5355 H

5275 NH/NLH

5 355 NH/NLH

S 460 NH/NLH
5275 MH/MLH
5 355 MH/MLH
5420 MH/MLH
S 460 MH/MLH
5235 JR(EN 1002...

as 0 Awd Al v Y
Name S235
4 Code independent
Material type Steel
Thermal expansion [m/mK] 0.00
Unit mass [kg/m"3] 7850.0
E modulus [MPa] 2.1000e+05
Poisson coeff, 0.3
Independent G modulus
G modulus [MPa] 3.0T69e+04
Log. decrement (non-uniform d 0.15
Colour N
Thermal expansion (for fire resi 0.00
Specific heat [J/gK] 6-0000e-01
Thermal conductivity [W/mK] 4.5000e+01
Price per unit [€/kg] 1.00

4 Material behaviour for ...

Material behaviour Elastic ¥

New Insert Edit

4+ EC3
Ultimate strength [MPa] 360.0
Yield strength [MPa] 235.0

Thickness range

Close

is a

By default, all materials in the library are set as elastic. This means, that the selected material will behave
elastically during a nonlinear analysis. The plastic properties of materials are generic, code independent in

SCIA Engineer and are therefore available for any material, regardless of the selected design code.

Plasticity can be enabled by selecting a type of plastic behaviour. For steel we can use Isotropic elasto-
plastic von Mises . It corresponds to a bilinear stress-strain relationship, identical in tension and compression.
The plastic branch may have a slope (hardening modulus) or not.
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The stress-strain relationship is automatically generated from 3 parameters: Young's modulus (elastic part),
yield stress for uniaxial tension and, optionally, hardening modulus (slope of the plastic branch).

hardening modulus
with hardening

B Teassssnnnnnnnnnnnnnnns Without hardening

E modulus

» strain

Only the tension part of the diagram is defined, as it is related to a plastification condition in general 3D
stress state in principal stress directions. Some plastification models allow for a different yield stress in
compression, which is defined separately. There is no limit (ultimate) strain value for the analysis.

When the actual strain value in the structure exceeds the defined diagram, the diagram is extrapolated,
tangent to the last defined segment of the stress-strain relationship. The reason for that is, that the analysis
would then fail and it would be impossible to find where the problem is located in the structure. It is therefore
preferable, that the analysis continues and that you check the obtain strain values after the analysis.

last defined segment
of plastic branch

stress

II'

»
>

o)

extrap'olated
branch

.......................... elastic branch

» strain

The following parameters define the nonlinear behaviour of the material in the material library:
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=Bl “as O Swld A ~ Y
5235 Name S 235 ~
5275

< Code independent

5355
Material type Steel
5450 .t}fP 0.00
5275 N/NL Thermal expansion [m/mK] 0.
S 355 N/NL Unit mass [kg/m*3] 7850.0
5420 N/NL | E modulus [MPa] 2-1000e+05 ]
5460 N/NL Poisson coeff. 0.3
5275 M/ML Independent G modulus
5355 M/ML G modulus [MPa] 8.0769e+04
5420 M/ML tor N e NGHE
5 460 M/ML og. decrement (nen-uniform d -
e Coour I
5355 W Thermal expansion (for fire resi 0.00
5460 Q/QL/QLL Specific heat [J/gh] €.0000e-01
| 5235 H Thermal conductivity [W/mK] 4.5000e+01
S275H Price per unit [€/kg] 1.00
5355 H
< Material behaviour for ...
5275 NH/NLH . . .
$355 NH/NLH Material behaviour Isotropic elaste-plastic, von Mises v
5460 NH/NLH Note ductile materials (metal, steel, aluminiun
S 275 MH/MLH Input ype Elasto-plastic with hardening v
5355 MH/MLH Yield stress in uniaxial tension 235.0
S 420 MH/MLH Hardening modulus [MPa] 2.1000e+01
S 460 MH/MLH % ECs
5235 JR (EN 1002... v
1l ata cbrancth [MBa1 360.0
New Insert Edit Close
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 E modulus: Young's modulus of the material which defines the slope of the elastic part of the
stress-strain diagram
* Material behaviour: t he type of material behaviour for the nonlinear analysis has to be selected
o Elastic
0 Isotropic elasto-plastic, Tresca (ductile materials such as metal, steel, aluminium)
o0 Isotropic elasto-plastic, von Mises (ductile materials such as metal, steel, aluminium)
0 Isotropic elasto-plastic, Drucker-Prager (materials with difference in compressive en
tensile strength such as concrete and soil)
0 Isotropic elasto-plastic, Mohr-Coulomb (materials with difference in compressive en
tensile strength such as concrete and soil)
* Inputtype: d efines the definition of the plastic branch of the stress-strain diagram
o Elasto-plastic: in the plastic domain, the stress remains constant when the strain
increases
o Elasto-plastic: in the plastic domain, the stress increases with the strain
* Yield strength: e lastic limit for plastification due to shear
» Hardening modulus: slope of the plastic branch of the stress-strain diagram

Note: Various types of nonlinearity may be combined in the same project. However it is not possible to
cumulate several types of nonlinearity on the same 2D member. The property FEM non-linear model will
behave as follows, when combined with a plastic material:
» Plastic material and 2D press-only behaviour: the press-only behaviour will be ignored and the
2D member will behave as plastic.
e Plastic material and membrane behaviour: the plastic behaviour will be ignored and the 2D
member will behave as an elastic membrane element.

When starting the analysis, a warning message will be displayed giving the same information about
functionality conflicts.

Example: Plastic_Plate_Stresses.esa

In this project, 3 vertical walls of different steel materials are loaded each time by the same vertical surface
load of 242.90 kN/mz2. The value of the load is high enough to make sure that the Von Mises stresses in
every wall are higher than the allowed yield strength fy of the steel materials.

A linear analysis shows the following results for the Von Mises stresses:

\iigE+ [MPa]
426.2

400.0
350.0

300.0

250.0
426,2 MPa 200.0
150.0

100.0

As expected, the Von Mises stresses for every wall are exactly the same and are higher than the yield
strength fy.

For every used material, the following properties for the non-linear analysis are inserted:
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[ Materials X
EiEGFE «» 0O SmB A ' 4
5235 Name S 235 ~
S 4 Code independent
232 Material type Steel
Thermal expansion [m/mK] ©.00
Unit mass [kg/m"3] 7850.0
E modulus [MPa] 2.1000e+05
Poisson coeff. 0.3
Independent G modulus
G modulus [MPa] 8.0769e+04
Log. decrement (non-uniform d 0.15
Colour |
Thermal expansion (for fire resi 0.00
Specific heat [J/gK] 6.0000e-01
Thermal conductivity [W/mK] 4.5000e+01
Price per unit [€/kg] 1.00
4 Material behaviour for ...
Material behaviour lsotropic elasto-plastic, von Mises v

| New | insert | Edit |

l

Note ductile materials {metal, steel, aluminiun
Input type Elasto-plastic v
Yield stress in uniaxial tension 235.0
4 EC3
Ultimate strength [MPa] 360.0
Viald chrannth [MPa1 235.0 v

Close

The nonlinear analysis shows the following results for the Von Mises stresses:

353,1 MPa

sigE+ [MPa]
3531

3200
2800
2400
2000
160.0
1200

B0.0

40.0
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Example: Beam_Column_Connection.esa

The functionality General Plasticity can also be used to model steel connections using finite elements to
perform a plastic stress check.

In this example, a bolted column-beam connection is modelled using 2D finite elements in SCIA Engineer.
That way the plastic stresses can be calculated by performing a nonlinear analysis.

Elastic results for (linear) combination CO2:

\iigE+ [MPa]
506.4

430.0

420.0

360.0

Plastic results for nonlinear combination NC2:
@B [MPa]
2350
2100
180.0

150.0
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Chapter 9: SLS check

9.1. Nodal displacement
The nodal displacement defines the maximum global deflections in the vertical and horizontal directions.

The following values are controlled in the example below:
e Limit for horizontal deflections & is h/150
e Limit for vertical deflection Omax is L/200

Example: Industrial Hall.esa

Look at Menu bar > Results > Nodal displacement  and look at the combination CO2 — SLS.

Horizontal deformation

The maximum displacement in the X direction is 26,3 mm on a height of 6,9 m.
And in the Y-direction 27,3 mm on a height of 8,1 m.

Limit for Limit for horizontal deflection & is h/150
*  6900/150 = 46 mm - 26,3mm<46mm - OK
¢ 8100/150 =54 mm - 27,3mm<54mm - OK

Vertical deformation

The maximum displacement in the Z direction is 59,0 mm

Limit for Limit for vertical deflection 6 is L/200
« 30000/200 = 150 mm - 59,0mm<150 mm - OK

Displacement of nodes

Linear calculation
Combination: CO2

Extreme: Global
Selection: All
Name Case Ux Uy U: Ox Oy O, Utotal
[mm] [mm] [mm] [mrad] [mrad] [mrad] [mm]
N113 C02/1 -26.3 -0.5 0.0 -1. 0.2 0.0 26.3
N114 |CO2/2 26.3 -0.5 0.0 -1.4 -0.2 0.0 26.3
N70 C02/3 0.0| -27.3 0.0 15 0.0 1.3 27.3
N60 C02/4 0.0 27.3 0.0 -1.5 0.0 1.3 27.3
N109 |CO2/5 13.2 0.0 -59.0 0.2 -0.3 0.0 60.4
N82 C02/6 10.0 -9.3 14.5 -26.8 -0.2 1.9 19.9
N80 C02/6 9.7| -103 0.0 -29.7 0.0 1.3 14.2
N179 |CO2/7 9.7 10.3 0.0 29.7 0.0 1.3 14.2
N116 C02/8 -9.7 -0.2 -21.6 0.5 -5.9 0.0 23.6
N112 C02/5 9.7 0.2]| -21.6 -0.5 5.9 0.0 23.6
N95 C02/7 -9.8 9.5 0.0 -27.7 0.0 -4.3 13.7
N87 C02/6 9.8 -9.5 0.0 -27.7 0.0 4.3 13.7
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9.2. Relative deformation — SLS check

To perform a steel SLS check, the following data needs to be specified:
» the span of the elements to be checked;
» the deflection limits of the elements to be checked;
e the camber attributed to the elements (optional).

The span is defined in the dialog System lengths and buckling groups . There can also overwrite the
deflection limits and camber values of the steel setup for a certain buckling group.

The deflection limits can be set in the Span settings part of the dialog. The deflection limits can be set
independently for the local y and z directions (based on the active deflection option, defy or defz), and
independently for total loads and variable loads.

7 System lengths and buckling settings o X |
o EN SR R
Settings  Results
Name  Truss bottom chord
Buckling span Deflection span
¥y * Deflectionz= defz v
zz= IZ ¥ Deflection y= zz ¥
y2= 2z ¥
oB= zz ¥
iy % S Rl b Active buckling constraints
\i\‘ Lo e e i S 7.“ - _-_7_‘7' 4 Spansettings
A e S i)
d 1y Y .'T\j h P i S Deflection limits (EC-EN 1893 Steel Check SLS) From setup -
AL SR TS
o G AL R i For all spans
“l 1 \‘)\-_i)_ - Per span
G5t i) 15 =5k
e Y 17‘7-"f
el gy S
L,’!.\ 4y V Soan settines for def 2
o | B Total loads | Ljxx; xx= [] Variable loads | Ljot; xx= [
1 200.00 350.00
l
3
Save Cancel

Three options are available:
» For all spans : the same deflection limits will apply to all the spans of the selected element(s)
» Per span: different deflection limits will apply to different spans
« From setup : the deflection limits specified in the steel settings will apply to all the spans

B Steel setup X

Mame Standard EN

- Standard EN
- Steel
Member check
Fire resistance
- Cold Formed
- Plated structural elements
- Limit slenderness
-+ Buckling defaults

S SL5 deflection check

-+ Autodesign

4 Steel
Member check
Fire resistance

Cold Formed

Limit slenderness

B
=
b
P Plated structural elements
[
b Buckling defaults

L

EN 1993-1-1
EN 1993-1-2
EN 1993-1-3
EN 1993-1-5
EN 50341-1

SLS deflection check
4 SLS deflection limits
4 In plane deflection (def z)

4 Out of plane deflection (def y)

Total loads [-] 20000
Variable loads [-] 350.00

Total loads [-] 20000
Variable loads [-] 350.00

4 SLS camber

P Autodesign

Load default non-NA parameters

Camber definition Ne camber

Load default MA parameters

Canel
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The camber can be set independently for the local z and y direction (based on the active deflection option,
defy or defz) via the combo box:

| 87 System lengths and buckling settings o X

frFllersE @

Settings Results

Name Truss bottom chord

Buckling span Deflection span
¥y * Deflection z = defz v
2= 7 & Deflection y = zz ¥
y2= 2z v
oB= zz v
el e e S e b Active buckling constraints
itk s S e
454 J\i‘ \‘ :"7“1.‘ Rl et 4 T Deflection limits (EC-EN 1983 Steel Check SLS)  From setup v
. \ & -~ ”
] Y n"‘]\.-I g 3 - Camber definition From setup ~
L\ e

L Te % [From setup |
ll'f \.7\‘“'-. T Mo camber
& Y ‘7\7' = Design camber
by Input camber [relative}
e .y V ¥ Input camber [absolute]

~ ] Total leacts | Lfxx; xx= [ Variable loacts | Ljx; %= [

1 200.00 350.00

Save Cancel

Five options are available:

* No camber : no camber will be applied

» Design camber : the camber can be designed based on the deflection limits. You can define
certain boundary conditions (camber shape, minimum camber, camber limit, maximum
camber and rounding)
This option is available since SCIA 19.1

» Input camber (absolute) :the camber value will be input, span by span, in absolute
dimensions (length units)

* Input camber (relative) :the camber value will be input, span by span, as a relative
coordinate (1/length units)

« From setup: the camber values specified in the steel setup will be applied to all spans

Note: The camber is defined with respect to the local z axis. If the local z axis is directed downward, you
must input a negative value in order to have an upward camber.

With the option Menu bar > Design > Steel members > SLS check or Process toolbar > Steel > Steel
SLS check , the relative deformations can be checked. The relative deformations are given as absolute
value, relative value related to the span, or as unity check related to the limit for the relative value to the
span.

It is also possible to visualise the camber via the SLS check.
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Two options for this span are possible and explained below.

2 nodes supported

When two nodes are supported in this menu as shown below, the deformation is taken as the maximum
deflection of the beam in comparison with a line connecting the two end nodes:

B System lengths and buckling settings m} X

o9 2FEXEBEH. AH.
Settings | Results
»<] Bl Name | BG1
Buckling span Deflection span

¥y ® Deflection z = vy -

22= 2z -~ Deflectiony = 2z -~

yz= zz ~

LTB= zz ~
Active buckling constraints -
Span settings

Deflection limits (EC-EN 1993 Steel Check SLS) From setup

Camber definition From setup

Span settings for def z

Total loads | L/xg xc= [-] | Variable loads | Lo xc= [-]
1 20000 =
AR
[ fed
x -
O >
QY 38 0

Save Cancel

In below an example of this principle:

Calculation for this relative deformation:
Deformation in the beginning of the beam = 5,967 mm and at the end = 11,863 mm.
Maximum deformation is at 0,979 m from the beginning at the beam.

So this point has already displaced 9,5 mm (see blue line at the picture):

2 %(11,863 — 5,967 = 9,504
*
1 (11, mm , mm) , mm

UZplue line;0,979m — 5,967 mm +
And Uz, relative = 10,2 mm — 9,5 mm = 0,7 mm

And suppose the length of this beam = 1632 m:

0,73 mm

reluz = e mm
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1 node supported and the other node free _ (for example cantilever beams)

This is the case if one end node is free:
B System lengths and buckling settings [m] X

Urel 09 AEEBE. A,

Settings | Results

T ﬁm Name BG1

Buckling span Deflection span
¥y @ Deflection z = vy
zz= (22 Deflectiony = zz
yz= z

LTB= zz

Active buckling constraints -
Span settings

Deflection limits (EC-EN 1993 Steel Check SLS) From setup

Camber defintion From setup

Span settings for def z

Total loads | L/%g xx= [-] Variable loads | L/xg xx= [-]

IRARAML 4

P
Eé— AP ee & -

Save Cancel

Now the maximal relative deformation is taken as the deformation minus the deformation of the fixed node.
ANnd Uzrelative = 12,057 mm — 0,355 mm = 11,7 mm

And suppose the length of this beam = 1632 mm:;
11,7 mm

rel uz =m= 1/139
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Now this principle is shown at the example of the industrial hall.

Example: Industrial Hall.esa

Consider beam B10. In the System lengths and buckling settings  dialog the deflection limit for the total
loads is taken as L/200 and for the variable loads L/360 as defined in the steel setup.

7 System lengths and buckling settings o X

FlF FeersE S

Settings  Results

Name BCL

Buckling span Deflection span
¥y * Deflection z = i Sl
gizs iz ¥ Deflection y = zz_¥
yz= 22 ¥
TB= zz v
(l(l b Active buckling comstraints
4 Spansettings
G Deflection limits (EC-EN 1993 Steel Check 5LS]  From setup ¥
Camber definition From setup v
G
4 ‘Spari settings for def z
Total loack | Lixx; so= [ Variable loads | Ljxx; xx=[]
Ll X 200.00 3560.00
n’ 3

L’ ORI M

Qs g

Save Cancel

EC-EN 1993 Steel Check SLS

Linear calculation
Combination: CO2
Coordinate system: Principal
Extreme 1D: Global
Selection: B10

Overall Unity Check

Name dx Case Uymax Uyvar Lim. Uymax Lim. Uyvar Check Camber dx Checkoveral
[m] [mm] [mm] [mm] [mm] . Uy,var Uz -]
Wmax Uzvar  LimM. Uzmax  Lim. Uzvar [-1 [mm]
[mm] [mm] [mm] [mm] Check  Camber

Uz,var [mm]

Around the y-y axis (in the z-direction), only the first node has been supported, so the beam behaves as a
cantilever and the deflection limit will be adapted with a factor 2.

Length of the element = 15,075 m
Deformation uzmax = 13,4 mm (and O mm at the beginning of the beam)

= Uzmaxrelative = 13,4 mm — 0,0 mm = 13,4 mm

1/1125

- Uzmaxrelative / length = 13,4 mm / 15075 mm = 1/1125 - check = 00 = 0,09

Deformation uzvar = 46,2 mm (and 0 mm at the beginning of the beam)

-> Uzvar,relative = 46,2 mm — 0,0 mm = 46,2 mm

1/326
1/180

- Uzmaxrelative / length = 46,2 mm / 15075 mm = 1/326 > check = = 0,55
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Chapter 10: Fire resistance check

For the fire resistance calculation, a Professional or an Expert edition is necessary. The fire resistance check
has been inputted in module sensd.05.xx (for example sensd.05.01 for the code EC-EN).

10.1. General

The fire resistance check in SCIA Engineer has been inputted following the EN 1993-1-2 — simple calculation
model.

For a selected temperature curve, the temperature in the material after a required period is calculated. And
with this material temperature, the material characteristics are adapted.

The required levels of fire safety depend on factors such as:
» type of occupancy;
» height and size of the building;
» effectiveness of fire brigade action;
* active measures such as vents and sprinklers.

10.1.1. Temperature-time curves
This is the temperature of the air during the time.

You can choose between 4 nominal temperature-time curves in SCIA Engineer:

1400
1200
1000
g
T 200
‘E — S0 834
S 600 == == External fire
E —— = Hydrocarbon
400 -+ smoldering fire
200
0
0 30 60 90 120 150 180 210 240 270 300 330 360
Time (min)
Standard 1SO 834 curve: 0 =20 + 345log;o(8t+ 1) [°C]
a. = 25 W/m?K
External fire curve: 0y = 660 (1 — 0,687 e7*32t — 0,313 e7>8"%) + 20 [°C]
a. = 25 W/m?K
Hydroncarbon curve: 0, = 1080 (1 —0,325e7 217t~ 0,675 e™>°") + 20 [°C]
a. = 50 W/m?K
Smoldering fire curve: 0, = 154t + 20 [°C]

After 20 minutes followed by the standard 1SO 834 curve
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Advanced Concept Training — Steel code check

The temperature-time curve can be set via Menu bar > Design > Steel members > Settings > Fire

resistance :

Steel setup

=~ Standard EN
- Steel

dember check

ire resistance

old Formed

lated structural elements
imit slenderness

uckling defaults

i 5L5 deflection check
Autodesign

4 Steel
F Member check
4 Fire resistance

4 Requirement

Name Standarcd EN

EN 1993-1-1
EN 1993-1-2
EN 1993-1-2: 2.5

Required fire resistance R [min] 30.00

4 MNet heat flux

Emissivity related to the fire compartment =; [-]

Emissivity related to the surface material = [-]

EN 1993-1-2: 3.1
1.00
0.70

Configuration factor ¢ for radiative heat flux [-] 1.00

*

4 Temperature-time curve

EN 1993-1-2: 3.2

Temperature-time curve 150 834 curve

External fire curve
Hydrocarbon curve
Smoldering fire

User-defined curve

Cold Formed

Plated structural elements

Buckling defaulits
SLS deflection check
F Autodesign

(8
I
B Limit slenderness
(2
[

Reference: EN 1991-1-2 article 3.2

EN 1993-1-3
EN 1992-1-5
EN 50341-1

Description: Setting to select the nominal temperature-time curve,

Load default non-NA parameters

Application: Used for determining the gas temperature at a given time,

Load default NA parameters

10.1.2.

Steel temperature

Afterwards, the steel temperature will be calculated after a certain time with the following formulas. This steel
temperature will be assumed as a uniform temperature in the whole section:

Unprotected steel member:

Protected steel member:

Where:

e An/V

* [An/Vls

e hpe

Ag/V .
Aea,t = kshcm—phnetAt

alFa

_ MpAp/V Bge — 0y .
1+ d/3)

AB, ¢

¢
= el0 — 1) AB
’ dpcapa ( g't

correction factor for shadow effect
Am
-> for I-sections under nominal fire actions: kg, = 0.9%
v
- all other cases: kg, = [An/Vlp/[Am/V]
section factor for unprotected steel members [1/m]
- intable 4.2 (EN 1993-1-2) some section factors are calculated for unprotected
steel members.
box value for the section factor
design value on the net heat flux per unit area [W/mZ]
-> this value should be obtained from EN 1991-1-2 with & = 1,0 and em = 0,7.

I %dp A,V

. AV

130

section factor — see also table 4.3. En 1993-1-2
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And the netto heat flux can be calculated according EN 1991-1-2 article 3.1:

hper = hnet,r + hnet,c

heat transfer by convection [W/m?]

= (05— Om)

heat transfer by radiation [W/m2]

=d g, & 0 [(0, +273)* — (0, +273)%]

coefficient of heat transfer by convection [W/m2K]
gas temperature in the vicinity of the fire exposed member [°C]
-> this temperature may be adopted as nominal temperature-time curves as given

surface temperature of the member [°C]

Stephan Boltzmann constant (= 5,67 - 1078 W/m2K#4)

surface emissivity of fire = 0,7 (EN 1993-1-2)

emissivity of fire = 1

configuration factor - ® = 1,0. A lower value may be chosen to take account of so
called position and shadow effects (calculation is given in EN 1991-1-2 —Annex G).

° hnet,c

* hnet,r
With:

4 Oc

. @g

below

. 0O,

4 o

4 €m

4 &f

e O

s 0,

effective radiation temperature of the fire environment [°C]
- in case of fully fire engulfed members, the radiation temperature 6,. may be
represented by the gas temperature 6, around that member.

The parameters of the previous formulas can be adapted in the steel settings:

| B " Steel setup

= Standard EM
Steel

-~ Member check

- Cold Formed

- Plated structural elements
- Limit slenderness

- Buckling defaults

- 515 deflection check

L Autodesign

x |
MName Standard EN
4 Steel
P Member check EN 1993-1-1
4 Fire resistance EM 1993-1-2
4 Requirement EN 1993-1-2: 2.5
Required fire resistance R [min] 30.00
4 Net heat flux EM 1993-1-2: 3.1
Emissivity related to the fire compartment =; [] 1.00
Emissivity related to the surface material = [-] 0.70
Configuration factor & for radiative heat flux [-] 1.00
4 Temperature-time curve EM 1993-1-2: 3.2
Temperature-time curve 150 834 curve ¥
Coefficient of heat transfer by convection o [W/m"2K] 25.00
4 Structural fire design EN 1993-1-2: 4.2
Analysis type Resistance domain v
Use adaptation factor for shadow effect k, no
P Cold Formed EN 1993-1-3
b Plated structural elements EN 1993-1-5
I Limit slenderness EM 50341-1
P Buckling defaults
P 5LS deflection check
P Autodesign
Load default non-NA parameters Load default NA parameters Cancel
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Advanced Concept Training — Steel code check

10.1.3. Steel properties

Most of the steel properties will change by a different temperature, so once the steel temperature is known,
the steel properties can be calculated. In below the properties for carbon steel from EN 1993-1-2, art.3 are
used. The properties for stainless steel can be found in EN 1993-1-2 Annex C. There are also reduction

factors for class 4 cross-sections according to table E.1 of EN 1993-1-2 Annex E.

Reduction factors

Effective yield strength, relative to yield strength at 20°C:ky g = f; o/f,

Proportional limit, relative to yield strength at 20°C:

Slope of linear elastic range, relative to slope at 20°C:

kp,e = fP,e/ fy

kE,S = Ea,S/Ea

ks

N

Effective vield strength
Ko = f\;.[!ff:f

0.5 \
\ \\, Slope of linear
0 \ elastic range m
\ \ \ keon=Ean/Ea
0.4 . \ .
Proportional limit )\Q(
0.2 kpo=fpolfy %
0 | hh—.__
200 400 600 800 1000 1200
[°C]

Thermal elongation

The relative thermal elongation of steel Al/1 should be determined from the following:

» for20°C <8, <750°C:

+ for750°C <6, <860°C: —=1,1x10"
o for750°C <6, <860°C: —=1,1x10"

132

Relative Elongation Al [x107)

20

18
16

14

12

10

= N & Oy 2

0 200 400

600

800 1000 1200

Temperature [°C]

AT‘ =1,2x10759, + 0,4x 107802 — 2,416 x 10~*
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Specific heat

The specific heat ca [J/kgK] should be determined from the following:

. fOI’ ZOOC S ea < 600°C Ca = 425 + 7’73 X 10—1 ea _ 1,69 X 10_36221 + 2,22 < 10—663
+ for 600°C < 8, < 735°C: ¢, = 666 +
17820a

. for 735°C < 0, < 900°C: ¢, = 545 +
a—-731
«  for900°C < 0, < 1200°C: ¢, = 650 J/kgK

Specific heat [J / kg K]
5000
4500
4000
3500
3000 '
2500
2000
1500 H
1000 '

500 94— S E—
0

0 200 400 €00 800 1000 1200

Temperature [°C]

Thermal conductivity

The thermal conductivity Aa [W/mK] should be determined from the following:
» for20°C<6,<800°C: A,=54—-3,33x10"%20,
« for800°C <6, < 1200°C: A, = 27,3 W/mK

Thermal conductivity [W/ mK]
60

50T =

40 T~ —

30

20

0 200 400 600 800 1000 1200
Temperature [ °C ]
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10.1.4. Fire resistance properties in SCIA Engineer

In SCIA Engineer you can input fire resistance properties on a steel member via Input panel > Steel > Fire
resistance check data or Process toolbar > Steel > Fire resistance check dat  a:

B Fire resistance X

4 General settings

Ignore check no
4 Requirement
==l E— Required fire resistance Input L
Required fire resistance R [min] 30.00
T 4 Temperature-time curve
Temperature-time curve According to setup v

Coefficient of heat transfer by convectiona,  25.00
¢ 4 Compression members

Modify buckling lengths during fire no

S S 4 Beams
Fire exposure 3 sides v
T Covered flange Top flange ¥
Adaptation factor for cross-section xq 0.85
Adaptation factor for beam Statically indeterminate beam v
Adaptation factor for beam x5 0.85

4 Steel temperature development
Protection L4 ves
Insulation Fibre board ¥ o

Thickness [mm] 10.00

OK Cancel

Where:

» Required fire resistance : inputted by you as user or according to the steel setup

* Required fire resistance R : specifies the required resistance (input)

e Temperature-time curve : according to the steel setup or overruled for the selected member

» Coefficient of heat transfer by convection o: can only be changed by a user defined
temperature-time curve

* Modified buckling lengths during fire  : the buckling ratios can be inputted manually for the
fire resistance check

» Fire exposure : the section may be exposed to fire on all or only three sides

» Covered flange : when a section is exposed to fire on only three sides, the covered flange can
be chosen here

» Adaption factor for cross-section  Ki: this parameter is the adaptation factor for non-uniform
temperature distribution across a cross-section. This factor k1 is used for the check on the
design moment resistance Mg rd

» Adaption factor for beam : at the supports of a statically indeterminate beam or all other
cases

» Adaption factor for beam k»: this parameter is the adaptation factor for non-uniform
temperature distribution along the beam. This factor k2 is used for the check on the design
moment resistance MsioRrd
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Protection : yes or no

Insulation : here the insulation properties can be inputted

B Insulations

HiEBEFE a2 O B A

Fibre board

Mame Fibre board

Encasement type

Insulation type

Unit mass [kg/m"3]

Thermal conductivity [W/mK]
Specific heat [J/gK]

Default value for thickness [mm)]

New Insert Edit

Hollow encasement v
Board protection w
150.0

2.0000e-01
1.2000e+00

10.00

0K

e Thickness [mm] : thickness of the insulation

10.2.

Calculation methods

In SCIA Engineer 3 calculation methods are implemented:

resistance domain;
time domain;

temperature domain (iterative).

The choice between those analysis types can be made in the steel settings:

B Steel setup

[=- Standard EN

[ Steel
L Member check
- Fire resistance
Cold Formed

- Plated structural elements

- Limit slenderness

-~ Buckling defaults

-~ 5L5 deflection check

L. Autodesign

Analysis type Resistance domain

X
Mame Standard EN ~
4 Steel
P Member check EN 1993-1-1
4 Fire resistance EN 1993-1-2
4 Requirement EM 1993-1-2: 2.5
Required fire resistance R [min] 30.00
4 Net heat flux EN 1993-1-2: 3.1
Emissivity related fo the fire compartment £; [-] 1.00
Emissivity related fo the surface material = [-] 0.70
Configuration factor ¢ for radiative heat flux [-] 1.00
4 Temperature-time curve EN 1993-1-2: 3.2
Temperature-time curve 150 834 curve v
Coefficient of heat transfer by convection a_ [W/m*2K] 25.00
4 Structural fire design EN 1993-1-2: 4.2
~

Resistance domain
Time domain
Temperature doma

in {Iterative)

FPlated structural elements
b Limit slenderness
P Buckling defaults
i SLS deflection check

EN 199310

EN50341-1

| <€

domain or the temperature domain.

Load default non-MNA parameters

Reference: EN 1991-1-2 article 2.5(2) and EN 1993-1-2 article 4.2.1
Description: Analysis type for the verification of the fire resistance,
Application: The verification of the fire resistance can be executed in the resistance domain, the time

[Eenie]

Load default NA parameters
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10.2.1. Resistance domain

Principle

You will choose the used temperature time curve and will input a required fire resistance time. After this time,
the temperature of the gas and afterwards of the steel will be calculated.

With this steel temperature, the reduced properties will be calculated and a fire resistance check according
to EN 1993-1-2, art. 4 will be executed with those adapted steel properties. This check will result in a unity
check, which is the fire resistance check for the resistance domain.

Example in SCIA Engineer

This principle is explained with an example in SCIA Engineer.

Example: Industrial hall.esa
Consider member B28.

Following fire resistance properties are inputted on this column:
w

MEMBER (1) > FIRE RESISTANCE (1) (=)

g hiALE S 2
w GENERAL SETTINGS
lgnore check (I:l
w REQUIREMENT
Required fire resistance  Input -
Required fire resistanc... 30.00
» TEMPERATURE-TIME CURVE
Temperature-time curve  According to setup
transfer by convection Q.
w COMPRESSION MEMBERS
Modify buckling lengt... (O )
v BEAMS
Fire exposure  All sides -
factor for cross-section K,
Adaptation factor for ...  Statically indeterminat
itation factor for beam K,
w STEEL TEMPERATURE DEVELOPMENT
Protection ()
Insulation  Fibre board » ==

Thickness [mm] 5.00

So the fire resistance will be checked after 30 minutes (= 1800 seconds) with a fibre board protection and the
buckling factors are taken equal as the buckling factors of the normal steel code check.
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The fire resistance check is executed via Menu bar > Design > Steel members > Fire check  or Process
toolbar > Steel > Steel ULS fire check for this column and for result class Fire (which contains combination
EN-Accidental with w1 coefficients and combination EN-Accidental with w2 coefficients), resulting in a unity
check of 1,18 .

When looking at the detailed output, this calculation is given by SCIA Engineer (it is also possible to turn on
the formulas as for the normal ULS checks).

First, the partial safety factors are given:

ymo for resistance of cross-sections |1.00
ywm1 for resistance to instability 1.00
ymz for resistance of net sections 1.25
ym,f for resistance to fire 1.00

Then the material properties (not adapted by the temperature) are given:

Yield strength fy [235.0 |MPa
Ultimate strength [fu [360.0 [MPa
Fabrication Rolled

And the fire resistance properties as inputted in SCIA Engineer. Here is also indicated that the fire resistance
check has been executed after 30 minutes of fire.

Fire resistance
Verification in Resistance domain according to EN 1993-1-2 article 4.2.3

Fire resistance

Temperature-time curve 1S0 834 curve
Coefficient of heat transfer by ac 25.00 W/mkK
convection

Emissivity related to fire &f 1.00

compartment

Emissivity related to surface £m 0.70

material

Configuration factor for radiation [ 1.00

heat flux

Required fire resistance R 30.00 min
Gas temperature Oq 841.80 o€
Material temperature Ba,t 600.06 °C
Beam exposure All sides

Adaptation factor for cross-section  [k1 1.00

Adaptation factor for beam K2 0.85

Reduction factor for the yield ky,8 0.47

strength

Reduction factor for the 0.2% proof |ko.2p,e |0.30

strength

Reduction factor for the E modulus |kes 0.31

Insulation properties

Name Fibre board

Encasement type Hollow encasement
Insulation type Board

Thickness do 5.00 mm
Unit mass Do 150.0 kg/m3
Thermal conductivity Ao 2.0000e-01 W/mK
Specific heat [ 1.2000e+00 J/gK
Section factor for insulated steel |A/V |1.0830e-01 1/mm
members
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Now a graph is shown with the gas temperature (in this example follow the ISO 834 curve), the steel

temperature calculated with a protection and the reduction of the yield strength.

N/mm? *c
250 - 1000
200 I~ 800
150 - 600
100 ~ 400

50 - 200
0 T T T T T T T T T T T T 1 0
0 2 4 6 8 10 12 14 16 18 20 22 24 26 28 30 min
Yield strength
Gas temperature

Steel temperature

And then the unity checks are shown with the reduced properties:

The critical check is on position 6.900 m

Internal forces Calculated  Unit
Normal force N#,Ed -69.55 kN
Shear force Vyfied [-0.01 kN
Shear force Vzfied  [-40.21 kN
Torsion ThEd 0.00 kNm
Bending moment  [My.fed |-277.43 kNm
Bending moment  [Mzfied |-0.08 kNm

Classification for cross-section design
Classification according to EN 1993-1-2 article 4.2.2
Classification of Internal and Outstand parts according to EN 1993-1-1 Table 5.2 Sheet 1 & 2

o2

[kN/m 2]
1 |so 108.90 [17.00 |65221.307 |65395.606 [1.0 |0.4 [1.0 |6.4 |7.6 8.5 11.7 1
3 |so 108.90 [17.00 |65145.761  |64971.462 |1.0 |0.4 |1.0 |6.4 |7.6 8.5 11.7 1
4 |1 685.00 |13.20 |60923.771 _ |-53505.136 |-0.9 0.5 [51.9 [58.9 67.8 93.9 1
5 |so 108.90 [17.00 |-57802.671 |-57976.970
7 [so 108.90 [17.00 |-57727.125 |-57552.826

The cross-section is classified as Class 1

Compression check
According to EN 1993-1-2 article 4.2.3.2 and formula (4.5)

Cross-section area A 1.8800e+04 |mm?
Design buckling resistance [Nfitrd |2075.86 kN
Unity check 0.03 -

Bending moment check for My
According to EN 1993-1-2 article 4.2.3.3 and formula (4.10)

Plastic section modulus Woly 5.1100e+06 [mm?3
Plastic bending moment Moly,Ré  |1200.85 kNm
Bending resistance My.fig.Rd | 564.24 kNm
Design bending resistance |Myfiwrd |663.81 kNm
Unity check 0.42 =
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Bending moment check for M

According to EN 1993-1-2 article 4.2.3.3 and formula (4.10)

Plastic section modulus Wolz 6.3100e+05 |[mm?3
Plastic bending moment Mplz,Rd 148.28 kNm
Bending resistance Mzf5Rd | 69.67 kNm
Design bending resistance |M,s.rd [81.97 kNm
Unity check 0.00 -

Shear check for vy

According to EN 1993-1-2 article 4.2.3.3 and formula (4.16)

Shear correction factor n 1.20

Shear area Av 9.4086e+03  [mm?
Plastic shear resistance for Vy |Vply.rd [1276.54 kN
Plastic shear resistance for Vy |Vyfitrd [599.80 kN
Unity check 0.00 -

Shear check for V;
According to EN 1993-1-2 article

4.2.3.3 and formula (4.16)

Shear correction factor n 1.20

Shear area Av 1.1389e+04 [mm?
Plastic shear resistance for Vz |Vplzrd | 1545.22 kN
Plastic shear resistance for Vz: |Vzfitrd [726.05 kN
Unity check 0.06 -

Combined bending, axial force and shear force check
According to EN 1993-1-2 article 4.2.3
According to EN 1993-1-1 article 6.2.9.1 and formula (6.41)

Plastic bending moment My.fitRd |663.81 [kNm
Exponent of bending ratio y |a 2.00
Plastic bending moment Mzfitrd  |81.97 kNm
Exponent of bending ratio z |B 1.00

Unity check (4.9) = 0.17 + 0.00 = 0.18 -

Note: Since the shear forces are less than half the plastic shear resistances their effect on the moment

resistances is neglected.

Note: Since the axial force satisfies both criteria (6.33) and (6.34) of EN 1993-1-1 article 6.2.9.1(4)
its effect on the moment resistance about the y-y axis is neglected.
Note: Since the axial force satisfies criteria (6.35) of EN 1993-1-1 article 6.2.9.1(4) its effect on the moment

resistance about the z-z axis is neglected.

The member satisfies the section

..2iSTABILITY CHECK::...

check.

Classification for member buckling design
Decisive position for stabiity classification: 6.900 m

Decisive utiisation factor n: 0.42

Classification according to EN 1993-1-2 article 4.2.2
Classification of Internal and Outstand parts according to EN 1993-1-1 Table 5.2 Sheet 1 & 2

01 02

w
[kN/m?]  [-]

[kN/m?]

ko
[

Class 1
Limit

[-]

Class 2
Limit

[]

Class 3
Limit

[-]

i [SO 108.90 [17.00 [65221.307 [65395.606 (1.0 |04 |1.0 |64 [7.6 8.5 11.7 i
3 [SO 108.90 [17.00 [65145.761 [64971.462 (1.0 (0.4 [1.0 |64 |7.6 8.5 117 i
4 |I 685.00 |13.20 [60923.771 [-53505.136 |-0.9 0.5 [51.9 [58.2 67.4 92.7 !
5 [SO 108.90 [17.00 |-57802.671 |-57976.970
7 _[SO 108.90 [17.00 [-57727.125 |[-57552.826

Note: The Classification lmits have been set according to Semi-Comp+.
The cross-section is classified as Class 1

Note: The decisive posttion for the stabity classification is based on the utiisation factor n according to Semi-Comp+.

Flexural Buckling check

According to EN 1993-1-2 article 4.2.3.2 and formula (4.5)

Buckling parameters v zz

Sway type sway non-sway
System length L 6.900 6.900 m
Buckling factor k 3.58 0.87

Bucking length ler 24716 |5.978 m
Critical Euler load Ner 5635.44 [3067.01 kN
Slenderness A 83.15 112.71
Relative slenderness Arel 0.89 1.20

Relative slenderness Acels 1.09 1.48
Imperfection a 0.65 0.65

Reduction factor XFi 0.42 0.28

Buckling resistance Nbfitrd  [864.02  |588.88 kN
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e a & a 1
Cross-section area [A 1.8800e+04 |mn?¥

Bucking resistance [Nbfitrd |588.88 kN
Unity check 0.12 -

Torsional(-Flexural) Buckling check

According to EN 1993-1-2 article 4.2.3.2 and formula (4.5)

Note: For this I-section the Torsional(-Flexural) bucking resistance is higher than the resistance
for Flexural bucking. Therefore Torsional(-Flexural) bucking is not printed on the output.

Lateral Torsional Buckling check
According to EN 1993-1-2 article 4.2.3.3 and formula (4.11)

Plastic section modulus Wely 5.1100e+06 [mm?
Elastic_critical moment Mer 1785.02 kNm
Relative slenderness Arelir 0.82

Relative slenderness Arelits [1.01

Imperfection awr 0.65

Reduction factor XLTA 0.45

Design bucking resistance |Mbfitrd | 254.59 kNm
Unity check 1.09 -
LTB length v [6.900 m
Influence of load position no influence

Correction factor k ]1.00

Correction factor ke [1.00

LTB moment factor € |1.77

LTB moment factor C; [0.00

LTB moment factor G [1.00

Shear centre distance d: 10.00 mm
Distance of load application |z |0.00 mm
Mono-symmetry constant By 10.00 mm
Mono-symmetry constant z [0.00 mm

Note: C parameters are determined according to ECCS 119 2006 / Galea 2002.

Bending and axial compression check
According to EN 1993-1-2 article 4.2.3.5 and formula (4.21a),(4.21b)

Bending and axial compression check parameters

Cross-section _area A 1.8800e+04 [mm?
Plastic section modulus Woely 5.1100e+06 [mm?
Plastic_section modulus Wiz [6.3100e+05 |[mm?

Design compression force | Nsed 69.55 kN
Design bending moment Mysed |-277.43 kNm
Design bending moment M:fed  |-0.08 kNm
Reduction factor Xminé  |0.28

Reduction factor Xzfi 0.28

Reduction factor XLt 0.45

Equivalent moment factor | Bmy 1.80

Factor Uy -0.44

Interaction factor ky 1.04

Bending and axial compression check parameters
Equivalent moment factor [Bm.: 1.80

Factor Yz -0.25
Interaction factor Kz 1.03
Equivalent moment factor [Bm.ir 1.80
Factor pLr 0.25
Interaction factor ki 0.97

Unity check (4.21a) = 0.12 + 0.51 + 0.00 = 0.63 -
Unity check (4.21b) = 0.12 + 1.06 + 0.00 = 1.18-

Shear Buckling check
According to EN 1993-1-2 article 4.2.3
According to EN 1993-1-5 article 5 & 7.1 and formula (5.10) & (7.1)

Shear Buckling parameters

Bucking field length a 6.900 m
Web unstiffened

End post non-rigid

Web height hw. 1719.00 mm
Web thickness E 13.20 mm
Yield strength frw 1235.0 MPa
Flange width b [265.00 mm
Flange thickness tr |17.00 mm
Yield strength fs  [235.0 MPa
Material coefficient € 0.85

Shear correction factor |n  [1.20
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Shear Buckling verification

Web slenderness hu/t 54.47

Web slenderness limit 51.00

Plate slenderness Avi8 0.78
Reduction factor Yo 1.07
Contribution of the web Vb fitRd 646.91 |kN
Capacity of the flange MsstRrd 340.52 |kNm
Flange factor c 1.849 m
Contribution of the flange [ Vbt fitrd 1.54 kN
Maximum resistance Vbfitrdimt | 726.05 [kN
Resistance Vb fitRd 648.45 |kN
Plastic_resistance MpifitRd 564.24 |kNm
Shear ratio N3bar 0.06

Unity check (5.10) = 0.06 -
Note: The interaction between Bending and Shear Bucking does not need to be verified
because the shear ratio does not exceed 0.5.

The member does NOT satisfy the stabiity check!
So in this example the Bending and axial compression check  will result in a unity check of 1,18.

To reach the required fire resistance of 30 minutes, you could increase the thickness of the insulation (for
example to 6 mm or more).
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10.2.2. Time domain
Principle

You will choose the used temperature time curve and will input a required fire resistance time. After this time,
the temperature of the gas and afterwards of the steel will be calculated.

Now also the critical steel temperature will be calculated. The fire resistance check according to the time
domain will be the ratio of the real steel temperature after a chosen time and the critical steel temperature.

This critical steel temperature Ba,cr will be calculated with a simple formula:

0, =39,19In|——————=— 1| + 482
aer [0,9674 u>833 ]

Where Lo is the degree of utilization. This means the unity check following EN 1993-1-2 at time = 0 sec, so
without augmentation of the temperature.

Note: this simple formula is only valid if no stabi lity phenomena or deformation criteria have to be
taken into account! Therefore, this calculation met hod will rarely be used.

Example in SCIA Engineer

This principle is explained with an example in SCIA Engineer.

Example: Industrial hall.esa
Consider member B28.
Change in the steel settings the analysis type to Time domain .

The fire resistance check is executed via Menu bar > Design > Steel members > Fire check  or Process
toolbar > Steel > Steel ULS fire check for this column and for result class Fire, resulting in a unity check
of 0,46.

When looking at the detailed output, following information is mentioned by SCIA Engineer:
The check results shown hereafter are given at time t = 0.00 min. These results have been used to determine
the degree of utilization for the critical temperature.

So the check following EN 1993-1-2 will be executed at t = 0 min, so at 20°C, without any reduction of the
steel properties. This check will result in a low unity check, which is the degree of utilisation po.

In this example again the ‘Bending and axial compression’ check will result in the highest unity check = 0,46
= Mo.

Bending and axial compression check
According to EN 1993-1-2 article 4.2.3.5 and formula (4.21a),(4.21b)

nec

= paramete
Cross-section _area A 1.880

0e+04 |mm?

Plastic_section modulus Woly 5.1100e+06 [mm?
Plastic section modulus Wolz 6.3100e+05 [mm?
Design compression force [Nsed 69.55 kN
Design bending moment Myfied |-277.43 kNm
Design bending moment M:ses  [-0.08 kNm
Reduction factor Xmingi |0.37

Reduction factor Xzfi 0.37

Reduction factor XLT6 0.54

Equivalent moment factor |Bmy 1.80

Factor Uy -0.16

Interaction factor ky 1.00

Equivalent moment factor |Bu.: 1.80

Factor Yz -0.02

Interaction factor kz 1.00

Equivalent moment factor |Bm.r 1.80

Factor pLr 0.17

Interaction factor kir 0.99

Unity check (4.21a) = 0.04 + 0.23 + 0.00 = 0.27 -
Unity check (4.21b) = 0.04 + 0.42 + 0.00 = 0.46 -
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This value is used in the simple formula for the critical steel temperature:

Bacr = 39,19 ln[

1
0,9674 3533

1] +482 =39,19In

1
0,9674 (0,46)3833

1] + 482 = 596,41 °C

And the steel temperature after 30 minutes is 600,06°C.

The unity check is:

600,06°C _
596,41°C

1,01

All those values are also given in the overview table in the preview of the fire resistance check:

Fire resistance

Verification in Time domain according to EN 1993-1-2 article 4.2.4

Temperature-time curve

ISO 834 curve

Coefficient of heat transfer by ac 25.00 W/m2K
convection

Emissivity related to fire 15 1.00

compartment

Emissivity related to surface €m 0.70

material

Configuration factor for radiation ® 1.00

heat flux

Required fire resistance R 30.00 min
Gas temperature Bg 841.80 °C
Material temperature 8.: [600.06 oC
Degree of utiization Yo 0.46

Critical material temperature Bacr [596.41 °C
Fire resistance ter 29.65 min
Beam exposure Al sides

Adaptation factor for cross-section |k 1.00

Adaptation factor for beam K2 0.85

Reduction factor for the yield kys [1.00

strength

Reduction factor for the E modulus [kes [1.00

Unity check 1.01 -

Also the fire resistance time

is given in this table: this member can resist fire for 29,65 minutes .

Note: as stated before, this simple calculation met
have to be taken into account. In this example the
thus taken into account, so this method is not corr
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hod can only be used if no stability phenomena
stability causes the highest unity check and is
ect and should not be used!
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10.2.3. Temperature domain (iterative)

Principle

If this method is used, the critical steel temperature will be calculated with an iterative process. So first, an
estimation of this critical temperature will be chosen and the unity check following EN 1993-1-2 will be
executed, if this check is lower than one, a higher critical temperature is chosen or when this check is higher
than one, a lower temperature is chosen. Now this unity check is recalculated just until the moment this unity
check gives a result for this critical steel temperature between 0,99 and 1.

This is a more accurate procedure to calculate the critical temperature and this method is also valid if stability
phenomena or deformation criteria have to be taken into account.

Example in SCIA Engineer

This principle is explained with an example in SCIA Engineer.

Example: Industrial hall.esa

Consider member B28.

Change in the steel settings the analysis type to Temperature domain (iterative)
Change in the steel settings the analysis type to Time domain .

The fire resistance check is executed via Menu bar > Design > Steel members > Fire check  or Process
toolbar > Steel > Steel ULS fire check for this column and for result class Fire, resulting in a unity check
of 0,80.

When looking at the detailed output, following information is mentioned by SCIA Engineer:

The check results shown hereafter are given at the critical material temperature Ba.cr = 752.89 °C. These results
have been used to determine the critical temperature i.e. the temperature at which the unity checks become near to 1.00.

So the check following EN 1993-1-2 will be given at Ba.cr = 752,89 °C. This temperature is calculated
iteratively resulting in a unity check following the EN 1993-1-2 equal to 1,00:

Bending and axial compression check
According to EN 1993-1-2 article 4.2.3.5 and formula (4.21a),(4.21b)

" ena (] d 0 d d CO ) £SSI10 eCl Dd d eLe
Cross-section area A 1.8800e+04 |[mm?
Plastic section modulus Woly 5.1100e+06 |[mm?3
Plastic section modulus Woiz 6.3100e+05 |mm?
Design compression force [ Nsied 47.52 kN
Design bending moment Mysed |-74.53 kNm
Design bending moment M.fes  |-0.06 kNm
Reduction factor Xminfi  |0.28

Reduction factor Xzfi 0.28

Reduction factor XL 0.46

Equivalent moment factor [Bmy 1.79

Factor Py -0.49

Interaction factor Ky 1.08

Equivalent moment factor [Bwm.: 1.80

Factor Yz -0.26

Interaction factor k2 1.06

Equivalent moment factor |[Bu.r 1.79

Factor pLr 0.25

Interaction factor kit 0.94

Unity check (4.21a) = 0.23 + 0.40 + 0.00 = 0.63 -
Unity check (4.21b) = 0.23 + 0.77 + 0.00 = 1.00 -

And indeed the highest unity check will be equal to 1,00 for this critical temperature.

600,06°C
752,89°C

So for this case the unity check is: = 0,80
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All those values are also given in the overview table in the preview of the fire resistance check:

Fire resistance

Verification in Temperature domain according to EN 1993-1-2 article 4.2.4

Fire resistance

Temperature-time curve

ISO 834 curve

Coefficient of heat transfer by ac 25.00 W/m2K
convection

Emissivity related to fire & 1.00

compartment

Emissivity related to surface €m 0.70

material

Configuration factor for radiation ) 1.00

heat flux

Required fire resistance R 30.00 min
Gas temperature Bs  [841.80 °C
Material temperature 8.+ |600.06 °C
Critical material temperature Bacr |752.89 oC
Fire resistance Ler 57.47 min
Beam exposure Al sides

Adaptation factor for cross-section | K1 1.00

Adaptation factor for beam K2 0.85

Reduction factor for the yield kye [0.17

strength

Reduction factor for the E modulus [kes |0.11

Unity check 0.80 -

And also the fire resistance time

is given in this table: this member can resist fire for 57,47 minutes .
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Annex A: Shearareas

Cross-section type Shear Area Source
Apz=A-2=betp+ (ty+2r) stg = n=hy =ty EN 1993-1-1
Rolled I-section (FC 1)
Apy=2%brtp+(ty+7) sty ECCS 85
th+tt
Ay =A-bt=tt—bbsth+(t;, +2=1)= [ 2 ] 20 hy =ty | EN 1993-1-1 (mod)

Rolled Asym. I-section (FC 101)

ECCS 85 (mod

A,,y=btktt+bbxtb+(t“.+r)xt“. ( )

Apz =T =hy=ty EN 1993-1-1
Welded |-section (FC 1)

Apy=A—hy=ty EN 1993-1-1

sz=A—2“ b“tf+(t“-+r)“tf EN 1993-1-1
Rolled U-section (FC 5)

Ab‘y =2x% b= tf EN 1993-1-1 (mod)

Apz=hy =ty EN 1993-1-1 (mod)
Welded U-section (FC 5)

Apy=A—hysty EN 1993-1-1

&
App=A=betr+(ty+n)ey EN 1993-1-1

Rolled T-section (FC 6)
EN 1993-1-1 (mod)

AV}' = b= tf
Ay =ty (h— t—’)
vz =tw(h =7 EN 1993-1-1
Welded T-section (FC 6)
EN 1993-1-1 (mod)
AI))' = b+ tf
A=h
e T EN 1993-1-1
Apz = +h)
Rolled RHS (FC 2)
.. EN 1993-1-1
WT (b+h) L
A=xh
e o EN 1993-1-1
Avz = (b+h)
Cold-Formed RHS (FC 2)
A=b
Ay = Gr T EN 1993-1-1
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Avy:bonto-!—bu"tu

Apz=1m=2=hy=ty EN 1993-1-1
Welded RHS (FC 2)
Apg=A=2xhysty EN 1993-1-1
LY
Lol EN 1993-1-1
CHS (FC 3) 2«4
Av). = =
EN 1993-1-1
A=A ECCS 85
Full Rectangular Section (FC 7)
Agy =4 ECCS 85
Agy=A ECCS 85
Full Circular Section (FC 11)
Agy =4 ECCS 85
2 4
A‘.z=h'tw+2“f"to'.‘2'r"(1-z) ECCS 83
IFBA(FC 154) With h the height of the rolled section
A, i+ Bt ECCS 83 (mod)
A(,’l=h-t\r+2-r'ru+2'r:'(1_§) ECCSS3
IFBE (FC 155) With h the height of the rolled section
v i ECCS 83 (mod)
2 4
At.z:h'tn.+4'f'tf+4"r"(1—2) ECC883
SFB (FC 153) With h the height of the rolled section
Apy=2sxbxts+by=ty ECCS 83 (mod)
Apz =2+h=ty ECCS 83
THQ (FC 156) With h the web height
ECCS 83 (mod)

Numerical

Apz =Az Ayz =A; (Taken from the cross-section)

A".). = Ay Avy = Ay

(Taken from the cross-section)
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Annex B: Examples on the Eurocode paths \

This annex will illustrate the Eurocode paths with some examples. Path 2b is not given since this path cannot
be used in practice: or you put a local imperfection on all members as in path 2c¢ or you put no local
imperfections as in path 2a. It is possible to put a local imperfection on several members, but the flexural
buckling check will always be performed on all members or no member at all.

Example project: 1 load case, containing 3 point loads of 500 kN. For the examples of paths 1b, 2a, 2c and
3, the loads are increased to 750 kN to have a lower critical alpha coefficient.

-500.00
-%00.00

-500.0¢

——f—
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Path la: 1st order analysis

Functionalities

Project data

Basicdata Functionality Actions

| GENERAL

Property modifiers
Model modifiers
Parametric input
Climatic loads
Mobile loads

Dynamics

Unit Set Protection

Stability
Nonlinearity

Structural model
IFC properties
Prestressing
Bridge design
Excel checks
Substitution beam

DETAILED

4 MNonlinearity

Support nonlinearity/basic soil
Initial im perfections
Geometrical nonlinearity
General plasticity
Cables
Friction support/Soil spring

4 Subsoil
Pad foundaticn check

4  Steel

Plastic hinge analysis
Fire resistance checks
Steel connections
Scaffolding
7DoF 2nd order analysis for LTB

OK

Beam local nonlinearity

Cancel

Stability calculation

We perform a stability analysis to check if the critical alpha coefficient is bigger than 10. If so, it is sufficient to
perform a first-order analysis. As mentioned in the chapter ‘Buckling shape as imperfection’, the Average

number of tiles of 1d element is set to 10:
B Mesh setup x
MeshSetupl
I Average number of 1D mesh elements on straight 1D members 10 I
Average size of 10 mesh element on curved 10 members [m] 1.000
1.000

| 2 g OK Cancel

Via Menu bar > Results > Critical load coefficients, a critical alpha coefficient of 11,93 is found, so it is

I Advanced mesh settings

Average size of 2D mesh element [m]

Connect members/nodes

sufficient to perform a first-order analysis.
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Linear calculation

Setup of buckling properties:
e buckling factor k: calculated by default by SCIA Engineer (only valid for simple structures!);
» sway/non-sway property: proposition of SCIA Engineer to be checked by you as user;
» system length of member: proposition of SCIA Engineer to be checked by you as user.
Alternative: manual input of the buckling factor k or the buckling length |

We perform the ULS check on load case BG1: the unity check for flexural buckling is decisive.

——

JL
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Nonlinear calculation
Same setup of buckling properties as for linear calculation.

The only difference is the Tension only property (via Input panel > Structure > Boundary conditions >
Nonlinearity 1D ) that has been added to the wind bracings. This means we are still dealing with a 1st order
calculation, but a nonlinear calculation must be executed to take the local nonlinearity ‘tension only’ into
account.

Attention: It is necessary to execute both linear and nonlinear calculation/analysis, because the buckling
properties are calculated only during the linear calculation!.

; 4 Mesh setu
Calculations e

Average number of 10 mesh elements 10
Linearanalysis Average size of 10 mesh element on cu 1.000
Load cases: 1
Average size of 2D mesh element [m] 1.000
MNenlinearanalysis

Nonlinear combinations: 1 Connect members/nodes

Linearstability I> Advanced mesh settings

Buckling modes: 4 4 Solver setup
Menlinearstability Specify load cases for linear calculatior
Buckling modes: 4 Specify combinations for nonlinear cal
Other processes F  Advanced solver settings
F  Deve setup

Test input of data

Save projectafteranalysis
The project version will be updated.

Calculate

We perform the ULS check on nonlinear combination NC1: the unity check for flexural buckling check is still
decisive.

:".;__:
N

——

72
PR

7775777

!
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Path 1b: 1st order analysis

Functionalities

Basic data | Functionality | Actions Unit Set Protection

Property modifiers A
Model modifiers Beam local nonlinearity v
Parametric input Support nonlinearity/basic soil...
Climatic loads Ilnitial imperfections v, I
Mobile loads Geometrical nonlinearity
Dynamics General plasticity
Stability v Cables
Nonlinearity v Friction support/Soil spring
Structural model ISequential analysis v I
IFC properties “ Subsoil
Prestressing Pad foundation check
Bridge design 4 Steel
Excel checks Plastic hinge analysis
Document Fire resistance checks

Steel connections

Scaffolding

7DoF 2nd order analysis for LTB

Note: the functionality ‘Sequential analysis’ is no t yet supported for the default post-processing
environment, so you need to use the post-processing environment ‘v16 and older’ in the 32bit
version of SCIA Engineer for this example!

Stability calculation

The stability calculation will be performed to determine the critical alpha coefficient. As mentioned in the
chapter ‘Buckling shape as imperfection’, the Average number of tiles of 1d element  is set to 10.

The critical alpha value must be higher than 3 to be able to use path 1b of the structural frame stability
scheme. In this example, the critical load coefficient is equal to 7,95 (which is in between 3 and 10).

Critical load coefficients

Stability combination : S1
1 7.95
2 22.98
3 24.18
4 26.65
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Global imperfection

The next step is to insert the global imperfection. This will be done using ‘Libraries > Structure, Analysis >

Initial deformations’.

Since this example is made in a 2D-environment, one initial deformation for the X-direction is sufficient. If the

project was made in a 3D-environment, it would be needed to create two initial deformations (one in X-

direction and one in Y-direction).

IDef X

Name I IDef X

Type EN 1993-1-1art. 5. ~
Basic imperfection value: 1/[-] 200,00

Height of structure : [m] 6,000

Number of columns per plane: 3

D:

On: -]

Ot [-] 0,82

New Insert Edit

- Y

Close

This global imperfection can now be inserted into the nonlinear combination. Once in the positive X-direction

and once in the negative X-direction:

NC1 Name
NC2 Description
Type
Contents of combination
BG1[-]

Bow imperfection
Global imperfection

dx inclination functions

Sense

NC1
Ultimate
1,00

None

Inclination functions

+

New from combination New Insert Edit Delete

Close

BV —2021/06/21

153



Advanced Concept Training — Steel code check

Linear combination

The inserted imperfections must be used during the linear calculation. This can be done by referring to the
correct nonlinear combination in the linear combination window:

A3 2B ) * & Input combinations v

Cco1 Name Cco1
co2 Description

Type Linear - ultimate

Amplified Sway Moment method no

“ Contents of combination
BG1[-] 1.00

New Insert Edit Delete Close

The Amplified Sway Moment method may only be used, if the actual normal force Neq is smaller than 25%
of the critical Euler force Ncr. Both values are printed in the detailed output of the steel code check. For
column S1:

The critical check is on position 0.000 m

Normal force Ned -752.88 kN
Shear force Vyed |0.00 kN
Shear force Vzed  [-2.03 kN
Torsion Ted 0.00 kNm
Bending moment [Myed |4.53 kNm
Bending moment Mzed [0.00 kNm

Flexural Buckling check
According to EN 1993-1-1 article 6.3.1.1 and formula (6.46)

Buckling parameters Yy zz

Sway type sway non-sway
System length L 3.000 5.000 m
Buckling factor k 1.00 1.00
1 Buckling lenath lcc 3.000 5.000 m
Critical Euler load Ncr 8497.73 [|1110.92 kN
Slenderness A 36.22 100.19
Relative slenderness Arel 0.39 1.07

Limit slenderness Arelo  [0.20 0.20

Buckling curve b C

Imperfection a 0.34 0.49

Reduction factor X 0.93 0.50

Buckling resistance Nprd |1177.95 |634.92 kN

Next the Amplified Sway Moment Method can be activated in the linear combinations and the critical alpha
value has to be inserted:

A 2B ) * &  Input combinations =

co1 [Name | co
coz Description
Type Linear - ultimate
Nonlinear combination NC1 -

Amplified Sway Moment method v/ yes

“ Contents of combination

BG1[-] 1.00
“ Amplified Sway Moment ...
foo ] 795
Amplification factor [-] 1.14
BG1 no

New Insert Edit Delete Close
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Linear calculation

The buckling lengths are taken equal to the system lengths.

This can be done via the steel setup:

(=) Standaard EN
(=) Steel

Member check

Fire resistance

Cold Formed

Plated structural elements
Limit slenderness
Buckling defaults

SLS deflection check
Autodesign

“ Shear
Use Ay, A, instead of elastic shear
“ Torsion
Limit for torsion [-]
“ Default sway types
yy
zz
“ Buckling length ratios ky, kz

Name Standaard EN A
“ Steel
“ [Member check ] En 1993-1-1
“ Classification EN 1993-1-1: 5.2.2
Use Semi-Comp+ [ Ino
Plastic analysis Elastic Stresses -

EN 1993-1-1: 6.2.6

no

EN 1993-1-1: 6.2.7

0.05

EN 1993-1-1: 6.3.1

v yes

no

EN 1993-1-1: 6.3.1

Max. k ratio [-] 10.00
Max. slenderness [-] 200.00
E order buckling ratios j=iL - I

“ Lateral Torsional Buckling

Lateral torsional buckling curves General case -
Method for C1 C2C3 ECCS 119/Galea -
Method for k. EN 1993-1-1 table 6.6 -
“ General settings

Elastic verification no

Verify only section checks no

Flexural buckling accounted for by 2™ order calculation no

Moments on columns in simple construction no hd

Load default non-NA parameters Load default NA parameters oK Cancel

EN 1993-1-1: 6.3.2

Or by inserting buckling ratios equal to 1 manually in ‘System lengths and buckling settings’ for y-y and z-z:

[ Settings | Results Settings | Results
Name BC1 Name BC1
Buckling span Deflection span Buckling span Deflection span
Deflectony= zz ~ Deflectiony= zz ~
2 Deflectionz= y-y ~ Deflectionz= yy ~
yz= zz ~ yz= zz ~
LTB= zz ~ LTB= zz ~
Active buckling constraints Active buckling constraints
4 Span settings 4 Span settings
Buckling length factors Settings per span for y-y axis Buckling length factors Settings per span for 2.z axis
lk)' factor Factor Y I | ky[[] | Swayyy l kz factor Factor - I kz[-] Sway z-z
) 1 1,00 1 1,00 |
Sway y- Cust, - B v ’
y ustom 2 100 & Sway zz Custom

Member imperfection in 2nd order analysis

Bow imperfection e0y
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no bow imperfectic v

Bow imperfection e0.z

Member imperfection in 2nd order analysis

no bow imperfectic ~
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In the next step, the calculation can be performed. Since the global imperfections are inserted in the
nonlinear combination, the linear as well as the nonlinear calculation need to be performed.

Calculations * |Meshisetnp

I . Average number of tiles of 1d element 1

v| Linear analysis
Load cases: 1 Average size of 2d element/curved ele... 1,000
Advanced mesh settings

“ Solver setup

'v| Nonlinear analysis
Nonlinear combinations: 1

Other processes
| Test input of data

Specify load cases for linear calculation |
Specify combinations for nonlinear ca...

Advanced solver settings

Calculate

We perform the ULS check for the result class ‘RC NL’: the unity check for flexural buckling check is
decisive.

1120 = HZ.')X 1.20 -
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Path 2a: 2nd order analysis — global imperfection

Functionalities

Proj

Basicdata Functionality Actions

Property modifiers
Model modifiers
Parametric input
Climatic loads
Mobile loads

Dynamics

Unit Set Protection

Stability

Nonlinearity

Structural model
IFC properties
Prestressing
Bridge design
Excel checks

Substitution beam

DETAILED

4 MNonlinearity

"~

I Beam local nonlinearity I

Support nenlinearity/basic soil <

Initial im perfections

Geometrical nonlinearity 5

General plasticity
Cables
Friction support/Soil spring

4 Subsoil
Pad foundation check

4 Steel

Plastic hinge analysis
Fire resistance checks
Steel connections
Scaffelding
TDoF 2nd order analysis for [TE

OK

Cancel

Stability calculation

The stability calculation will be performed to determine the critical alpha coefficient. Since the critical alpha

value is smaller than 10, we cannot follow path 1a of the Eurocode overview so we could follow path 2a.

Global imperfection:

BV —2021/06/21

see previous chapter.
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Steel setup

The whole structure can be considered as non-sway, which means that | < L (or conservatively | = L). SCIA
Engineer will execute the flexural buckling check with k = 1.

B Steel setup

[=)- Standaard EN
£ Steel
= Member check
- Fire resistance
- Cold Formed
- Plated structural elements
- Limit slenderness
~-Buckling defaults
- 5L5 deflection check
Autodesign

X
MName Standaard EN A
4 Steel
4 Member check EN 1993-1-1
4 Classification EN 1993-1-1:5.2.2
Use Semi-Comp+ no
Plastic analysis Elastic Stresses ¥
Stability classification method Max. class along member ¥
4 Shear EN 1993-1-1:6.2.6
Use Ay, A, instead of elastic shear no
4 Torsion EN 1993-1-1:6.2.7
Limit for torsion [-] 0-05
4 Default sway types EN 1993-1-1: 6.3.1
vy R ves
Zz o
4 Buckling length ratios ky, kz EN 1993-1-1:6.3.1
Max. k ratio [-] 10.00
Max, slenderpess [-1 200.00
Qnd order buckling ratios k=L v
4 Lateral Torsional Buckling EN 1993-1-1; 6.3.2
Lateral torsional buckling curves General case v
Method for €1 C2 C3 ECCS 119/Galea v
Method for k EN 1993-1-1 table 6.6 ¥
4 General settings
Elastic verification no
Verifv onlv section checks no V
I Load default non-NA parameters Load default MA parameters | ‘ OK ] |.Cancel |

We perform the ULS check for the result class ‘RC NL’: the unity check for combined compression and

bending is decisive.

E==73

-0,
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Path 2c: 2nd order analysis — global + local imperf  ection

Functionalities

Project data P
Basic data Functionality Actions UnitSet  Protection
| GENERAL DETAILED
Property modifiers 4 MNonlinearity i
Model modifiers I Beam local nonlinearity
Parametric input Support nenlinearity/basic soil <
Climatic loads Initial im perfections
Mobile loads Geometrical nonlinearity
Dynamics General plasticity
Stability Cables
Nonlinearity Friction support/Soil spring
Structural model 4 Subsoil
IFC properties Pad foundation check
Prestressing 4 Steel
Bridge design Plastic hinge analysis
Excel checks Fire resistance checks
Substitution beam Steel connections
Scaffelding
TDoF 2nd order analysis for [TE W
OK Cancel

Stability calculation

The stability calculation will be performed to determine the critical alpha coefficient. Since the critical alpha
value is smaller than 10, we cannot follow path 1a of the Eurocode overview so we could follow path 2c.

Global imperfection: see previous chapters.
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Bow imperfection

The bow imperfection €0 is inserted in the System lengths and buckling groups

And in the nonlinear combination, a reference is made to this inserted buckling data:

160

):

(or you can set it for the
entire project via the steel settings and put the diagonals manually to No bow imperfection via the
System lengths and buckling settings

B Systemn lengths and buckling groups

BEEEFE «2 O @ A

A ec1

A Becz

Mew

Insert

Name

Number of parts
Description

Member(s) material

ky factor

kz factor

Point of load application
Mer

(%]

Steel, other
Calculate
Calculate
Inshear center

Calculated

Bow imperfection 0,y

Bow imperfection €0,z

EN 1993-1-1 Table 5.1 - elastic
EN 1993-1-1 Table 5.1 - elastic

Edit

yy

ZZ

D14
p
b4

Delete

Close

B Meonlinear combinations bt
HEiEFE «2 O A v Y
NL BG1 Name ML BG1
NLBG2 Description
Solver index (1)
Type Ultimate v
4 Contents of combination
BG1[] 1.00
I Bow imperfection According to buckling data VI
Global imperfection Inclination functions v
4 dx inclination functions
7 IDefX v
Sense * v
New Insert Edit Delete Close

BV —2021/06/21



Steel setup

According to the Eurocode, it is not necessary anymore to execute the flexural buckling check.

SCIA Engineer will execute the flexural buckling check with k = 0,001, so that it will not be decisive.

= Standaard EN

£ Steel
‘- Member check
ire resistance
- Cold Formed
- Plated structural elements
mit slenderness
- Buckling defaults
i 515 deflection check
5----Au‘todesign

4 Steel

LR A

MName Standaard EN

.

4 Member check EN 1993-1-1
Classification EM 1993-1-1: 5.2.2
Shear EN 1993-1-1: 6.2.6
Torsion EN 1993-1-1: 6.2.7
Default sway types EN 1993-1-1;6.3.1
Buckling length ratios ky, kz EMN 1993-1-1: 6.3.1
Lateral Torsional Buckling EN 1993-1-1: 6.3.2
General settings

Elastic verification no
Verify only section checks 1o
I Flexural buckling accounted for by 2™ order calculation B3 ves
Mements on columns in simple construction T no
Fire resistance EMN 1993-1-2
Cold Formed EM 1993-1-3
Plated structural elements EN 1993-1-5
Limit slenderness EN50341-1
Buckling defaults
SLS deflection check
Autodesign

vy vV vV v v 9

Load default non-MA parameters

Load default MA parameters

oK

Cancel

We perform the ULS check for the result class ‘RC NL': the unity check for combined compression and

bending is decisive.

N
] .
>
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Functionalities

Path 3: 2nd order analysis — buckling shape as impe  rfection
Project data
Basic data Functionality Actions UnitSet  Protection
| GENERAL | DETAILED
Property modifiers 4 MNonlinearity i

Model modifiers
Parametric input
Climatic loads
Mobile loads

Dynamics

Stability [
Nonlinearity

Structural model
IFC properties
Prestressing
Bridge design
Excel checks
Substitution beam

I Beam local nonlinearity I

Support nenlinearity/basic soil <
Initial im perfections
Geometrical nonlinearity

General plasticity

Cables

Friction support/Soil spring
4 Subsoil
Pad foundation check
4 Steel
Plastic hinge analysis
Fire resistance checks

Steel connections

Scaffelding
TDoF 2nd order analysis for [TE W
ok || Cancel

Stability calculation:

The first buckling mode looks like this:

B
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see previous chapters.
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Calculation of nint = to be filled in as ‘max. deformation’ (see ‘Nonlinear combinations’ window)

B Monline

>

HEEEFE «2 O A

NL BG1
NL BG2

Name
Description
Solver index
Type
« Contents of combination
BG1 [-]

Bow imperfection

NL BG1

(1)

Ultimate

1.00

Nene

Global imperfection
Stability
Eigen shape

Max deformation [mm]

Buckling shape
S1

1

188.0

Mew Insert Edit Delete

Close

Steel setup

According to the Eurocode, it is not necessary anymore to execute the flexural buckling check.

SCIA Eng

ine

B Steel setup

[=- Standaard EN
£ Steel
‘- Member check
Fire resistance
Cold Formed
Plated structural elements
Limit slenderness
Buckling defaults
5L5 deflection check
~- Autodesign

4

4

¥ NN NN YR

Steel
Member check
Classification
Shear
Torsion
Default sway types
Buckling length ratios ky, kz

A - S

Lateral Torsional Buckling

b

General settings

Verify only section checks

Name Standaard EN

Elastic verification

EN 1993-1-1
EM 1993-1-
EN 1993-
EN 1993-
EM 1993-
EM 1993-1-

[
bt | [ | g [ e

EN 1993-1-1:

no

£ 5.2:2

6.2.6
6.2.7

:6.3.1
:6.3.1

6.3.2

er will execute the flexural buckling check with k = 0,001, so that it will not be decisive.

bt

I Flexural buckling accounted for by an order calculation yes

Mements en columns in simple censtruction

Fire resistance

Cold Formed

Plated structural elements
Limit slenderness
Buckling defaults

5LS deflection check
Autodesign

Load default non-MA parameters

no
EN 1993-1-2
EM 1993-1-3
EN 1993-1-5
EN50341-1

Load default MA parameters

oK

Cancel

BV —2021/06/21

163



Advanced Concept Training — Steel code check

We perform the ULS check for the result class ‘RC NL': the unity check for combined bending, axial force

and shear force is decisive.

| N PN VI BN N NN (EE |

2.74- |

1_1 1 1 1

1)

6}
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